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CHAPTER 1. READ ME

1.1. BACK UP YOUR DATA

! WARNING
Red Hat recommends that you back up your system settings and data before

undertaking any of the configuration tasks mentioned in this book.

1.2. VARIABLE NAME: EAP_HOME

EAP_HOME refers to the root directory of the Red Hat JBoss Enterprise Application Platform installation
on which JBoss Data Virtualization has been deployed.

1.3. VARIABLE NAME: MODE

MODE will either be standalone or domain depending on whether JBoss Data Virtualization is running
in standalone or domain mode. Substitute one of these whenever you see MODE in a file path in this
documentation. (You need to set this variable yourself, based on where the product has been installed in
your directory structure.)

1.4. RED HAT DOCUMENTATION SITE

Red Hat's official documentation site is available at https://access.redhat.com/site/documentation/. There
you will find the latest version of every book, including this one.


https://access.redhat.com/site/documentation/

CHAPTER 2. SOME KEY TERMS USED THROUGHOUT THIS DOCUMENT

CHAPTER 2. SOME KEY TERMS USED THROUGHOUT THIS
DOCUMENT

2.1. WHAT IS TEIID DESIGNER?

Teiid Designer is an Eclipse based graphical modeling tool for modeling, analyzing, integrating and
testing multiple data sources to produce Relational, XML and Web Service Views that expose your
business data.

2.2. WHAT IS METADATA?

Metadata is data about data. A piece of metadata, called a meta object in the Teiid Designer, contains
information about a specific information structure, irrespective of whatever individual data fields that may
comprise that structure.

Let us use the example of a very basic database, an address book. Within your address book you
certainly have a field or column for the ZIP code (or postal code number). Assuming that the address
book services addresses within the United States, you can surmise the following about the column or
field for the ZIP code:

e Named ZIPCode

e Numeric

e A string

e Nine characters long

e Located in the StreetAddress table

e Comprised of two parts: The first five digits represent the five ZIP code numbers, the final four
represent the ZIP Plus Four digits if available, or 0000 if not

e Formatted only in integer numeric characters. Errors will result if formatted as 631410.00 or
631490000

This definition represents metadata about the ZIP code data in the address book database. It abstracts
information from the database itself and becomes useful to describe the content of your enterprise
information systems and to determine how a column in one enterprise information source relates to
another, and how those two columns could be used together for a new purpose

You can think of this metadata in several contexts:

e What information does the metadata contain? (See Section 2.4, “Business and Technical
Metadata”)

e What data does the metadata represent? (See Section 2.11, “Source and View Metadata”)

e How will my organization use and manage this metadata? (See Section 2.7, “Design-Time and
Runtime Metadata”)

2.3. METADATA MODELS

Metadata model represents a collection of metadata information that describes a complete structure of
data.
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In a previous example we described the field ZIPCode as a metadata object in an address book
database. This meta object represents a single distinct bit of metadata information. We alluded to its
parent table, StreetAddress. These meta objects, and others that would describe the other tables and
columns within the database, would all combine to form a Source Metadata model for whichever
enterprise information system hosts all the objects.

You can have Source Models within your collection of metadata models. These represent physical data
storage locations. You can also have View Models, which model the business view of the data. Each
contains one type of metadata or another. For more information about difference between Source and
View metadata, see Section Source and View Metadata.

2.4. BUSINESS AND TECHNICAL METADATA

Metadata can include different types of information about a piece of data.

e Technical metadata describes the information required to access the data, such as where the
data resides or the structure of the data in its native environment.

e Business metadata details other information about the data, such as keywords related to the
meta object or notes about the meta object.

NOTE

The terms technical and business metadata, refer to the content of the metadata, namely
what type of information is contained in the metadata. Do not confuse these with the
terms physical and view metadata that indicate what the metadata represents.

2.5. TECHNICAL METADATA

Technical metadata represents information that describes how to access the data in its original native
data storage. Technical metadata includes things such as datatype, the name of the data in the
enterprise information system, and other information that describes the way the native enterprise
information system identifies the meta object.

Using our example of an address book database, the following represent the technical metadata we
know about the ZIP code column:

e Named ZIPCode

e Nine characters long

A string
e Located in the StreetAddress table
e Uses SQL Query Language

These bits of information describe the data and information required to access and process the data in
the enterprise information system.

2.6. BUSINESS METADATA

Business metadata represents additional information about a piece of data, not necessarily related to its
physical storage in the enterprise information system or data access requirements. It can also represent
descriptions, business rules, and other additional information about a piece of data.
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Continuing with our example of the ZIP Code column in the address book database, the following
represents business metadata we may know about the ZIP code:

e The first five characters represent the five ZIP code numbers, the final four represent the ZIP
Plus Four digits if available, or 0000 if not

e The application used to populate this field in the database strictly enforces the integrity of the
data format

Although the first might seem technical, it does not directly relate to the physical storage of the data. It
represents a business rule applied to the contents of the column, not the contents themselves.

The second, of course, represents some business information about the way the column was populated.
This information, although useful to associate with our definition of the column, does not reflect the
physical storage of the data.

2.7. DESIGN-TIME AND RUNTIME METADATA

Teiid Designer software distinguishes between design-time metadata and runtime metadata. This
distinction becomes important if you use the Teiid Designer Server. Design-time data is laden with
details and representations that help the user understand and efficiently organize metadata. Much of that
detail is unnecessary to the underlying system that runs the Virtual Database that you will create. Any
information that is not absolutely necessary to running the Virtual Database is stripped out of the runtime
metadata to ensure maximum system performance.

2.8. DESIGN-TIME METADATA

Design-time metadata refers to data within your local directory that you have created or have imported.
You can model this metadata in the Teiid Designer, adding Source and View metadata.

2.9. RUNTIME METADATA

Once you have adequately modeled your enterprise information systems, including the necessary
technical metadata that describes the physical structure of your sources, you can use the metadata for
data access.

To prepare the metadata for use in the Teiid Designer Server, you take a snapshot of a metadata model
for the Teiid Designer Server to use when resolving queries from your client applications. This runtime
metadata represents a static version of design-time metadata you created or imported. This snapshot is
in the form of a Virtual Database definition, or VDB.

As you create this runtime metadata, the Teiid Designer:

e derives the runtime metadata from a consistent set of metadata models.

e creates a subset of design-time metadata, focusing on the technical metadata that describes the
access to underlying enterprise information systems.

e optimizes runtime metadata for data access performance.

You can continue to work with the design-time metadata, but once you have created a runtime metadata
model, it remains static.

2.10. WHAT ARE MODELS?
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A model is a representation of a set of information constructs. A familiar model is the relational model,
which defines tables composed of columns and containing records of data. Another familiar model is the
XML model, which defines hierarchical data sets.

In Teiid Designer, models are used to define the entities, and relationships between those entities,
required to fully define the integration of information sets so that they may be accessed in a uniform
manner, using a single APl and access protocol. The file extension used for these models is . xmi (for
example, NorthwindOracle.xmi) which adheres to the XMI syntax defined by the OMG.

Below is an example of the partial contents of a model file.

<?Eml version="1.0" encoding="ASCII"?:»
<EML HEMI ®Zmi:version="2.0" Emlns: =Emi="http: www.ong. org-XHI" =mlns xsi="http:< www. w3l org-2001-HHLSchema-instance" =1
<mmcore: ModelAnnotation =mi:uuid="mmuuid:b0355£f00-413b-1079-9d18-8acfda?127d5" description="Horthwind_Oracle was cre
cmodel Imports =mi:uuid="mnuuid: 2d815780-4140-1079-9d18-8acf4a7127d5" name="XHLSchema" modellocation="http: . ~www. .
cmodelInports =miuuid="nnuuid: 2e663940-4140-1079-9d18-8acf4a7127d5" name="Simplelatatypes—-instance" modellocatio
<smmcore: ModelAnnotations
<relational :BaseTable =zni:uuid="mnmuuid: b20=64c0-413b-1079-9d18-8acf4a7127d5" name="CATEGORIES" namseInSource="CATEGOL
¢columns =niuuid="nnuuid: bb5acic0-413b-1079-9d18-8acf4a7127d5" name="CATEGORYID" nameInSource="CATEGORYID" natiwve
<type href="http: - www. w3 org- 2001-HHI1Schema#long" >
<columns
¢columns =niuuid="nnuuid bcdes?c0-413b-1079-9d18-8acf4a7127d5" name="CATEGORYHAME" nameInSource="CATEGCORYHAME" n:
<type href="http:- ~www wl org-2001-EHLSchemafstring" >
<columns >
¢columns =niuuid="nnuuid bcdes?cl-413b-1079-9d18-8acf4a7127d5" name="DESCRIPTION" nameInSource="DESCRIFTION" nat:
<type href="http:- ~www wl org-2001-EHLSchemafstring" >
</columns >
<columns =Zmi:uuid="mmuuid:bcdese?c2-413b-1079-9d18-8acf 4a7127d5" name="PICTURE" namelnSource="PICTURE" natiwveType='
<type href="http: “wwy metamatriz. comn-metamodels-Simplebatatypes—instancetblab"~ >
</columns >
<primarvEey =mi:uuid="mmuuid:d481£940-413b-1079-9d18-8acf4a?127d5" name="FPE_CATEGCORIES" namelnSource="PE_ CATEGOREIL
¢srelational :BaseTable:

Figure 2.1. Sample Model File

A NOTE

Model files should never be modified by hand. While it is possible to do so, there is the
possibility that you may corrupt the file such that it cannot be used within Teiid Designer
system.

The fundamental models in Teiid Designer define the structural and data characteristics of the
information contained in data sources. These are referred to as source models. Teiid Designer uses the
information in source models to federate the information in multiple sources, so that from a user's
viewpoint these all appear to be in a single source.

Model Internals
Customer
L
Eritity
Metadata relatipnzhip imported
~ll-------------q DEMS
Crider
Eritity
Metaclata
v

Figure 2.2. Model Internals

In addition to source models, Teiid Designer provides the ability to define a variety of view models.
These can be used to define a layer of abstraction above the physical (or source) layer, so that

10
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information can be presented to end users and consuming applications in business terms rather than as
it is physically stored. Views are mapped to sources using transformations between models. These
business views can be in a variety of forms:

e Relational Tables and Views

e XML

e Web services

e Functions

A third model type, logical, provides the ability to define models from a logical or structural perspective.

2.11. SOURCE AND VIEW METADATA

In addition to the distinction between business and technical metadata, it is necessary to know the
difference between Source Metadata and View Metadata.

Source and View metadata refers to what the metadata represents, not its content.

Source Metadata directly represents metadata for an enterprise information system and captures exactly
where and how the data is maintained. Source Metadata sounds similar to technical metadata, but
Source Metadata can contain both technical and business metadata. When you model Source Metadata,
you are modeling the data that your enterprise information systems contain.

View Metadata, on the other hand, represent tailored views that transform the Source Metadata into the
terminology and domain of different applications. View Metadata, too, can contain both technical and

business metadata. When you model View Metadata, you are modeling the data as your applications
(and your enterprise) ultimately use it.

2.12. COMPACT NODE TYPE DEFINITION
Compact Node Type Definition (CND) is a file format that defines node type in a compact standardized
format. A typical CND file contains series of namespace declarations, node type definitions and

comments. CND provides a compact and standard syntax for defining node types and making
namespace declarations.

2.13. JAVA CONTENT REPOSITORY

Java Content Repository is a content repository for Java API. JCR provides the following information
related services:

e read/write access to information,

e the ability to structure files in hierarchical manner,

e the ability to work with structured/unstructured content,
e the ability to search and query,

e versioning of information, and

e the ability to control access to the content.

11
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2.14. MODESHAPE TOOLS

ModeShape Tools is a set of Eclipse plugins you can use to work with ModeShape and Java Content
Repositories (JCRs).

2.15. THE VIRTUAL DATABASE

The critical artifact that Teiid Designer is intended to manage is the VDB, or Virtual DataBase. Through
the JBoss Data Virtualization server, VDB's behave like standard JDBC database schema which can be
connected to, queried and updated based on how the VDB is configured. Since VDB's are just
databases once they are deployed, they can be used as sources to other view model transformations.
This allows creating and deploying re-usable or common VDB's in multiple layers depending on your
business needs.

12
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CHAPTER 3. INTRODUCTION TO TEIID DESIGNER

3.1. WHY USE TEIID DESIGNER?

Teiid Designer allows you map data sources to target formats. It also lets you do the following:
e resolve semantic differences
e create virtual data structures at a physical or logical level

e use declarative interfaces to integrate, aggregate, and transform the data on its way from source
to target formats which is compatible and optimized for consumption by your applications

It allows you to abstract the structure of the information you use in your applications from the underlying
physical data structures. With Teiid Designer, data services are defined quickly, the resulting artifacts are
easy to maintain and reuse, and all the valuable work and related metadata are saved for later reference.

You can also use Teiid Designer to integrate multiple sources, and access them using these common
data access standards:

o Web Services/SOAP/XML
e JDBC/SQL

e ODBC/SQL

3.2. MODELING YOUR SOURCE METADATA

When you model the Source Metadata within your enterprise information systems, you capture some
detailed information, including:

e Identification of datatype

e Storage formats

e Constraints

e Source-specific locations and names

The Source Metadata captures this detailed technical metadata to provide a map of the data, the location
of the data, and how you access it.

This collection of Source Metadata comprises a direct mapping of the information sources within your
enterprise. If you use the Teiid Designer Server for information integration, this technical metadata plays
an integral part in query resolution.

For example, our ZIPCode column and its parent table StreetAddress map directly to fields within our
hypothetical address book database.

To extend our example, we might have a second source of information, a comma separated text file
provided by a marketing research vendor. This text file can supply additional demographic information

based upon address or ZIP code. This text file would represent another Enterprise Information System
(EIS), and the meta objects in its Source Model would describe each comma separated value.

3.3. MODELING YOUR VIEW METADATA

14
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When you create View Metadata, you are not describing the nature of your physical data storage.
Instead, you describe the way your enterprise uses the information in its day to day operations.

View Metadata derives its classes and attributes from other metadata. You can derive View Metadata
from Source Metadata that describes the ultimate sources for the metadata or even from other View
Metadata. However, when you model View Metadata, you create special views on your existing
enterprise information systems that you can tailor to your business use or application expectations. This
View Metadata offers many benefits:

e You can expose only the information relevant to an application. The application uses this View
Metadata to resolve its queries to the ultimate physical data storage.

e You can add content to existing applications that require different views of the data by adding the
View Metadata to the existing View Metadata that application uses. You save time and effort
since you do not have to create new models nor modify your existing applications.

e Your applications do not need to refer to specific physical enterprise information systems,
offering flexibility and interchangeability. As you change sources for information, you do not have
to change your end applications.

e The View Metadata models document the various ways your enterprise uses the information and
the different terminology that refers to that information. They do so in a central location.

Our example enterprise information sources, the address book database, and the vendor supplied
comma-delimited text file, reside in two different native storage formats and therefore have two Source
Metadata models. However, they can represent one business need: a pool of addresses for a mass
mailing.

By creating a View Metadata model, we could accurately show that this single View Table, the
AddressPool, contains information from the two enterprise information systems. The View Metadata
model not only shows from where it gets the information, but also the SQL operations it performs to
select its information from its source models.

This View Metadata can not only reflect and describe how your organization uses that information, but, if
your enterprise uses the Teiid Designer Server, your applications can use the View Metadata to resolve
queries.

To create this View Metadata, you create a view and define a transformation for that view, a special

query that enables you to select information from the source (or even other view) metadata models. For
more information, see .
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CHAPTER 4. : MODELS

4.1. GUIDING THROUGH THE PROCESS

To make the process of using Teiid Designer to build models more as easy as posssible, a guides view
(See Section D.19, “Guides View”) has been introduced. It provides action sets which bring together the
actions necessary to develop models for specific use-cases. Action sets are available for the following
scenerios:

Consuming a SOAP Web Service

Modelling from a Flat File Source (a text file)

Modelling from a JDBC Data Source

Modelling from a Local XML File Source

Modelling from a Remote XML File Source

Modelling from a Teiid Data Source (deployed on server)

Connecting to a Teiid Server

4.2. MODEL CLASSES AND TYPES

Teiid Designer can be used to model a variety of classes of models. Each of these represent a
conceptually different classification of models.

Relational - Model data that can be represented in table columns and records form. Relational
models can represent structures found in relational databases, spreadsheets, text files, or
simple Web services.

XML - Model that represents the basic structures of XML documents. These can be backed by
XML Schemas. XML models represent nested structures, including recursive hierarchies.

XML Schema - W3C standard for formally defining the structure and constraints of XML
documents, as well as the datatypes defining permissible values in XML documents.

Web Services - which define Web service interfaces, operations, and operation input and output
parameters (in the form of XML Schemas).

Function - The Function metamodel supports the capability to provide user defined functions,
including binary source jars, to use in custom transformation SQL statements.

4.3. VDB CONTENT AND STRUCTURE

In Teiid Designer, the VDB file names use a . vdb file extension. VDBs are structurally just ZIP archive
files containing 3 folders:
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META-INF - contains vdb . xm1 definition file.
runtime-inf - contains a binary INDEX file for each model included in your VDB.

project folder - contains of the models you will be adding in the VDB Editor (that is, * . xmi and
* . xsd files)



CHAPTER 4. : MODELS

When deployed, the metadata is consumed by JBoss Data Virtualization in order to create the
necessary runtime metadata for your model definitions.

The vdb.xml file contains:
e VDB name, version, properties
e contained model information (name, translator name, connection info)
e translator info
e data role definitions for the referenced models
e import VDB references

Fortunately, Teiid Designer simplifies the management of your VDBs by providing a dedicated VDB
Editor which maintains a consistent, valid vdb . xm1 file for you and assists in synchronizing your
workspace models with any related models in your VDB. (See Section E.8.1, “VDB Editor”)

4.4. MODEL VALIDATION

Models must be in a valid state in order to be used for data access. Validation of a single model means
that it must be in a self-consistent and complete state, meaning that there are no missing pieces and no
references to non-existent entities. Validation of multiple models checks that all inter-model
dependencies are present and resolvable.

Models must always be validated when they are deployed in a VDB for data access purposes. Teiid
Designer will automatically validate all models whenever they are saved.

NOTE

The Project > Build Automatically menu option must be selected. When editing
models, the editor tabs will display a * to indicate that the model has unsaved changes.

4.5. TESTING YOUR MODELS

Designing and working with data is often much easier when you can see the information you are working
with. The Teiid Designer's Preview Data feature makes this possible and allows you to instantly preview
the information described by any object, whether it's a physical table or a virtual view. In other words, you
can test the views with actual data by simply selecting the table, view, procedure or XML document. The
preview functionality insures that data access behavior in Teiid Designer will reliably match when the
VDB is deployed to the Server.

Previewing information is a fast and easy way to sample the data. Of course, to run more complicated
queries like what your application likely uses, simply execute the VDB in Teiid Designer and type in any
query or SQL statement.

After creating your models, you can test them by using the Preview Data action. By selecting a desired
table object and executing the action, the results of a simple query will be displayed in the Data Tools
SQL Results view. This action is accessible throughout the Teiid Designer in various view toolbars and
context menus.

17
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Previewable objects include:
e Relational table or view, including tables involving access patterns
e Relational procedure
e Web Service operation

e XML Document staging table

NOTE

If attempting to preview a relational access pattern, a web service operation or a relational
procedure with input parameters, a dialog will request values for required parameters.

18
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CHAPTER 5. MODEL OBJECT EXTENSIONS

5.1. MODEL OBJECT EXTENSIONS

Teiid Designer in conjunction with JBoss Data Virtualization provides an extensible framework to define
custom properties for model objects other than what is defined in the metamodel. These custom property
values are added to your VDB and included in your runtime metadata. This additional metadata is
available to use in your custom translators for both source query manipulation as well as adjusting your
result set data being returned.

Teiid Designer introduces a new Model Extension Definition (MED) framework that will replace the EMF
based Model Extension metamodel.

This MED framework provides the following improvements:

Eliminate need for separate EMF metamodel.

Simpler approach including reduction of extendable metamodels and metamodel objects
(Relational, Web Services, XML Document, User Defined Functions) and replacing EMF
terminology with basic object types.

Allows metamodels to be extended by multiple MEDs.

MEDs are stored in models so no added dependency needed in VDB.

Also see: Section 10.8.1, “Managing Model Object Extensions” and Section E.9, “Model Extension
Definition Editor”.

5.2. MODEL EXTENSION DEFINITION (MED)

The purpose of a MED is to define one or more sets of extension properties. Each set of extension
properties pertains to one model object type (or metaclass). Each MED consists of the following:

Namespace Prefix - a unique identifier. Typically only a small number of letters and can be used
as an abbreviation for the namespace URI.

Namespace URI - a unique URI.
Extended Metamodel URI (Model Class) - the metamodel URI that is being extended. Each
metamodel URI also has model class and that is typically what is shown in the Designer. The

model classes supported for extension are: Relational, Web Service, XML Document, and
Function.

Version - (currently not being used)
Description - an optional description or purpose.

Extended Model Object Types (Metaclasses) - a set of model object types, or metaclasses, that
have extension properties defined.

Properties - the extension property definitions grouped by model object type.

A MED file is an XML file with an extension of mxd. A MED schema file (see attached
modelExtension.xsd file) is used to validate a MED file. Here is a sample MED file:
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<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<modelExtension xmlns:p="http://org.teiid.modelExtension/2011"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
metamodelUri="http://www.metamatrix.com/metamodels/Relational"
namespacePrefix="mymodelextension"
namespaceUri="org.my.extension.mymodelextension"
version="1"
xsi:schemalLocation="http://org.teiid.modelExtension/2011
modelExtension.xsd"
xmlns="http://org.teiid.modelExtension/2011">
<p:description>This is my model extension</p:description>
<p:extendedMetaclass
name="com.metamatrix.metamodels.relational.impl.BaseTableImpl">
<p:property advanced="false" index="true" masked="false"
name="copyable" required="false" type="boolean'">
<p:description locale="en_US">Indicates if table can be
copied</p:description>
<p:display locale="en_US">Copyable</p:display>
</p:property>
</p:extendedMetaclass>
</modelExtension>

The MED Registry is where the MEDs used by Teiid Designer are stored. MED files can be edited by
opening the . mxd file in the Extension Editor.

5.3. MODEL EXTENSION DEFINITION REGISTRY (MED REGISTRY)

A MED registry keeps track of all the MEDs that are registered in a workspace. Only registered MEDs
can be used to extend a model. There are 2 different types of MEDs stored in the registry:

e Built-In MED - these are registered during Teiid Designer installation. These MEDs cannot be
updated or unregistered by the user.

e User Defined MED - these are created by the user. These MEDs can be updated, registered,
and unregistered by the user.

The MED Registry state is persisted and is restored each time a new session is started.
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CHAPTER 6. SERVER MANAGEMENT

6.1. TARGETING THE JBOSS DATA VIRTUALIZATION SERVER

6.1.1. Targeting the JBoss Data Virtualization Server

The JBoss Data Virtualization Server is the destination for Teiid Designer's modeling. It is essential to
define the correct server version that models will be deployed to. This is achieved either by setting the
server version preference or defining the JBoss Data Virtualization Server in the Servers View.

6.1.2. Server Version Preference

The default server version preference allows the target server version to be changed without actually
having to define a JBoss Data Virtualization Server in Teiid Designer. The preference's list of possible
values is determined by which teiid runtime client plugins have been installed into the application.

Preferences
' 4 Teiid Designer L= TV -
+ Forge Specify values for general Designer preferences.
FreeMarker Editor Preview Data/VDB Execution
+ Help ¥ Enable auto-creating of a source model's data source on Teiid Instance (VDB Execution)
HQL editor

Enable auto-toggling children of the checked model object
+ Install/Update

+ Java « Enable Preview
+ Java EE

« Generate Teiid Query Plan on execution
+ Java Persistence

+ JavaScript # Enable Preview Teiid Cleanup

+/ JBoss Tools
120 Teiid Connection Importer Timeout (sec)

+ Maven
+/ Plug-in Developmen Teiid Designer
Project Archives Always open editor without prompting
| Remote Systems Open Designer perspective when a model is opened
*/ Run/Debug Always open Never open @ Prompt
+l Server
T Team # Check and update imports during save
8.4.x v | Default Teiid Instance Version (applicable if no teiid instance defined)
Diagram

Diagram Printing

Editor
Validation
Terminal
Restore Defaults Apply
2
@ Cancel oK

Figure 6.1. Default Server Version Preference

6.1.3. Defining JBoss Data Virtualization Server

You can preview and test the deployment of the models by defining a JBoss Data Virtualization Server.
There is no limit to the number of servers that can be defined. However, the default server will always be
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used for previewing and deployment, unless you use the context menu actions in the Server View
section.

The Guides View provides the following JBoss Data Virtualization Server actions.
e Configure New JBoss Server
e Edit JBoss/Teiid Instance Properties
e Set the Default JBoss/Teiid Instance

e Refresh Teiid Instance

™ Guides i3 =

Modeling Actions... ~

- Action Sets

Execute selected action

| Teiid 3

-y L L} ' L Ly Y

# Edit |Boss / Teiid Instance Properties
H Set the Default |Boss / Teiid Instance
&% Refresh Teiid Instance

Figure 6.2. Teiid Server Category in the Guides View

The Configure New JBoss Server action will display the wizard outlined in the Setting Up a Server
section and steps through the process of creating both the JBoss Data Virtualization instance and its
parent JBoss server in the Server View.

Should more than one JBoss Data Virtualization Server be defined in the Server View then the Set the
Default JBoss/Teiid Instance action allows for the default server to be changed appropriately.
The JBoss Data Virtualization server that is currently selected in the Server View is considered as the
default server. However, should nothing be selected then a dialog will be displayed inviting you to choose
the default server.

NOTE

The version of the defined JBoss Data Virtualization server always takes precedence over
the server version selected in the Preference window.

e

6.1.4. Server Version Status Panel

22



CHAPTER 6. SERVER MANAGEMENT

Whether the server version preference has been modified or a server defined, the server and server
target version will be updated in the default server status panel. This will always reflect the current server
version being targeted and the server being used to preview or deploy against.

* Default Teiid Instance

Teiid Instance: o4 mm://localhost: 9999

Targeted Version: 8.4.0 @a

Figure 6.3. Default Server Status Panel

6.2. SETTING UP A SERVER

Teiid Designer is installed as a component of JBoss hence connection to a JBoss Data Virtualization
Server requires the setting up and configuration of its parent JBoss Server. This is achieved using the
Server View, see Server View section, displayed as part of the Teiid Designer perspective.

If no servers have been previously created then the Server View will display a new server hyperlink. To
create a new JBoss Server configuration, click the hyperlink.

[/ Problems | @] Error Log | 4 Servers 52 | & Console | = SQL Results | ¢7 Teiid Execution Plan = B
=)
Mo servers are available. Click this link to create a new server...

Figure 6.4. Server View with no created servers

Navigate through the wizard, configuring the details of the JBoss Server including its Runtime location,
hostname and whether its externally managed. The final property determines whether the server is
instantiated within the IDE or whether it is installed and started independently. Should the latter be the
case then the Server View merely assumes connection to the independent server.
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New Server
Define a New Server
Choose the type of server to create

Download additional server adapters

Select the server type:

type filter text f

% JBoss Enterprise Application Platform 6.1+

JBoss Enterprise Application Platform (EAP) 6.1+

i
Server's host name: localhost
Server name: jposs-eap-6.1 Runtime Server (1)
Server runtime environment: | jboss-eap-6.1 Runtime ¥ Add...
Configure runtime environments..,.
@ < Back Mext = Cancel Finish

Figure 6.5. New Server Configuration
The server has been installed with a JBoss Data Virtualization Server and on clicking the green start

button, Teiid Designer is successfully connected to the server, resulting in the display of the JBoss Data
Virtualization Server's configuration.
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5l Problems €] Error Log # Servers 8% & Console @ Teiid Execution Plan & 3% 0 P = O |

8 7, JBoss EAP 6.1+ Runtime Server [Started, Synchronized]

+ (%] XML Configuration
+ 5 Filesets
+ = Server Details
~I = Teiid Instance Configuration
= ‘A mm:/flocalhost: 9999
+l (= Data Sources
+l (& Translators

+ & VDBs

Figure 6.6. Server View with a single server

JBoss Tools provides an editor for the configuration of the JBoss Data Virtualization Server. In addition,
Designer provides an extra tab to this editor that displays the configuration of the JBoss Data
Virtualization Server. Only a few options can be modified since most of the configuration is determined
by the parent JBoss Server. This editor can be displayed by double-clicking on any node in the JBoss

Server tree.
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¥ JBoss EAP 6.1+ Runtime Server = A

Teiid Instance

* Overview

Display Mame

Host localhost
Teiid Runtime Version 8.4.0

JBoss Server JBoss EAP 6.1+ Runtime Server
~ Administration Connection

Administration is performed via the jboss management configuration

Port 9999

Test Administration Connection

~ JDBC Connection

User name user
Password
Port 31000

JDBC connection uses 551

Test JDBC Connection

Overview |Deployment | Teiid Instance

Problems % Error Log it Servers B2 Console Teiid Execution Plan

-1 43 JBoss EAP 6.1+ Runtime Server [Started, Synchronized]
+ ¥ XML Configuration

+ |5 Filesets
Figure 6.7. Editor for Configuring the Teiid Server

6.3. CONNECT JBDS TO A REMOTE RED HAT JBOSS DATA
VIRTUALIZATION SERVER

If you want to connect JBDS to a remote Data Virtualization server, you must also have Data
Virtualization installed on the local EAP machine on which JBDS is running. Simply copying over the
standalone. xml file does not work.

NOTE

i You do not need to set up the users on the local machine.
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CHAPTER 7. TEIID DESIGNER EXAMPLES

7.1. TEIID DESIGNER EXAMPLES

We are going to dive right into a couple examples of common tasks in this section. These examples will
give you a quick introduction to the capabilities that are built into Teiid Designer to assist you with
common design tasks. Specifically, we will introduce the following concepts:

o Guides

The Guides View is a good starting point for many common modeling tasks. The view includes
categorized Modeling Actions and also links to Cheat Sheets for common tasks. The categorized
Modeling Actions simply group together all of the actions that you'll need to accomplish a task.
You can launch the actions directly from the Guides view, rather than hunting through the
various Teiid Designer menus.

e Cheat Sheets
The Cheat Sheets go beyond even the categorized Action Sets, and walk you step-by-step
through some common tasks. At each step, the data entered in the previous step is carried

through the process when possible.

After seeing the Guides and Cheat Sheets in action, subsequent chapters will offer detailed explanations
of the various concepts and actions.

7.2. GUIDE VIEW

In this section, we introduce the Guides View by walking through a simple example. For this example,
we will follow the Model JDBC Source Action Set. The actions appear in the following order:

1. Define Teiid Model Project

2. Create JDBC connection

3. Create source model for JDBC data source

4. Preview Data

5. Define VDB

6. Execute VDB
The action names are self explanatory. We will create a new Model Project in the workspace, then define
our connection properties to a MySQL database. We will then connect to the database and import the
metadata, creating a source model in Teiid Designer. Next we will preview the database contents.

Finally we will define a VDB and then deploy it to a running JBoss Data Virtualization Server to
execute.

7.3. MODEL A JDBC SOURCE

This section shows how to model a JDBC Source, using the Guide View action set. For this example,
we will connect to a MySQL database, but you can use the same process to connect to any supported
database.

1. Open Guides View
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To open the Teiid Designer's Guides view, on the main menu, click Window >Show View >
Other... andthenclick Teiid Designer > Guidesview in the dialog.

The Guides view is shown below, with the Model JDBC Source Action Set selected:

.
A Guides i3 =

Modeling Actions...

+ Action Sets

Model |DBEC Source

L

& Define Teiid Model Project

=@ Create |DBC connection

[, Create source model for |JDBC data source
% Preview Data

i Define VDB

% Execute VDB

Description
<no action selected=

~ Cheat Sheets
Cheat sheets for Teiid Designer use cases

(?) Create Model from JDBC Source

(¥ Create Model from Flat File Source

(¥ Consume a SOAP Web Service

(7 Create Model from XML Local File Source

Figure 7.1. Guides View

. Define Teiid Model Project

a. The Define Teiid Model Project action launches the New Model Project wizard.
In the Action Set list, double-click the action (or select the action, then click Execute
selected action). The wizard is launched as shown below:
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Enter a project name, for example, MyProject in the Name field. Then click Next.

New' Model Project

New Model Project
Create a new model project. ﬁ

Project name: [Mmeieclj ]

Use default location

Location: [,*home,*mdriIIin,*F.untime-Work5paceﬂ?_?_x,’h’lg,meject ] [ Browse... l
Working sets
[] Add project to working sets
Working sets: o) l [ Select... l
@ < Back " Next > l [ Cancel l [ Finish

Figure 7.2. New Project Wizard

b. The next page of the wizard is shown below:

29



User Guide Volume 1: Teiid Designer

New' Model Project

Model Project Options

Click Finish to create folders for your new project

-Create Folders

Name [sources

Name [views

[ Name [schemas

[] Name [web_sewices

[] Name [functiDHS

[] Name [extensinns

S N N S SR N S

@ < Back " Next > l [

Cancel l [ Finish

Figure 7.3. New Project Folders

c. Under Create Folders, clear schemas and web_services. We will not need them for
this example. Now, click Finish to exit the wizard. The project has now been created.

Your Model Explorer view will look like this:

-

Figure 7.4. Model Explorer

= Model Explorer 32 - o= Dutline} = 8
F | 1% &9 <& g ¥
* = MyProject
(= sources
= views
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3. Create JDBC connection
The Create JDBC connection action will create the Connection profile for your
database. The connection profile defines the properties and driver to be used when connecting
to the database. In the Action Set list, double-click the action (or select it, then click Execute
selected action). The wizard is launched as shown below:

New Connection Profile

Connection Profile —

Create a MySQL connection profile.

-Connection Profile Types:

[type filter text ]
T TTITUTTTITA ':"
&4 Ingres

£ MaxDB
ModeShape ]
= MysqL
Ed Oracle

DnctrraSimil L

MName:

| TestMysQl] ]
Description (optional):

| |

@ | < Back || Next > | | Cancel | | Finish

Figure 7.5. Connection Profile Name and Type

Select the type of database that you are connecting to (for example, MySQL), and enter a name
for the connection profile, for example, TestMySQL. Click Next.

31



User Guide Volume 1: Teiid Designer

32

= New Connection Profile =) )

Specify a Driver and Connection Details —

Select a driver from the drop-down and provide login details for the [
connection.

Drivers: | MySQL JDBC Driver S @ A

-Properties

General | Optional

Database: [database

URL: [jdbc:mysql:macalhaat: 3306/database

User name: [raat

(M N N— L SE—

Password: [

[] Save password

Connect when the wizard completes | Test Connection |

[] Connect every time the workbench is started

@ | < Back ” Next = J | Cancel | | Finish

Figure 7.6. Connection Profile properties

Now, select the driver and enter the login properties for your database. Click Finish to
complete the profile creation.

4. Create source model for JDBC data source

a. The Create source model for JDBC data source action will now utilize the
Connection profile that you have created, to import the metadata from the database to

create your Teiid Source Model. In the Action Set list, double-click the action (or select it,
then click Execute selected action). The wizard is launched as shown below:
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Import Database via JDBC

Import Database via JDBC

model,

Select the |DBC source configuration for the database to be imported into a relational

Connection Profile

=] ]

3

| TestMysQL

) o o]

-JDBC Metadata Processor

' JDBC {default)

-Properties

ik

Driver: MySQL |DBC Driver

jdbe:mysgl: flocalhost: 3306/ Accounts
User Name: root

URL:

Password: [rﬂe#:*#

@ < Back I[

‘ I Cancel Finish

Figure 7.7. Select Connection Profile

b. On this page, select the TestMySQL Connection profile that you created in the previous
step. Click Next.
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C Import Database via |DBC | 5|

Select Database Metadata ﬁ
Select the types of objects in the database to import. F |
¥ Foreign Keys Table Types

4 Include Incomplete FKs  JUALIEE
[ Indexes MIEN

: . LOCAL TEMPORARY
[ Unigue Only

[ Approximations Allowed

e

@ [ < Back J[ Next > E ’ Cancel Finish

Figure 7.8. Select Database Metadata

c. On this page, select the database metadata that you want to import. When finished, click
Next.
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Import Database via JDBC

Select Database Objects ﬂ
Press the "Next =" button to continue. |

|FldrEIE5|PI'iI'I‘IElr)‘ Key!lmpurted Foreign ... ™s
TABLE_CAT TABLE_SCHEM | TABLE_NAME COLUMN_NAME DATA_‘I;

Accounts ACCOUNT  ACCOUNT ID
Accounts

(3 TestMySQL &b

b ] information_schem|L
= [] Accounts

~ [+ TABLE ACCOUNT  SSN
CUSTOMER Accounts ACCOUNT  TYPE
] HOLDINGS Accounts ACCOUNT  DATEOQOPENED

Accounts ACCOUNT DATECLOSED

¥ PRODUCT

4 table object(s) selected to import.

] show Only Selected Schemas

@ =< Back l[ Next > l ’ Cancel J l Finish

Figure 7.9. Select Database Objects

d. On this page, select the specific objects from the database that you want to import. When
finished, click Next.
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Import Database via JDBC

Specify Import Options ﬁ
|

Press the "Next =" button to continue or the "Finish" button to finish.

-Relational Model Definition
Model Name: [TesmySQLxmi ] u

Into Folder: [MmejectfsuurCES ] E]

[] Make target a view model
[ Update (if existing model selected)

& Include Catalog For Fully Qualified Names

-Model Object Names (Tables, Procedures, Columns, etc...)
1 Use Fully Qualified Names (Example: partssupplier.dbo.PARTS)

[] Change Case For All Characters
Case Options

P

@ Make All Upper Case (Example: Suppliers = SUPPLIERS)

o | N T ) ) oy
) Make All Lower Case (Example: SUPPLIERS = suppliers)

@ ext= | [ cancel |[ Finish

Figure 7.10. Import Options

. Finally, choose the name for the model to be created (defaults to profileName.xmi). The

Into Folder field defines the target location for your new model. Select the
MyProject/sources folder. Now, click Finish. The source model has now been created.

Your Model Explorer view will look like this:
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;
= Model Explorer 32 - o= Gutline} =

F & =
= [= sources

— [g TestMySQL.xmi

b “= import declarations (2)

is Package Diagram

[ B Accounts.ACCOUNT

> B Accounts.CUSTOMER

> B Accounts.HOLDINGS

> B Accounts.PRODUCT

b [J, Data Source

Figure 7.11. Model Explorer

5. Preview Data

All execution capabilities in Teiid Designer (Preview Data, VDB execution) require you to
connect to a running JBoss Data Virtualization Server. See teiid-view for instructions on
establishing a JBoss Data Virtualization Server connection. Once you are connected to a JBoss
Data Virtualization Server, you can proceed with the following steps.

a. The Preview Data action allows you to preview a sample of data rows from your source.
In the Action Set list, double-click the action (or select it, then click Execute selected
action).

b. In the dialog, select the source table you want to preview, as shown below:
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Table or Procedure Selection

Select table or procedure from workspace and click OK

~ =% MyProject

Vv [= sources
= (g TestMySQL.xmi

I “= import declarations (2)
is Package Diagram

b 8 Accounts.CUSTOMER
> B Accounts.HOLDINGS
> B Accounts.PRODUCT
> [1, Data Source

= views

Figure 7.12. Select Preview Table

c. After selecting the table, click OK. Now, the preview results will be displayed:

|;.‘.5komem5 Q;Ermrmg[:lmLm_n' -_&mmmmrmarﬂ X 5%(E

||T!|rp= query sxpression here | st Aesultl |
ACCOUNT_ID S5M STATUS TYPE DETEQPENED DATEC
13520007 C5TO1002 Persanal 1558-02-01 00; 00

Status Qperation  Date Ce

Sucoa salect * fro Jun 8, 2012 Tn

2 i 19580003 i CATO1003 i Persanal :MIU‘E i 1556-03-06 0 0 000 iml!‘-l
3 19960004 | CETOLa0 ! Berzanal ! Active | 1998-03-07 0000000 20134
4 | 19eB0008 { csTono0s { persanal active { 15mm-06-15 omocong 20124
5 | 19580006 | CHTO1006 | Persanal i Active | 15580815 0000000 {3012+
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Figure 7.13. Preview Results

6. Define VDB

a. The Define VDB action allows you to create a VDB (Virtual Database) artifact for
deployment to a JBoss Data Virtualization Server. In the Action Set list, double-click the
action (or select it, then click Execute selected action). The following dialog is

displayed:
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e New VDB =

New VDB

Press the "Finish" button to finish.

In Folder: [Mmeject l E]

VDB Name: lmw[)|3| ]
-Description

()

Selected Models

g TestMySQL.xmi

® Cancel l [ Finish

Figure 7.14. New VDB

. In the dialog, select the target In Folder location where the VDB will be placed. Enter a
Name for the VDB, for example myVDB. Finally, select the models that will be included in
the VDB. When finished, click Finish. The VDB will be created in your Teiid Model Project
as shown in the following figure.
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; _
= Model Explorer 32 - o= Dutline} = B

F 1% » g ¥
v = MyProject
[ (= sources

= views
i myVDB.vdb

Figure 7.15. Model Explorer

7. Execute VDB
The Execute VDB action allows you to execute your VDB and run sample queries against it. In
the Action Set list, double-click the action (or select it, then click Execute selected action).
In the dialog, select the VDB you want to execute, then click OK. The VDB will be deployed and
executed, and the perpective will switch to the Database Development perspective. You can
now run queries against the VDB, as show in the following example:

T lesteysolani |0 mpvoesch | ) tSOL SoepBoake 5

Cannectian prafile
Type: Teiid_7.x = | Hame: | myNDE - localhast - Teiid Connaction % | Datahasz: | mywDE 2 | Status: Connected, duto Commit

: SELECT * FROM Accounls. MCCUUNE

L ———

(B S0 esalls 5 g Teiid Bxecalion Blan ® OB K|
|'I,'pe quEry sxpression hers J Status | Hesulll
Shatm Operatian  Dats ‘ ACCOUNT_ID 55N SLATUS TIFE DATECIFEMED DT EC LOSED

¥ Sucoe select * e Jun A, 2012 © [ CETOL00Z Parsanal 2012-04-25 11301
Succe SELECT*F Jun 8, 2012 S s ilE CETO100E Parsanal Active 1998-03-06 1 000 2012-04-25 110
F 19560004 | CETO10NG | Parsoral | Artlve | e R R [ O HA 201F-04-25 110
4 1%EE000G CETOIN0E Persoral Aive TOAR-06-15 D0 a0 o 201E-04-25 1150
5 18E000E | CETO100E | Porsaral | At TR0 15 Ok A a0 F IR0

Figure 7.16. Execute VDB Example

7.4. CHEAT SHEETS

In this section, we introduce Cheat Sheets by walking through a simple example. For this example, we
will follow the Consume a SOAP Web Service Cheat Sheet.

7.5. CONSUME A SOAP WEB SERVICE
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This section shows how to consume a SOAP Web Service, using a Cheat Sheet. We will demonstrate
connection to a publicly accessible web service. You can use this process as an example for modeling
other web services.

1. Open the Cheat Sheet
You can access the Cheat Sheet from the Designer Menu. From the Designer main menu,
select Window > Show View > Other.. ., then select Help > Cheat Sheets inthe
dialog.

Alternately, you can access the Cheat Sheet from the Guide View. A sample Guide view is
shown below, with the Consume a SOAP Web Service Action Set selected:

A Guides i3 =

Modeling Actions... ¥

+ Action Sets

Execute selected action

Consume SOAP Web Service

L

& Define Teiid Model Project

<@ Create Web Services (SOAP) connection
g Generate relational models from WSsDL
% Preview Data

i Define VDB

i Execute VDB

-Description

Test a VDB by deploying to Teiid Server, connecting
to it via |DBC and executing gueries against it via
Datatools' SQL Scrapbook

~ Cheat Sheets
Cheat sheets for Teiid Designer use cases

() Create Model from |DBC Source

(¥ Create Model from Flat File Source

() Consume a SOAP Web Service

(7 Create Model from XML Local File Source

Figure 7.17. Guides View
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To open the Cheat Sheet from the Guide View, expand the Cheat Sheet section in the
lower portion of the Guide View, then select the Consume a SOAP Web Service link.

2. Begin the Cheat Sheet
The Consume a SOAP Web Service Cheat Sheet is shown below:

& Cheat Sheets &3 = ¥ =0

Consume a SOAP Web Service

~ Introduction:

This cheat sheet shows you how to consume a
SOAP Web Service by creating source and view
models based on the Web Service WSDL.

] Click to Begin
» Create New Teiid Model Project
» Create SOAP Web Service Connection
» Create Models From SOAP Connection

» Create VDB
» Test VDB

Figure 7.18. Consume SOAP Web Service Cheat Sheet

To start the Cheat Sheet process, expand the Introduction section, then select Click to
Begin. The Create New Teiid Model Project section opens, as shown.
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& Cheat Sheets &3 = ¥ =0

Consume a SOAP Web Service

v » Introduction:
~ Create New Teiid Model Project

Follow the steps below to create a Teiid
Model Project

Launch New Teiid Model Project Wizard =

1) Specify unique project name [V %
2) Click Next > twice to get to Model
Project Options page

3) Check folders you wish the wizard to

create in your project

4) Click Finish

» Create SOAP Web Service Connection
» Create Models From SOAP Connection
» Create VDB

» Test VDB

Figure 7.19. Create Model Project

NOTE

Each section of the sheet has basic instructions outlining what to do at each step.

Project wizard. Follow the wizard to create a new Model Project. For this example, we will use
SOAPProj for our project name. On the second page of the wizard, select the sources and
views folders. Click Finish. The new project is created.

In the Cheat Sheet, you can advance to the next step - once the wizard has completed. Click

E v to advance to the next step.

. Create SOAP Web Service Connection
This section of the Cheat Sheet provides instructions for creating a connection profile for the
SOAP Web Service, as shown below:
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& Cheat Sheets &3 = ¥ =0

Consume a SOAP Web Service

+ » Introduction
+ » Create New Teiid Model Project
+ = Create SOAP Web Service Connection

Follow the steps below to create an ODA
Web Service connection profile using the
WSDL URL and end-point information.

+ Launch Create SOAP Connection Profile ' 'y
Wizard

v 1) Specify unigue name and optional v %
description and click Next >
2) Enter a WSDL URL or 'Browse...' to
select a local WSDL.
3) Click Test Connection to verify
connectivity.
4) Click Finish

» Create Models From SOAP Connection
¢ Create VDB
» Test VDB

Figure 7.20. Create SOAP Connection Profile

wizard. The first page of the wizard is shown below:
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New Connection Profile

New Connection Profile —

Create a SOAP Web Service connection profile. r

-Connection Profile Types:
type filter text ]

i Web Services Data Source (SOAP)

Name:

[Cnu ntrylinfoConn| ]

Description (optional):

| l

® < Back " Next = l [ Cancel l | Finish

Figure 7.21. Create SOAP Connection Profile

The Web Services Data Source (SOAP) profile type will be selected. Enter
CountryInfoConn for the profile name, then click Next. The next page of the wizard is shown
below:
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46

HNew connection profile

Web Service Connection Properties &
Click Next or Finish

Properties
Profile Mame CountryinfoConn
Profile Description [ J

Connection URL or File Path [http:.ffm'rw.I:l-l:lrsprr::lng.Drgfwehsamples.country'infﬂf(:ﬂurrtrylnfnSewice.ws-D?WSDL ]

lﬂnrkspa:e... || Eile System... | [QRL._

Description

The URL defined for this connection profile provides the hook to inject the 'Endpoint” property into a source
maodel via the "Modeling = Set Connection Profile’ action. This 'Endpoint® value is required by the "ws"
translator.

(see "Impart... = Teiid Designer = WSDL File ar URL >> Source and View Model (SOAP))

Test Connection

@ [ = Back | Nest > ] [ Cancel Finish

Figure 7.22. SOAP Connection Properties

The connection profile properties are entered on this page. Click the URL. . . button, then enter
the following URL: http://www.oorsprong.org/websamples.countryinfo/CountrylnfoService.wso?
WSDL. Select None for SecurityType, then click OK to complete the wizard. In the Cheat

Sheet, you can now continue - once the wizard has completed. Click E v to advance to the
next step.

. Create Models from SOAP Connection

This section of the Cheat Sheet provides instructions for creating relational models using the
previously created connection profile for the SOAP Web Service, as shown below:


http://www.oorsprong.org/websamples.countryinfo/CountryInfoService.wso?WSDL
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& Cheat Sheets &3 = ¥ =0

Consume a SOAP Web Service

+ ¢ Introduction
v » Create New Teiid Model Project
b » Create SOAP Web Service Connection
~ Create Models From SOAP Connection

Follow the steps below to create models using the
previously defined connection profile.

v Launch the Consume SOAP Web Service Wizard % 1

1) Select the connection profile, then press v %
validate wsp..
2) Select the Port and Service Mode as desired.

3) Select one or more operations under Select the
desired WSDL Operations. Click Next >.

4) Select the location and name for the Source and
View Models to be created. Click Next >.

5) For each operation, define the request and

response XML documents:

--Select the Operation

--Select the Request tab, then select desired
element(s) under schema contents and Add to

Element Info.

--Select the Response tab, then select desired
element(s) under schema contents and Add to

Column Info.

--Select the Wrapper Procedure tab to view the
generated procedure SQL.

6) When all operation(s) have been defined, click
Finish.

» Create VDB
» Test VDB

Figure 7.23. Create Models from SOAP Connection

wizard. The first page of the wizard is shown below:
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Create Relational Model from Web Service

Create Relational Model from Web Service
Press the "Next =" button to continue.

Connection Profile

lCuuntryrInfuCunn = J [New] [Edlt ]
http:/fwww.oorsprong.or/websamples. countryinfo/CountryinfoSenvice wso?WSDL validate WSDL

Select Port | CountrylnfoServiceSoap
Binding  |SOAP11 | service Mode | PaYLOAD

d or n: J
I
]

Select the desired WSDL Operations

Deselect all |

[ = CountriesUsingCurrency
[ ] = CountryCumency

Selection Details:
Operation: CapitalCity 4
bimding: CountryinfoServiceSoapBinding
port: CountryinfoserviceSoap
SErvice; CountryInfaservice i
<] [ ]
@ | = Back |[ Mext = ] [ Cancel Finish

Figure 7.24. Consume SOAP Wizard

For Connection Profile, select the previously created CountryInfoConn profile. The
available WSDL Operations will then be displayed under Select the desired WSDL
Operations. Select only the first CapitalCity Operation for this example. Click Next to

proceed to the next page, as shown below:

48




CHAPTER 7. TEIID DESIGNER EXAMPLES

Create Relational Model from Web Service

Models Definition
All inputs OK. Click 'Next=' to define custom procedures.

Source Model Definition

Location [SDAPFmi.Fsuurces ] D
Name [CDUH’EWlI’TfDSEWiEE.KI‘I’]i ] E]
Status

Source model CountrylnfoService.xmi does not exist and will be created and contain the required invoke() web
service procedure.

View Model Definition

Location [SOAPProjfviews | E]
Mame [Cnuntﬁrl nfoSenviceview.xmi ] E]
Status

View model CountryInfoServiceView.xmi does not exist and will be created and contain your generated ‘
procedures,

Procedure Generation Options
@ Userspecified Procedures (recommended)

Define user-specified request and response procedures from your WSDL schema elements. This option also generat
and response.

) Default Procedures

Generate default request and response procedures. A new procedure will be generated for each complex type. The

@ | <Back | Next> || cancel Finish

Figure 7.25. Consume SOAP Wizard

On the Model Definition page, the source and view model info section will be pre-filled. We

will keep the names and location defaults for the source and view models. Click Next to proceed
to the next page, as shown below:
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Create Relational Model from Web Service

Procedure Definition
& Mo columns are defined for the response procedure result set for the operation: CapitalCity

-Operations
| CapitalCity

O overwrite existing procedures for this operation

Request | Response .| mepﬂrﬁ'um:iml

Generated Procedure Mame [Eapitalcity_reques.t

BODY | HEADER |

-Schema Contents -Element Info

< (€ CapitalCity

[& sCountrylSOCode

= e SEQUENCE o
elete
-~ O sCountrylSOCode
L string Up

Crowin

-Generated SQL Statement

CREATE VIRTUAL PROCEDURE
BEGIM

SELECT
XMLELEMENT(NAME CapitalCity, XMLNAMESPACES{DEFAULT 'http://wwiw.oorsprong.org/

@ [ < Back ]| Next> | [ Cancel ] |

Finish

Figure 7.26. Consume SOAP Wizard

On the Procedure Definition page, the CapitalCity Operation will be selected since it
is the only one used for this example. On the Request tab, select the sCountryISOCode
element - then click the Add button. This will add the selected element to the request. Now select

the Response tab, as shown below:
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Create Relational Model from Web Service

Procedure Definition

Press the “Finish® button to finish.

-Operations

| CapitalCity s
O owerwrite existing procedures for this operation

Faqlm||ﬁﬂﬁmﬁf.|mnperpmedum|

Generated Procedure Name [Capitall:‘ity_response

BODY | HEADER |

-Schema Contents . Column Info
= [E] CapitalCityResponse Root Path | /ns:CapitalCityResponse ]
Add . I'I.Iam-el :Dmlinalihr: Da:‘.a Type :DEfELi|
@ string Delete B CapitalCityResult :a i string i
. Up
e | (< >

“Generated S5QL Statement

CREATE VIRTUAL PROCEDURE B
BEGIN :
SELECT L.* FROM ~]

@ = Back || Next = Cancel ] [ Finish

Figure 7.27. Consume SOAP Wizard

On the Response tab, select the Body sub-tab. In the Schema Contents, select the
CapitalcCityResult, and then click the Add button. This will add the selected element to the

response. Select the Wrapper Procedure tab to see the full Generated Procedure SQL, as
shown below.
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Create Relational Model from Web Service

Procedure Definition
Press the "Finish" button ko finish, A
-Operations
CapitalCity A
[0 Owerwrite ex sting proce dures for this operation

. H&quest] Mpnrﬁe| Wrapper Procedure
Generated Procedure Name
| capitalCity
Generated SQL Statement

CREATE VIRTUAL PROCEDURE
BEGIN
SELECT L.* FROM
TABLE(EXEC CountryinfoServiceview. CapitalCity _request
{CountryinfoServiceView.CapitalCity. sCountryl50 Code)
AS request,
TABLE(EXEC CountrylnfoServiceinvoke('SOAP11', null, REQUEST.xml_out, null))
AS response,
TABLE(EXEC CountrylnfoServiceView. CapitalCity_response{RESPONSE.result))
AST;
ENDY
@ < Back ]| Mext = Cancel | [ Finish

Figure 7.28. Consume SOAP Wizard
Click Finish to exit the wizard. In the Cheat Sheet, you can now continue. Click to
advance to the next step.

5. Create VDB
This section of the Cheat Sheet provides instructions for creating a VDB using the models that
you created in the previous step. The Cheat Sheet section is shown below:
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& Cheat Sheets &3 = ¥ =0

Consume a SOAP Web Service

+ ¢ Introduction

+ » Create New Teiid Model Project

b » Create SOAP Web Service Connection

% » Create Models From SOAP Connection
-~ Create VDB

Follow the steps below to create a new VDB

+ Launch New VDB Wizard % 1

1) Select "..." button to browse and select {3
project or folder location.
2) Enter a unique name for your VDB

3) Enter an optional description for your VDB

4) Select the Add button to choose models

to go in your VDB

5) Click Finish

» Test VDB

Figure 7.29. Create VDB

create a VDB in your workspace. When complete, exit the wizard. In the Cheat Sheet, you can

now continue. Click E v to advance to the next step.

. Test VDB
This final section of the Cheat Sheet provides instructions for executing the VDB created in the

Select the previously created VDB to execute it.
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CHAPTER 8. NEW MODEL WIZARDS

8.1. LAUNCH NEW MODEL WIZARDS

Models are the primary resource used by the Teiid Designer. Creating models can be accomplished by
either directly importing existing metadata or by creating them using one of several New Model wizard
options. This section describes these wizards in detail.

Use one of the following options to launch the New Model Wizard.

e o Click File > New... > Metadata Model action.

o Select a project or folder in the Model Explorer View and choose the same action in the
right-click menu.

o Select the New button on the main toolbar and select the Metadata Model action .

NOTE

Model names are required to be unique within Teiid Designer. When specifying model
names in new model wizards and dialogs error messages will be presented and you will
prevented from entering an existing name.

8.2. CREATE NEW RELATIONAL SOURCE MODEL

8.2.1. Create a New Relational Source Model

To create a new empty relational source model:
1. Launch the New Model Wizard.
2. Specify a unique model name.
3. Select Relational option from Model Class drop-down menu.
4. Select Source Model from Model Type drop-down menu.

5. Click Finish.

NOTE

You can change the target location (i.e. project or folder) by selecting the Browse. . .
button and selecting a project or folder within your workspace.

In addition to creating a new empty relational source model, you can also copy from existing model of the
same model class.

8.2.2. Generate File Translator Procedures

This builder option allows construction of a relational model containing one or more of the procedures
required for accessing file based data via a file translator.
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To create a new relational model containing file translator procedures, complete Create a New
Relational Source Model section and continue with these additional steps:

1. Select the model builder labeled Generate File Translator Procedures and click Next
>. The Generate File Translator Procedures dialog will be displayed.

2. Select one or more of the Available File Translator Procedures, then click Finish.

8.2.3. Generate Web Service Translator Procedures

This builder option allows construction of a relational model containing one or more of the procedures
required for accessing web-service-based XML data via a web service translator.

To create a new relational model containing web-service-based translator procedures, complete Create
a New Relational Source Model section and continue with these additional steps:

1. Select the model builder labeled Generate Web Service Translator Procedures and
click Next >. The Generate Web Service Translator Procedures dialog will be
displayed.

2. Select one or more of the Available Web Services Translator Procedures, then click

Finish.

8.2.4. Copy from an Existing Relational Source Model

This builder option performs a structural copy of the contents of an existing model to a newly defined
model. You can choose a full copy or select individual model components for copy.

To create a new relational model by copying contents from another relational source model, complete
Create a New Relational Source Model section and continue with these additional steps:

1. Select the model builder labeled Copy from existing model of the same model class and
click Next >. The Copy Existing Model dialog will be displayed.

2. Select an existing relational model from the workspace using the browse button.

NOTE

An existing model will be preselected if a relational model in the workspace is
selected in the model-explorer-view prior to starting the new model wizard.

3. Select the Copy all descriptions option if desired. Click Finish.

8.3. CREATE A NEW RELATIONAL VIEW MODEL

8.3.1. Create a New Relational View Model

To create a new empty relational view model:
1. Launch the New Model Wizard.

2. Specify a unique model name.
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3. Select Relational option from Model Class drop-down menu.
4. Select View Model from Model Type drop-down menu.

5. Click Finish.

NOTE

You can change the target location (i.e. project or folder) by selecting the Browse. . .
button and selecting a project or folder within your workspace.

In addition to creating a new empty relational view model, the following builder options are available:
1. Copy from existing model of the same model class.

2. Transform from existing model.

8.3.2. Copy an Existing Relational View Model

This builder option performs a structural copy of the contents of an existing model to a newly defined
model. You can choose a full copy or select individual model components for copy.

To create a new relational model by copying contents from another relational view model, complete
Create a New Relational View Model section and continue with these additional steps:

1. Select the model builder labeled Copy from existing model of the same model class and click
Next >.The Copy Existing Model dialog will be displayed.

2. Select an existing relational model from the workspace using the browse button.

3. Select the Copy all descriptions option if desired. Click Finish.

8.3.3. Transform from an Existing Relational View Model

This option is only applicable for creating a relational view model from a relational source model with the
added feature of creating default transformations (SELECT * FROM SourceModel.Table_X) for each
source table. The steps are the same as for the Copy from Relational View Model section described
above.

There is an additional option in the second dialog window of the wizard which can automatically set the
relational table's supports update property to false. If this is not selected, the default value will be true.

8.4. CREATE A NEW XML DOCUMENT VIEW MODEL

8.4.1. Create a New XML Document View Model

To create a new empty XML document view model:
1. Launch the New Model Wizard.
2. Specify a unique model name.

3. Select XML option from Model Class drop-down menu.
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4. Select View Model from Model Type drop-down menu.

5. Click Finish.

NOTE

You can change the target location (i.e. project or folder) by selecting the Browse. . .
button and selecting a project or folder within your workspace.

In addition to creating a new empty XML document view model, the following builder options are
available:

1. Copy from existing model of the same model class.

2. Build XML documents from XML schema.

8.4.2. Copy an Existing XML Document View Model

This builder option performs a structural copy of the contents of an existing model to a newly defined
model. You can choose a full copy or select individual model components for copy.

To create a new relational model by copying contents from another XML document view model,
complete Create a New XML Document View Model section and continue with these additional steps:

1. Select the model builder labeled Copy from existing model of the same model class and
click Next >. The Copy Existing Model dialog will be displayed.

2. Select an existing relational model from the workspace using the browse button.

3. Select the Copy all descriptions option if desired. Click Finish.

8.4.3. Build an XML Document View Model

This option creates an XML View document model based on a selected XML schema and its
dependencies.

To create a new XML document view model by from XML schema, complete Create a Xml Document
View Model section and continue with these additional steps:

1. Select the model builder labeled Build XML documents from XML schema and click Next
> The Select XML Schema dialog will be displayed.

2. Select an existing schema model from the workspace using the browse button.

NOTE

An existing model will be preselected if an XSD model in the workspace is
selected in the VDB explorer prior to starting the new model wizard. The schema
must be found in the workspace so if you need to get one or more into the
workspace use the XSD Schemas on file system importer.

3. Move the available schema root elements you want to become virtual documents in the new
model over to the Virtual Documents list by using the arrow button to move all elements.
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4. Select the appropriate document options and mapping options. Click Finish.

5. Click Finish to create a model of all selected document entities or (optional) click Next > to
view Selected Documents Statistics page which shows document entity statistics and
gives you an idea the size of the model being created.

6. (Optional) Click Finish to create a model of all selected document entities or click Next > to
view Preview Generated Documents page that allows you to exclude document specific
entities then click Finish.

NOTE

For deeply nested schema, your total entity count may be large. If so, displaying
the preview may take some time.

8.5. CREATE A NEW XML SCHEMA MODEL

8.5.1. Create a New XML Schema Model

To create a new empty XML schema (. xsd) model:
1. Launch the New Model Wizard.
2. Specify a unique model name.
3. Select XML Schema (XSD) option from Model Class drop-down menu.
4. Select Datatype Model from Model Type drop-down menu.

5. Click Finish.

NOTE

You can change the target location (i.e. project or folder) by selecting the Browse. . .
button and selecting a project or folder within your workspace.

In addition to creating a new empty XML schema model, the following builder option is available:

e Copy from existing model of the same model class.

8.5.2. Copy an Existing XML Schema Model

This builder option performs a structural copy of the contents of an existing model to a newly defined
model. You can choose a full copy or select individual model components for copy.

To create a new relational model by copying contents from another XML schema model, complete
Create a New XML Schema Model section and continue with these additional steps:

1. Select the model builder labeled Copy from existing model of the same model class and
click Next >. The Copy Existing Model dialog will be displayed.

2. Select an existing relational model from the workspace using the browse button.
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3. Select the Copy all descriptions option if desired. Click Finish.

8.6. CREATE A NEW WEB SERVICE VIEW MODEL

8.6.1. Create a New Web Service View Model

To create a new empty web service view model:
1. Launch the New Model Wizard.
2. Specify a unique model name.
3. Select Web Service option from Model Class drop-down menu.
4. Select View Model from Model Type drop-down menu.

5. Click Finish.

NOTE

You can change the target location (i.e. project or folder) by selecting the Browse. . .
button and selecting a project or folder within your workspace.

In addition to creating a new empty web service view model, the following builder options are available:
1. Copy from existing model of the same model class.

2. Build from existing WSDL file(s) or URL.

8.6.2. Copy an Existing Web Service View Model

This builder option performs a structural copy of the contents of an existing model to a newly defined
model. You can choose a full copy or select individual model components for copy.

To create a new relational model by copying contents from another web service view model, complete
Create a New Web Service View Model section and continue with these additional steps:

1. Select the model builder labeled Copy from existing model of the same model class and
click Next >. The Copy Existing Model dialog will be displayed.

2. Select an existing relational model from the workspace using the browse button.

3. Select the Copy all descriptions option if desired. Click Finish.

8.6.3. Create a Web Service View Model from a WSDL File or URL

This builder option creates a Web service model based on a user defined WSDL file and its referenced
schemas. In addition, applicable XML schema files and XML View document models (optional) are
created.

To create a new relational model by copying contents from another web service view model, complete
Create a New Web Service View Model section and continue with these additional steps:
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1. Select the model builder labeled Build from existing WSDL file(s) or URL and click
Next >.

2. The remaining wizard steps are identical to those found using the wsdl-to-web-service-import
section action option.

8.6.4. Create a Web Service View Model from Relational Models

See Create Web Service Models section.

8.6.5. Create a Web Service View Model from XML Document View Models

Web Service models and their corresponding Interfaces and Operations can be generated in Teiid
Designer from XML View model components. Namely, XML View Documents and XML View Document
roots.

To create a new Web service model from XML components:

—_

. Select either a single XML Document or single XML Document root in the Model Explorer View.

N

. Right-click select Modeling > Create Web Service action .
3. Fill in missing properties in Web Service Generation Wizard shown below.

4. Click Finish to generate model. When model generation is complete, a confirmation dialog is
displayed. Click OK.

NOTE

Users can change the Web Service Model and Interface Name values (via "..." buttons) to
use existing Web service model components. This will create a new operation in an
existing model.
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CHAPTER 9. IMPORTERS

9.1. IMPORTERS

The Import Wizard provides a means to create a model based on the structure of a data source, to
convert existing metadata (that is, WSDL or XML Schema) into a source model or to load existing
metadata files into the current VDB.

To launch the Import Wizard, select the File > Import action or select a project, folder or model in
the tree and right-click select Import. ..

[ Import x

Select

N
Choose import source. | g - EI

Select an import source:
[1:_. pe filter text 5]

[* [= Plug-in Development

[* = Run/Debug

[* (= Team

* B Teiid Designer
[, DDL File == Source or View Model
@? Designer Text Ale => Source or View Models
|_—ﬂi Fle Source (Flat) == Source and View Model
|_—ﬂi Fle Source (XML) == Source and View Model
[, JDBC Database == Source Model
X' salesforce >> Source Model
@? WSDL Ale or URL == Source Model
e P WSOL Fle or URL == Web Service Model
[S] XML Schemas

[ = XML

® | < Back ” Next = | | Cancel | | Einish

Figure 9.1. Import Wizard

9.2. IMPORT DDL
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You can create source relational models by importing DDL using the steps below.

1. In Model Explorer, click File > Import action £ in the toolbar or select a project, folder or
model in the tree and click Import. ..

2. Select the import option Teiid Designer > DDL File >> Source or View Model and
click Next>.

3. Select existing DDL from either Choose from file system... or Choose from workspace.... Set

the Model folder location, enter or select valid model name, set Model type (Source Model or
View Model), set desired options and click NEXT> (or Finish if enabled)

Import DDL

Provide DDL source i
v |

Create relational source model "Accounts” using DDL file “/home/nshendye/
workspace/Teiid-MySQLAccounts.ddl”.

Choose from file system...

DDL file: rendye/workspace/Teiid-MySQLAccounts.ddl
Choose from workspace...
DDL Dialect: ' Auto-select
Model folder: |/TestDDL Choose...
Model name: | Accounts Choose...

Model type: Source Model

| Set description of model entities to corresponding DDL statement
| Create model entities for DOL defined by unsupported DML (e.g., Views)

- DDOL file contents

CREATE FOREIGM TABLE "accounts. ACCOUNT" ( |
ACCOUNT_ID long NOT NULL DEFAULT '0° OPTIONS (ANNOTATION ", NAMEINSOURCI
55N string(10) OPTIONS (ANNOTATION *, NAMEINSOURCE ""S5N™, NATIVE_TYPE 'Ck
STATUS string(10) OPTIONS |(ANNOTATION ", NAMEINSCURCE ""STATUS™, NATIVE_T
TYPE string(10) OPTIONS (ANNOTATION ", NAMEINSOURCE ""TYPE ™', NATIVE_TYPE 'C
DATEOPENED timestamp NOT NULL DEFAULT 'CURRENT_TIMESTAMP" OPTIONS (ANNC
DATECLOSED timestamp NOT MULL DEFAULT '0000-00-00 00:00:00" OPTIONS [ANMNC

@ < Back Mext = Cancel

Figure 9.2. DDL Import Options

4. If you click NEXT>, a difference report is presented for viewing or deselecting individual
relational entities. Click Finish to complete.
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Import DDL

Select the Differences to Apply ﬁ
|

Select the items to apply, then click ‘Finish".

ltems for Import

- @  Objects to Create
" B ACCOUNT
« B CUSTOMER
" B HOLDINGS
« B PRODUCT

« B SUBSCRIPTIONS

Import Messages

@ < Back Mext Cancel Finish

Figure 9.3. Import DDL Dialog

9.3. IMPORT FROM JDBC DATABASE

You can create relational source models from your JDBC source schema data using the steps below.

NOTE

Depending the detail provided in the database connection URL information and schema,
Steps 5 through 7 may not be required.

1. In Model Explorer, Click File > Import action in the toolbar or select a project, folder or
model in the tree and click Import. ..
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2. Select the import option Metadata Modeling > JDBC Database >> Source Model and

click Next>.

3. Select existing or previous connection profile from the drop-down selector or click New. . .

button to launch the New Connection Profile dialog or Edit... to modify/change an existing
connection profile prior to selection.

NOTE
The Connection Profile selection list will be populated with only JDBC Database
connections.
||:l Import Database via |[DBC %
Select a |DBC source configuration ﬁ
Select the JDBC source configuration for the database to be imported into a relational d

madel.

‘Connection Profile

; | [New. | [Ear

JDBC Metadata Processor

|

-Properties

i

Driver:
URL:
User Name:

Password:

@

Figure 9.4. Select JDBC Source Configuration Dialog

Because JDBC databases are different, special processing of your metadata to be required in
order to convert datatypes or to interpret your metadata. The JDBC Metadata Processor drop-
down selector will be selected automatically based on your selected connection profile. Special
processors are available for DB2, ModeShape, ODBC, Oracle, PostgeSQL, SQL Server and
Sybase. For all other DBs a default JDBC processor is available.

. After selecting a Connection Profile, enter the password (if not provided). Click Next> (or

Finish if enabled).



CHAPTER 9. IMPORTERS

[ 1 Import Database via IDBC

Select a |DBC source configuration ﬁ
v

Press the "Mext =" button to continue or the "Rnish" button to finish.

x

-Connection Profile

| PartsOraclel1 ¢ | [New..|[Edit. |

-JDBC Metadata Processor

[ Oracle z l
-Properties

Driver: Oracle 11 Thin Driver

LRL: jdbc:oracle:thin:@ dbhoo2s. www. mydb.com: 1521:db25

User Name: partssupplier

Passwaord: ok

® | < Back ][ Next = H Cancel H Finish

Figure 9.5. Select JDBC Source Configuration Dialog

5. Onthe Select Database Metadata page, select the types of objects in the database to
import. Click Next> (or Finish if enabled).
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Import Database via JDBC

Select Database Metadata ﬁ
Press the "Next =" button to continue or the "Anish" button to finish. o
Fareign Keys -Table Types
Indexes SYNONYM

[] Unigue Only VIEW
W A i ti All d
pproximations Allowe select Al

[] Procedures
Deselect All

@ < Back H Next = ] [ Cancel Finish

Figure 9.6. Select Database Metadata Dialog

6. Onthe Select Database Objects page, view the contents of the schema, or change
selections. Select which database schema objects will be used to construct relational objects.
Click Next> (or Finish if enabled).
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Import Database via JDBC

Select Database Objects ﬁ
Select the objects to import from database "PartsOraclell™. 14
ﬂ PartsOraclell Q}% WL Indexes | Primany Keyl Imported Foreign ... 3
TABLE_CAT TABLE SCHEM TABLE MNAME COLUMM _MNAME DATA TYPE TYPE |
- PARTSSUPPLIER &
PARTSSUPPLIER PARTS PART 1D 1 CHAR
- [#] TABLE -
PARTSSUPPLIER PARTS PART MAME 12 WARCH
PARTS -
PARTSSUPPLIER PARTS PART COLOR 12 WARCH
SHIP_WIA -
- PARTSSUPPLIER PARTS PART WEIGHT 12 WARCH
STATUS -
SUPPLIER
SUPPLIER_PARTS
P[] PM

5 table object(s) selected to import.

Deselact All

[] Show Only Selected Schemas

@ [ < Back ][ Next > ][ Cancel ]| Finish |

Figure 9.7. Select Database Options Dialog

7. Onthe Specify Import Options page, specify desired Model Name as well as any other
options used to customize the naming of your relational objects. Click Finish to complete.
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] Import Database via [DBC o
Specify Import Options ﬁ
Specify the name, location, and import options for the new relational model of d
database "PartsOraclell.xmi".
-Relational Model Definition
Model Name: [F’arts[lraclell.xmi ] E]
Into Folder: [Par‘tsTest ] E]
[] Update (if existing model selected)]

[] Include Catalog For Rully Qualified Names

-Model Object Mames (Tables, Procedures, Columns, etc...}

Use Fully Qualified Names (Example: partssupplier. dbo. PARTS)

[] change Case For All Characters

-Case Options

(@ Make all Upper Case (Example: Suppliers = SUPPLIERS)
() Make all Lower Case (Example: SUPPLIERS = suppliers)
@ < Back | Next = | [ Cancel l [ EBnish

Figure 9.8. Specify Import Options Dialog

8. During the Finish processing, a monitor will be displayed providing feedback on the import
progress.

Progress Information

@ Impaorting from JDBC database: PartsOraclell

-

Processing database object (1 of 5) - creating BaseTable "PARTS"

Cancel

Figure 9.9. JDBC Import Progress Dialog

9.4. IMPORT FROM TEIID DATA SOURCE CONNECTION
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The Teiid Connection Source Model import option provides a means to create relational source models
from JDBC and other deployed data sources that are not supported by other Teiid Designer importers.

Procedure 9.1. Import From Teiid Data Source Connection

1. Go to the Model Explorer.
2. Choose the File - Import action in the toolbar.
Select a project, folder or model in the tree and then select Import. ..
3. Select Teiid Designer - Teiid Connection - Source Model and then click Next.
4. Select the datasource to use for the import.

You can create a new source if the one you want does not already exist. You can also
undertake other source management functions here.

5. Click Next.

6. Select the appropriate translator for your data source type as well as defined the target relational
model that you wish to create or update and then click Next.

7. When you move to next page of the wizard, a temporary dynamic vdb is actually deployed to
your server and the schema for your data source is retrieved in DDL form. This DDL is displayed
(and you can also be exported if you so desire). Click Next.

8. On the final page of the wizard, a difference report is presented for viewing or de-selecting
individual relational entities. Press Finish to complete.

9.5. IMPORT FROM FLAT FILE SOURCE

You can import metadata from your flat file data sources and create the metamodels required to query
your data in minutes. Using the steps below you will define your flat file data source, configure your
parsing parameters for the flat file, generate a source model containing the standard Teiid flat file
procedure and create view tables containing the SQL defining the column data in your flat file.

JBoss Data Virtualization supports Flat Files as data sources. Teiid Designer provides an Import
wizard designed to assist in creating the metadata models required to access the data in your flat files.
As with Designer's JDBC, Salesforce and WSDL importers, the Flat File importer is based on utilizing a
specific Data Tools Connection Profile.

The results of the importer will include a source model containing the getTextFiles( ) procedures
supported by JBoss Data Virtualization.

The importer will also create a new view model containing a view table for your selected flat file source
file. Within the view table will be generated SQL transformation containing the getTextFiles()
procedure from your source model as well as the column definitions and parameters required for the
Teiid TEXTTABLE( ) function used to query the data file. You can also choose to update an existing view
model instead of creating a new view model.

The TEXTTABLE function processes character input to produce tabular output. It supports both fixed and
delimited file format parsing. The function itself defines what columns it projects. The TEXTTABLE
function is implicitly a nested table and may be correlated to preceding FROM clause entries.
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TEXTTABLE(expression COLUMNS <COLUMN>, ... [DELIMITER char]
[ (QUOTE |ESCAPE) char] [HEADER [integer]] [SKIP integer]) AS name

Teiid Designer will construct the full SQL statement for each view table in the form:

SELECT A.Name, A.Sport, A.Position, A.Team, A.City, A.StateCode,
A.AnnualSalary FROM (EXEC PlayerDataSource.getTextFiles('PlayerData.txt'))
AS f, TEXTTABLE(f.file COLUMNS Name string, Sport string, Position string,
Team string, City string, StateCode string, AnnualSalary string HEADER 2
SKIP 3) AS A

To import from your flat file source follow the steps below.

1. InModel Explorer,click File > Import action £ in the toolbar or select a project, folder
or model in the tree and click Import. ..

2. Select the import option Teiid Designer > File Source (Flat) >> Source and
View Model and click Next>.
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» Import x

Select

Y
Choose import source. | g - EI

Select an import source:
[1:_ pe filter text «f]

[* = Plug-in Development

[* = Run/Debug

[ = Team

= = Teiid Designer
ﬁ‘ DOL Ale == Source or View Model
Bg? Designer Text Fle == Source or View Models
|_—ﬁi Fle Source (Flat) == Source and View Model
Eﬁi Fle Source (XML) >> Source and View Model
[, IDBC Database >> Source Model
:r}i.':- Salesforce >> Source Model
Bg-j WSDL Fle or URL >> Source Model
o P WSOL Fle or URL >> Web Service Model
[S] XML Schemas

[ = XML

@ | = Back ” Next = | [ Cancel ] | Enish

Figure 9.10. Import from Flat File Source

. Select existing or previous connection profile from the drop-down selector or click New. . .
button to launch the New Connection Profile dialog or Edit. .. to modify or change an
existing connection profile prior to selection. Note that the Flat File Source selection list will be
populated with only Flat File connection profiles.

After selecting a Connection Profile, the file contents of the folder defined in the connection

profile will be displayed in the Available Data Files panel. Select the data file you wish to
process. The data from this file, along with your custom import options, will be used to construct
a view table containing the required SQL transformation for retrieving your data and returning a

result set.

Lastly enter or unique source model name in the Source Model Definition section at the
bottom of the page or select an existing source model using the Browse button. Note the Model
Status section which will indicate the validity of the model name, whether the model exists or not



User Guide Volume 1: Teiid Designer

and whether the model already contains the getTextFiles() procedure. In this case, the

source model nor the procedure will be generated.
When finished with this page, click Next>.

[ Import From Flat File Source

Data File Source Selection

Press the "Next =" button to continue.

-Data File Source

EmployeeData = ] [New...] [Edit...]

-Available Data Files

Folder location: /homefblafond/TestDesignerFolder/FatFleData/emplovee-data

Data Fle Mame

[[] EmpDataFxedwidth. tet
[] EmployeeData. et
PlayerData. tut

Selected Data Fle: [PlayerData.txt

Source Model Definition

Location [Test)(mllmpur‘t

Name: [TextﬁlePracedures.xmi

-Model Status

EXISTING MODEL: Source model TextAleProcedures xmi already contains required
getTextAles() procedure.

@ < Back ][ Mext = ][ Cancel ]|

_Hrli:l-l

Figure 9.11. Data File Source Selection Page

4. The next page, titled Flat File Column Format Definition, requires defining the format of your

column data in the file. The options are Character delimited and Fixed width. This page

contains a preview of the contents of your file to aid in determining the format. The wizard

defaults to displaying the first 20 lines, but you can change that value if you wish.

When finished with this page, click Next>.
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Import From Flat File Source

Flat File Column Format Definition

Press the "Mext =" button to continue.

Selected Data Ale: [EmplnyeeData.b{t l

‘File Preview Options

Mumber of lines in file : Mumber of preview lines

Select Column Format

(@ Character delimited () Fixed width

File Contents Preview

LastName,F1rstName, MiddleMName, EmpId, Department, AnnualSalary,Title, HomePhone,Mgrid, S
Kisselmeyer, Abbiegale,Tikvica ,9000059,G,64000.00, MGMT WannaBe, 670-270- 7947, 9000073
Glore,Diodie, Vojvoda ,9000060,G, 71000, Assoclate, 480- 650- 9750, 9000073, 127 State St.,
Dawson,Pinckney,Ostoja , 9000061, G, 71000, Assoclate, 110- 400- 3600, 9000073, 135 State St
wWaldrip,Trixie,Curic ,5000062,G,57000,Newbie,820-210-7045, 9000073, 136 State St.,Alb
Kitchen,Zilpha,Buic ,9000063,G, 50000, MGMT WannaBe,560- 300- 3785, 9000073, 138 State St
Wakeman, Gerard, Vlahovic ,9000084,G, 78000, Newble, 700- 190- 5880, 0000073, 130 State St.,
Rafferty,Dock,Korda ,9000065,G,70000,Newbie, 400-190- 6192, 9000073, 128 State St.,Sacr
Kersavage,Zelda,Mjesecevic , 9000066, G, 56000, MGMT WannaBe, 802-930- 1482, 9000073, 137 S
Zummer, Gerda,Milan ,9000067,G, 59000, Newbie,920- 100- 9701, 9000073, 131 State St.,Bango
Davies, Allwyne,Radic ,9000068,G, 51000, Assoclate, 470- 820- 6096, 9000073, 126 State St.,
Deanford, Abe,Skrabalo ,9000089,G, 67000, Assoclate, 907-660- 8233, 9000073, 124 State St.
Garcla,Orsal,Ucovic ,9000070,ML,79000, CFQ, 480- 490- 7710, 9000075, 150 State St.,Phoeni
Zook,Orson,Bendevis ,9000071,G,71000,Newb1e, 350- 260- B654, 9000073, 133 State 5t.,Bost
Rainier,Adelaid,Marinovic ,9000072,G,67000,Newble, 316-550- 3499, 9000073, 125 State St
MNealon, General, , 9000073, G, 77000, CO0, 203- 420- 3113, 9000075, 129 State St.,Hartford,CT,
Garahana, Jarrod,Cvjetkovic ,9000074,G, 66000, Associate, 6520- 430- 1782, 9000073, 132 Stat
Neely,Petronella,Goravica ,9000075,G, 80000, CEQ, 230- 320- 6330, 9000076, 134 State St.,L

| | [2)

@ [ < Back

(8]
1]
=
~
1]
|

Figure 9.12. Data File Source Selection Page

. Character Delimited Option - The primary purpose of this importer is to help you create a view
table containing the transformation required to query the user defined data file. This page
presents a number of options you can use to customize the Generated SQL Statement, shown in
the bottom panel, for the character delimited option. Specify header options (Column names in
header, header line number and first data line number), Parse selected row, changed character
delimiter and edit the TEXTTABLE( ) function options.

If columns names are not defined in a file header or if you wish to modify or create custom
columns, you can use the ADD, DELETE, UP, DOWN to manage the column info in your SQL.

When finished with this page, click Next>.
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||:I Import From Flat File Source

Flat File Delimited Columns Parser Settings

Press the "MNext =" button to continue.

Selected Data Fle: |EmployeeData.tet

-‘Format Options

Column names in header

Header line # [1

Data line # [2

[ Parse Selected Row

[ Edit Delimiter Character

]
]
l
l
l

File Contents Preview

LastName,FirstName,MiddleName,EmpId,DEI.
Kisselmeyer,Abbiegale,Tikvica ,200005%
Glore,Diodie,Vojvoda ,9000060,G, 71000,
Dawson,Pinckney,Ostoja ,9000061,G, 710C
Waldrip,Trixie,Curic ,9000062,G,57000,
Kitchen,Zilpha,Buic , 2000063, G, 60000,
Wakeman, Gerard, Vlahovic ,5000064,G, 78C

[
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[Edit TEXTTABLE() function options v
B

-Column Information

Column Name Datatype

LastMame string

M FrstMame string

B MiddleName string

E Empld string

ADD RE-EJE JP DIDWM

‘Generated SQL Statement

SELECT (<)
A LastName, A ArstMName, A MiddleName, A Empld, A.Department, A AnnualSalarny, A Title,
A HomePhone, A Magrld, A Street, A City, A State, A ZipCode
FROM
[EXEC AAMA getTextFlesi'EmployeeData.tt')) AS f, TEXTTABLE(file COLUMNS LastMame
string, FArstName string, MiddleName string, Empld string, Department string, AnnualSalary
string, Title string, HomePhone string, Mgrid string, Street string, City string, State string,
FipCode string HEADER) AS A ]

@ «< Back

Figure 9.13. Flat File Delimited Columns Options Page

To aid in determining if your parser settings are correct you can select a data row in your File
Contents Preview section and click the Parse Selected Row button. A dialog will be
displayed showing the list of columns and the resulting column data. If your column data is not
what you expected, you'll need to adjust your settings accordingly.



CHAPTER 9. IMPORTERS

™|

Parsed Column Data s

e

The following list contains the parsed column data from the
selected line

Parsed Column Data

élastName : Glore

ArstName : Diodie
MiddleName : Vojvoda
Empld : 9000060
Department © &
AnnualSalary : 71000
Title : Associate
HomePhone : 480-650-9750
Mgrid : 9000073
Street : 127 State St
City : Los Angeles
State : CA

ZipCode : 10005

® Cancel | [ oK |

Figure 9.14. Parse Column Data Dialog

. Fixed Column Width Option - The primary purpose of this importer is to help you create a view
table containing the transformation required to query the user defined data file. This page
presents a number of options you can use to customize the Generated SQL Statement , shown
in the bottom panel, for the fixed column width option. Specify header options (Column names in
header, header line number and first data line number), Parse selected row, changed character
delimiter and edit the TEXTTABLE (') function options. See the Teiid User's Guide for details on
the TEXTTABLE () function.

If columns names are not defined in a file header or if you wish to modify or create custom
columns, you can use the ADD, DELETE, UP, DOWN to manage the column info in your SQL.

You can also utilize the cursor position and text length values in the upper left panel to
determine what your column widths are in your data file.

When finished with this page, click Next>.
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i Import From Flat File Source x

Flat File Fixed Columns Width Parser Settings

Press the "Next =" button to continue.

Selected Data FAle: [EmpDataerdWidth.b{t ]

-Format Options— File Contents Preview

Data line # E] /I Department string WIDTH 5, AnnualSalary integer WI
1/ Mgrid integer WIDTH 8, Street string WIDTH 14, Cit

Cursor Position I

— Kisselmeyer Abbiggale Tixrica =Talololost=NN¢] 54000
Glore Diodie Vojvoda 0000060 G 71000
Dawson Pinckney Ostoja 9000061 G 71000
Waldrip Trixie Curic 00OEO6E2 G 57000
kKitchen Zilpha Buic 0000063 G 60000
Wakeman Gerard Vlahovic 0000064 G 78000
Baffartu Minele Knrda QNNNNES. rialatalal
| [>]

~-Column Options., -Column Information

ADD Column Name Datatype Width
H firstName string 12
E middleMame string 12

-P- lastName

DOWN |

~Teiid TEXTTABLE() Function Options
[] Include HEADER [] Include SKIP [] Include QUOTE |® [] Include ESCAPE

-Generated SQL Statement

SELECT

A firstName, A middleMame, A column_3
FROM

[EXEC ssss.getTextfles{'EmpDataFxedWidth.t<t']) AS f, TEXTTABLE(file COLUMNS firstMame string width
12, middleMame string width 12, column_3 string width 12 ) AS A

@ [ < Back " Next = ] [ Cancel ] | Enish

Figure 9.15. Flat File Fixed Columns Width Options Page

. On the View Model Definition page, select the target folder location where your new view model

will be created. You can also select an existing model for your new view tables. Note the Model
Status section which will indicate the validity of the model name, whether the model exists or not.
Lastly, enter a unique, valid view table name. Click Finish to generate your models and finish

the wizard.
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- Import From Flat File Source o

View Model Definition
Press the "Fnish" button to finish.

Selected Data File: [PIayerData.tx‘t l

View Model Definition

Location [Test)(mllmpnr‘t l E]

Name: [M}rEmpInyee\-’iews.xmi l E]

-Model Status

EXISTING MODEL: Mew view tables will be created in your existing view model
MyEmployeeViews. xmi on FINISH.

New wview table name: [PIayerDataTabIe J

@ [ < Back “ Next = | [ Cancel ] I Fnish I

Figure 9.16. View Model Definition Page

When your import is finished your source model will be opened in an editor and show a diagram
containing the your getTextFiles() procedure.
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G

&g

ffs Package Diagram | [=] Table Editor

Figure 9.17. Generated Flat File Procedures

In addition, the view model will be opened in an editor and will show the generated view tables
containing the completed SQL required to access the data in your flat file using the getTextFiles
procedure above and the Teiid TEXTTABLE () function. The following figure is an example of a
generated view table.
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[ EmployeeViews.xmi 3 =8
& VIEW
=

==Base Table== |

a; EmployeeDataView \':J

 LastName : string({10]
¥ ArstName : string(10) ¥ pathAndExt : string
£ MiddleMame : stringl10]

A Empld : stringil0]
| Department : string(10]

) ™ AnnualSalary : stringl10)
* £ Title - string(10) S
% ™ HomePhone : string(10] 4 filePath : string
A Marid : string(10)
B Street : string(10)
£ City : string(10)
M State : string(10)

M ZipCode : stringi10)

g8 Transformation Diagram | [5] Table Editor

Toor [ e Cursor at (3. &) [] Supports Update B% A a w2 By x

SELECT
A.LastName, A FirstName, A MiddleName, A Empld, A.Department, A.AnnualSalary, A.Title, A.HomePhone,
AMgrid, A.Street, A.City, A.State, A ZipCode
FROM
(EXEC EmployeeSource.getTextFiles('EmployeeData txt')) AS f, TEXTTABLE(ffile COLUMNS LastName string,
FirstName string, MiddleMame string, Empld string, Department string, AnnualSalary string, Title string,
HomePhone string, Mgrid string, Street string, City string, State string, ZipCode string HEADER] AS A

Figure 9.18. Generated Flat File View Table

9.6. IMPORT FROM XML DATA FILE SOURCE

JBoss Data Virtualization supports XML Files as data sources. You can import from these data
sources and create the metamodels required to query your data in minutes. Using the steps below you
will define your flat file data source, configure your parsing parameters for the XML data file, generate a
source model containing the required Teiid procedure and create a view table containing the SQL
defining the column data in your XML data file.

As with Teiid Designer's JDBC, Salesforce and WSDL importers, the XML File importer is based on
utilizing a specific Data Tools Connection Profile.

The results of the importer will include a source model containing the getTextFiles() procedure or
invokeHTTP () procedure which are both supported by JBoss Data Virtualization.

The importer will also create a new view model containing a view table for your selected flat file source
file. Within the view table will be generated SQL transformation containing the getTextFiles()
procedure from your source model as well as the column definitions and parameters required for the
Teiid XMLTABLE () function used to query the data file. You can also choose to update an existing view
model instead of creating a new view model.

The XMLTABLE function uses XQuery to produce tabular output. The XMLTABLE function is implicitly a
nested table and may be correlated to preceding FROM clause entries. XMLTABLE is part of the
SQL/XML 2006 specification.
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I XMLTABLE([<NSP>, ] xquery-expression [<PASSING>] [COLUMNS <COLUMN>, ... )]
AS name

I COLUMN := name (FOR ORDINALITY | (datatype [DEFAULT expression] [PATH
string]))

Teiid Designer will construct the full SQL statement for each view table in the form:

SELECT A.entryDate AS entryDate, A.internalAudit AS internalAudit FROM
(EXEC CCC.getTextFiles('sample.xml')) AS f,

XMLTABLE (XMLNAMESPACES( 'http://www.kaptest.com/schema/1.0/party' AS pty),
'/pty:students/student' PASSING XMLPARSE(DOCUMENT f.file) COLUMNS
entryDate FOR ORDINALITY, internalAudit string PATH '/internalAudit') AS A

To import from your XML data file source follow the steps below.

1. In Model Explorer, click File > Import action £ in the toolbar or select a project, folder or
model in the tree and choose Import...

2. Select the import option Teiid Designer > File Source (XML) >> Source and View
Model and click Next>
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» Import x

Select

N
Choose import source. | ! - EI

Select an import source:

[1:_-.'|:--:- filter text ‘5]

[* = Plug-in Development

[* = Run/Debug

[ = Team

= = Teiid Designer
|1, DOL Ale == Source or View Model
Bg? Designer Text Fle == Source or View Models
|__ﬁi Fle Source (Flat) == Source and View Model
l-_ﬁi Fle Source (XML) >> Source and View Model
[, IDBC Database >> Source Model
:r}i.':- Salesforce >> Source Model
Bg-j WSDL Fle or URL >> Source Model
o P WSOL Fle or URL >> Web Service Model
[S] XML Schemas

[ = XML

@ l < Back “ Next > l [ Cancel ] l Einish

Figure 9.19. Import from XML File Source

3. The next page of the wizard allows selection of the XML Import mode that specifies whether the
XML file is local or remote. The description at the top describes what operations this wizard will
perform. Select either the XML file on local file systemor XML file via remote
URL and click Next>
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Import From XML File Source

XML Impeort File Options

Select the desired XML Import Mode
Description

This wizard automates the construction of the source procedure and view table transformation necessary to query data from your XML file source. The
view table transformation will contain a getTextFiles() (or invokeHTTP()) procedure and utilize the XMLTABLE() function.

The XML structure of your file will be presented to aid in selecting data elements to define your table column data.

Select XML Import Mode

© XML file on local file system

XML file via remote URL

2
(J < Back MNext > Cancel

Figure 9.20. XML Import File Options Page

. Select existing or previous connection profile from the drop-down selector or press New. . .

button to launch the New Connection Profile dialog or Edit. .. to modify/change an
existing connection profile prior to selection.

When creating a New XML Connection Profile, you can either create from XML File URL or
REST Web Services URL . XML File URL option enables conncetions to file or URL based
XML documents. REST Web Services URL option enables connections to any REST-based
web service.

After selecting a Connection Profile, the XML data file from the connection profile will be
displayed in the Available Data Files panel. Select the data file you wish to process. The
data from this file, along with your custom import options, will be used to construct a view table
containing the required SQL transformation for retrieving your data and returning a result set.

Lastly enter the unique source model name in the Source Model Definition section at the
bottom of the page or select an existing source model using the Browse button. Note the Model
Status section which will indicate the validity of the model name, whether the model exists or not
and whether the model already contains the getTextFiles() procedure. In this case, the
source model nor the procedure will be generated.

When finished with this page, click Next>.
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Import From XML File Source

XML Data File Source Selection

Press the "Next =" button to continue. = ,

Data File Source
CustomerList ¥ | |New... |Edit..
XML Data File

Folder Llocation: ...ntsftest/JBoss_Data_Virtualization_Testing/dv6/Teiid_Testing

Data File Name

& customerList.xml

Selected Data File: customerList.xml

Source Model Definition

Location: | CustomerList

Name: CustomerList_Source

Model Status

MEW MODEL: Source model [ CustomerList_Source ] does not exist.
Model with required getTextFiles() procedure will be created on FINISH.

@ < Back Next > Cancel

Figure 9.21. XML Data File Source Selection Page

. The primary purpose of this importer is to help you create a view table containing the
transformation required to query the user defined data file. This page presents a number of
options you can use to customize the Generated SQL Statement, shown in the bottom panel.
The to panel contains an XML tree view of your file contents and actions/buttons you can use to
create column entries displayed in the middle, Column Information panel.

To create columns, select a root XML element and right-click select Set as root path
action. This populates the root path value. Next, select columns in the tree that you wish to
include on your query. You can modify or create custom columns, by using the ADD, DELETE,
UP, DOWN to manage the column info in your SQL.

Note that the Path property value for a column is the selected element's path relative to the
defined root path. If no root path is defined all paths are absolute. Each column entry requires a
datatype and an optional default value. See the Teiid User's Guide for details on the
XMLTABLE () function.

When finished with this page, click Next>.
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XML Data File Import Options

Press the "Next =" button to continue.

XML File customerList.xml
XML File Contents
[® country
[] salesrepemployeenumber
+ [8] customer
+ [&] customer
+ [€] customer
+ & customer
+ [€] customer
+ 18] Frustamar
Generated SQL Statement

SELECT

Column Info

Root Path

Add

Import From XML File Source

Jcustomers

Column Name

E customernumber

B customername

E phone

B salesrepemployeenumber

H creditlimit

For Ordinality
O

Data Type

string
string
string
string

string

Default Value

A.customernumber AS customernumber, A.customername AS customername, A.phone AS phone, A.salesrepemployeenumber AS
salesrepemployeenumber, A.creditlimit AS creditlimit

FROM

@

Figure 9.22. XML File Delimited Columns Options Page

< Back

Next =

Cancel

Path

custome
custome
custome
custome

| custome

. Onthe View Model Definition page, select the target folder location where your new view

model will be created. You can also select an existing model for your new view tables. Note the
Model Status section which will indicate the validity of the model name, whether the model exists
or not. Lastly, enter a unique, valid view table name. Click Finish to generate your models and

finish the wizard.
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Import From XML File Source
View Model Definition

Press the "Finish" button to finish.

Selected Data File: customerList.xml

View Model Definition

Location: CustomerList

Name: customerList_View.xmi
Model Status

NEW MODEL: New view tables will be created in a new view model [ customerList_View.xmi ] on FINISH.

New view table name: customerListView

2 .
C) < Back Cancel Finish

Figure 9.23. View Model Definition Page

9.7. IMPORT FROM SALESFORCE

You can create relational source models from your Salesforce connection using the steps below.

NOTE

Depending the detail provided in the database connection URL information and schema,
Steps 5 through 7 may not be required.

1. In Model Explorer click File > Import action in the toolbar or select a project, folder or model
in the tree and click Import. ..

2. Select the import option Teiid Designer > Salesforce >> Source Model and click
Next>

3. Select existing or previous connection profile from the drop-down selector or click New. . .
button to launch the New Connection Profile dialog or Edit. .. to modify or change an

existing connection profile prior to selection. Note that the Connection Profile selection list will be
populated with only Salesforce connection profiles.
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[ 2 Create Relational Model from SalesForce Data Model x*

SalesForce Credentials

Walidate the SalesForce Connection Profile

-Connection Profile

iBilling Salesforce o ] [New... ] [Edit... l

-Properties

URL: <=default>

User Name: joeBlow@bogus.ortg

Password: [******************

@ < Back " Next = I [ Cancel ] | Enish

Figure 9.24. Select Salesforce Credentials Dialog

4. After selecting a Connection Profile, enter the password (if not provided). Click Next> to display
the Salesforce Objects selection page.
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e Create Relational Model from SalesForce Data Model

£

Select the SalesForce objects to Model

Press the "Mext =" button to continue.

-SalesForce Objects.—, Column Details 1
. Visible Name Mame in Source Type Searchable Updatable (4]
Account Partner Account ID Id id True False
Account Share Deleted IsDeleted boolean True False
Activity History Master Record IC MasterRecordld | reference True False
Additional Directo Account Name | Name string True True
Apex Class Account Type Tvpe picklist True True
Apex Trigger Parent Account || Parentld reference True True
Approval Billing Street BillingStreet textarea True True
Approval Request Billing City BillingCity string True True
Asset Billing State/Prot BillingState string True True
Assignment Rule Billing Zip/Posta BillingPostalCod} string True True
Attachment Billing Country ;| BillingCountry string True True
Business Hours | Shipping Street | ShippingStreet | textarea True True m
9 eneea N B

Select all
Deselect all

@ [ < Back ][ﬂext;.

Cancel l | Bnish

Figure 9.25. Select Salesforce Objects Dialog

5. Onthe Target Model Selection page, specify the target folder location for your generated
model, a unique model name and select desired import options. Click Next> (or Finish if
enabled).
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|'-'.'-= Create Relational Model from SalesForce Data Model =)

Target Model Selection

Press the "MNext =" button to continue or the "Rnish" button to finish.

Select Target Relational Model

Madel Mame: [E!illingSnurceMudel ] [ﬂruwse...]

Location: [Salesfurcelmpur‘tTest ] [ﬂruwse...]

Select Import Options

[] Model audit fields.

Selecting this option will cause the importer to model the 'Audit Felds' for each SalesForce object
(Created By, Created Date, Last Modified By, Last Modified Date, System Madification Timestamp)
[] Do not gather Cardinalities

Selecting this option will stop the importer from calculating and setting the cardinalities metadata
For large salesforce applications this can become a long running operation.

[] Gather Column Distinct Value Count

Selecting this option will cause the importer to calculate and set the distinct value count metadatz
This will scan the data in each field individually and can be a very long running operation.

[[] Set name to SalesForce label.

Selecting this option will cause the importer to set the name metadata ...in the generated model 1
By default the importer uses the internal data name because SalesForce labels are often inwvalid f
[] Create a procedure for the GetUpdated operation.

Selecting this option will cause the importer to create a procedure for the getUpdated operation ir
[] Create a procedure for the GetDeleted operation.

Selecting this option will cause the importer to create a procedure for the getDeleted operation in

[>)

@ MNext = Cancel ] [ FBnish ]

Figure 9.26. Target Model Selection Dialog

6. If you are updating an existing relational model, the next page will be Review Model Updates
page. Any differences. Click Finish to create your models and tables.
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[l Create Relational Model from SalesForce Data Model

Review Model Updates

Review the changes that will be applied to wour model to bring it up to date with the source metadata.
Uncheck any changes vou do not wish to apphy

Onby In Old Model {oLo): E] Changes (a]: @ Onky In Mew Madel (HEw):
LTy

= file:/TestSF1314365845645 temp. xmi

g salesforce

Selection Details

salesforce - this selection is an Addition

® [ < Back il Next = | [ Cancel ] [ Finish

Figure 9.27. Review Model Updates Dialog

7. When finished, the new or changed relational model's package diagram will be displayed
showing your new tables.

89



User Guide Volume 1: Teiid Designer

&5

#

=) L ZERO_TO_MANY .a

K .z FK_Account_AccountFry A

- ZERO_TO_MANY n
3 FK_Akcount_Accountid ZERO_TO_N -
",_.; FK_Account_Accouny
=
A
P
P

i) Package Dlagram E Table Editor

Figure 9.28. New Saleforce Tables Diagram

9.8. IMPORT METADATA FROM TEXT FILE

9.8.1. Import Metadata From Text File

The Teiid Designer provides various import options for parsing comma delimited text file metadata into
models. This is accomplished via the Import > Teiid Designer > Designer Text File >>
Source or View Models option.

1. In Teiid Designer, Click File > Import action and then clickImport. ..

2. Select the import option Teiid Designer > Designer Text File >> Source or View
Models and click Next>.

3. Select an import type from the drop-down menu shown below.

[ ] Import Metadata From Text File x

(5

| Select Import Type
Select the type of text file import desired.

Ly
v

e f
it
ata
A

L_Hl

lyyl+ T lg it -8R el ational Model (XML Format) i l

Relational Model (XML Farmat)
Purpose: Imp
relational =ou Relational Tables (CSV Format)
Relational Virtual Tables (CSY Format)
Sample Fle Fo patatypes (CSV Format)

|-:re|atiuna|-mude|:- ~
<table name="ProductData" namelnSource="dbo.products. ProductData"

Figure 9.29. Import Wizard
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These steps are required for each type are defined below:
e Relation Model Text Import
e Relational Table Text Import
e Virtual Table Text Import

e Datatype Table Text Import

9.8.2. Import Relational Model (XML Format)

To create relational tables from imported XML text file metadata, perform steps 1 to 3 from the Import
Metadata from Text File section and then perform following steps:

1. Select the Relational Model (XML Format) import type, then click Next >.
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Import Metadata From Text File

sSelect Import Type
Select the type of text file import desired.

Import Twpe: |Relational Model (XML Format) L ]

Purpose: Imports relational tables, views, procedures and indexes from an XML FAle into a
relational source model.

Sample FAle Farmat:

<relational-model=
<table name="ProductData" namelnSource="dbo.products. ProductData"
description="Basic stocks or bond" cardinality="100" materialized="FALSE" suppo
<column name="ProductlD" description="Unigue ID for this product" datatype="varcl
<column name="ProductMame" datatype="warchar" length="60" nullable="NULLABLE
<primary-key name="PK_ProductlD" namelnSource="dbo.products. ProductData.PK_P
<column name="ProductiD"=</columnz
</primary-key>
</ftable=
<table name="ProductSymbols" namelnSource="dbo.products. ProductSymbols" cardin
<column name="ProductlD" description="Unique ID for this product" datatype="varcl
<column name="SymboldType" datatype="numeric" length="10" radix="10" precisio
<foreign-key name="FK_ProductlD" uniquekKeyName="PK_ProductiD" uniqueKeyTableN
<column name="ProductiD"=</calumn:
<fforeign-key=
</ftable=
<procedure name="getProductinfo" namelnSource="dbo.products. getProductinfa" funct
<parameter name="I0" direction="IN" datatype="numeric" length="10" radix="10" p
</parameter>
<parameter name="productinfa" direction="RETURN" datatype="varchar" length="98
</parameter>
<resultset name="InfoResult">
<column name="ProductiD" datatype="wvarchar" length="10" nullable="NO_NULLS
<column name="ProductName" datatype="varchar" length="60" nullable="NULLAE
<column name="ProductType" datatype="varchar" length="15" nullable="NULLABL
<fresultset=
<fprocedure=
<index name="ProductiDIndex" autoupdate="false" nullable="false" unique="trug"=
<column name="ProductlD" tableMame="ProductData" /=
<findex=
<frelational-model=

a | [»)

@ <Back || Nexts ]| Ccancel |

Figure 9.30. Select Import Type - Relational Model (XML Format)

2. On the next page, select the XML file on your local file system via the Browse. . . button. Select
a target model to which the imported relational objects will be added via the second Browse. . .
button. The dialog allows selecting an existing relational model or creating a new model. Note
the contents of your selected XML file will be display in the File Contents viewer. Click Finish.
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|'-".'.: Import Metadata From Text File x|

Select Source Text File and Target Relational Model.

Select Metadata Fle to Import and Destination Model or model folder

Select Source Text Rle [arfReIease_?.E.u’pIanningISampleReIatinnaIKHL.me

Target Location [PruductsFrum)(MLText.xmi ] [ Browse. .. ]

Fle Contents

<7xml version="1.0" encoding="UTF-8"7=> ]
<relational-model name="myRelationalModel" xmlns="http:/fwww. teiid. arg"
xsi:schemalocation="http: {f/www.teiid. org file://fhome/blafond/Documents/Teiid_DesignerfRele
<table name="ProductData" namelnSource="dbo.products. ProductData"
description="Basic stocks or bond data table &#xa; second line Se#xa; G #x9; B #x
cardinality="100"
materialized="true" supportsUpdate="true" system="trug">
<column name="ProductlD" description="Unique ID for this product"
namelnSource="dbo.products. ProductData. ProductiD" datatype="varchar"
length="11" nullable="NO_NULLS"=
<fcolumn=
<column name="ProductMame" namelnSource="dbo. products. ProductData. Produ
datatype="wvarchar" length="60" nullable="NULLABLE">
<fcolumn=
<column name="ProductType" namelnSource="dbo.products. ProductData. Product
datatype="wvarchar" length="15" nullable="NULLABLE">
<fcolumn=

@ Mext = Cancel ] [ Finish ]

Figure 9.31. Select Source Text File and Target Relational Model Page

3. If the target model contains named children (tables, views, procedures) that conflict with the
objects being imported, a dialog will be displayed giving you options on how to proceed
including: replacing specific existing objects, creating new same named objects or cancel import
entirely.
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T

Duplicate Objects Exist x

-Options
(@ Replace Existing Objects (See list below]

() Create New Objects Anyway (results in validation errors)

() Cancel Import

-Duplicate Objects

[ ] getProductinfo

ProductData

[ ] ProductiDindex

ProductSymbols
[ ] Productview

| Select All || Deselect All |

@ | Cancel oK

Figure 9.32. Duplicate Objects Dialog

9.8.3. Import Relational Tables (CSV Format)

To create relational tables from imported text file metadata, perform steps 1 to 3 from the Import
Metadata from Text File section and then perform following steps:

1. Select the Relational Tables (CSV Format) import type, then click Next >.
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Import Metadata From Text File

Select Import Type f.“"?
Select the type of text file import desired. |i,"’ 4

Import Type: [Relational Tables|

Purpose: Imports relational schema, catalogs, tables, columns, and indexes from a CSY text file into a relational model.
1) Schema, Catalog, and Table data is expected to be of the form:
== TYPE (i.e. SCHEMA, CATALOG, or TABLE), Name, "Description” (Optional), Location (Optional)
== Locations are of the form: ProjectName/FolderMame/ModelName/SchemaName.
== If the project. folder, model or schema/catalog containers do not exist, they will be created.
2) The Column data is expected to be in the form:
> COLUMN, ColumnName, |DBCType. Length, "Description”
3) Column data rows for each table must appear immediately following the table data row.
4) The Index data is expected to be of the form:
== |INDEX, IndexMName, Type, Uniqueness, Tablespace, Column
5) Index data rows must appear immediately following the table column data rows.

A sample of typical input data is shown below:

Sample Fle Format:

CATALOG, Catalog_1, "Catalog_l Description”, Project_1/MyModel_1
SCHEMA, Schema_1l. "Schema_l Description”, Project_1/MyModel_1/Catalog_1

Figure 9.33. Select Import Type - Relational Tables (CSV Format)

2. In the next page, you'll need to provide a source text file containing the metadata formatted to
the specifications on the previous page.

Import Metadata From Text File

Select Source Text File and Target Relational Model.
Select CSY Ale to Import and Destination Model or model folder

V|[ Browse. .. ]

Select Source Text Fle |

Target Location [Eustnmerlnfn.xmi ] [ Browse. .. ]

Fle Contents

-Options
Use default datatype: string(255)

.

@ <Back | e~ || cancel ||  Fnish |

Figure 9.34. Select Source Text File and Target Relational Model
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3. Select an existing relational model as the target location for your new relational components
using the Browse. . . button to open the Relational Model Selector dialog. Select a
relational model from your workspace or specify a uniqgue name to create a new model.

4. Select any additional options and click Finish.

9.8.4. Import Relational View Tables (CSV Format)

To create relational virtual tables from imported text file metadata, perform steps 1 to 3 from the Import
Metadata from Text File section and then perform following steps:

1. Select the Relational Virtual Tables (CSV Format) import type, then click Next >.

Import Metadata From Text File

Select Import Type <>

D)
Select the type of text file import desired. rt‘" 4
Import Type: |Relational Virtual Tables | ~ l

Purpose: Imports virtual relational tables and procedures from a CSV text file into a relational virtual model.
Table data is expected to be of the form:
== TableName, "SQL Statement”, Description

& sample of typical input data is shown below:

Sample FAle Format:

WTablel, "SELECT * FROM PModl.PTabl, PModl.PTable2", "Descrip, no embedded quotes”
WTable2, "SELECT # FROM PModl. PTab2", "Descrip 2 with quotes ""“oo"""
WTable3, "SELECT * FROM PModl. PTab3", "Descrip 3"

Figure 9.35. Select Import Type - Relational Virtual Tables (CSV Format)

2. In the next page, you'll need to provide a source text file containing the metadata formatted to
the specifications on the previous page.
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Import Metadata From Text File

Select Source Text File and Target Virtual Relational Model
Select CSY Ale to Import and Destination Model or model folder

Select Source Text Fle | o [ Browse. .. ]

Target Location [ ] [ Browse. .. ]

Fle Contents

@ [ < Back ] Next > Cancel

Figure 9.36. Select Source Text File and Target Virtual Relational Model

3. Select an existing relational virtual model as the target location for your new model components
using the Browse. . . button to open the Virtual Model Selector dialog. Select a virtual
relational model from your workspace or specify a uniqgue name to create a new model.

4. Click Finish.

9.8.5. Import Datatypes (CSV Format)

To create datatypes from imported text file metadata, perform steps 1 to 3 from the Import Metadata
from Text File section and then perform following steps:

1. Select the Datatypes (CSV Format) import type, then click Next >.
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Import Metadata From Text File

Select Import Type 4"&
Select the type of text file import desired. 'réw'
[v]

Import Tvpe: [Datat}rpes

Purpose: Imports datatypes from a CSV text file into a datatype model.
Datatype data is expected to be of the form:
== TYPE or ENUM, Name, "Description”, baseTypeName, Length, MinLength, MaxLength, MinBound, Mininclusive, MaxBound,
MaxInclusive, TotalDigits., FractionDigits.
Blank or zero values are ignored.

& sample of typical input data is shown below:

Sample File Format:
TYPETAG,Mame, Description,BaseType, Length, MinLength, MaxLength, MinBound, MinInclusive, MaxBound, Maxinclusive, TotalDigits, Fraction Digits

TYPE, Atomicl, "Description for Typel", BType, 5.1, 10,1, 2,1, 2, 5, 2
TYPE, Atomic2, "Description for Type2", BType, 5.1, 10,1, 2, 1, 2, 5, 2

Figure 9.37. Select Import Type - Datatypes (CSV Format)

2. In the next page, you'll need to provide a source text file containing the metadata formatted to
the specifications on the previous page.

Import Metadata From Text File

Select Source Text File and Target Datatypes Model.
Select CSY Ale to Import and Destination Model or model folder

V|[ Browse. .. ]

Select Source Text Fle |

Target Location [ ] [ Browse. .. ]

Fle Contents

@ | “<Back | Next> || cancel || Fnisl

Figure 9.38. Select Source Text File and Datatypes Model

3. Select an existing datatype model as the target location for your new model components using
the Browse. . . button to open the Datatypes Model Selector dialog. Select a datatypes
model from your workspace or specify a unique name to create a new model.

4. Select any additional options and click Finish.
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9.9. IMPORT WSDL INTO RELATIONAL MODELS

9.9.1. Import WSDL into Relational Models

You can turn your WSDL file (local or URL) into a queryable relational procedures that represent your
desired request and response web service structure defined through your WSDL's schema definition.
You can access this wizard by clicking Import. .. action and then selecting theTeiid Designer >
WSDL File or URL >> Source and View Model (SOAP) option. Web Services Connection
Profile is defined by a WSDL file in your workspace or defined by a URL. Designer will interpret the
WSDL, locate any associated or dependent XML schema files, generate a physical model to invoke the
service, and generate virtual models containing procedures to build and parse the XML declared as the
service messages.

To create relational models from WSDL use the steps below.

1. In Model Explorer click the File > Import action in the toolbar or select a project, folder or
model in the tree and click Import. ..

2. Select the import option Teiid Designer > WSDL File or URL >> Source and View
Model (SOAP) and click Next>.

3. On the next page select an existing Web Service Connection Profile from the list, or click the
New button to create a new profile.

Create Relational Model from Web Service
Source and WSDL Operations Definition
Press the "Next =" button to continue. C
Connection Profile

Countrylnfo s New... | Edit..

WSDL URL or Location:

http:/fwww.oorsprong.org/websamples.countryinfo/CountrylnfoService wso

End Point
End Point Name  CountrylnfoServiceSoap End Point URI ' http://www.oorsprong.org/websamples.countryinfo/CountrylnfoService. wso
Binding |SOAP11 Service Mode | PAYLOAD w-

Select the desired WSDL Operations

Select All Operation

= LU Y e U
¥ CurrencyName
¥ & FullCountrylnfo
¥ FullCountrylnfoAllCountries
¥ B LanguagelSOCode
¥ LanguageName
¥ ListOfContinentsByCode
W= |istOfC antinantsRullama

Selection Details:

Operation: CountryName '
binding: CountrylnfoServiceSoapBinding
port: CountrylnfoServiceSoap

@ < Back Next > Cancel

Figure 9.39. WSDL Source Selection
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4. Select individual Web Service Operations to model. The default behavior of this page selects all
available operations in the tree. Operations can be deselected if they are not being modeled.
The Selection Details panel displays static information about the operation such as the names of
the input and output messages, and faults thrown by the operation.

Click Next >.

5. The next page entitled Model Definition requires both a model location (i.e. folder or
project) and a valid model name for both source and view models. Use the Browse. . . button
to select existing folders or models. Click Next> when all the information is defined.

Create Relational Model from Web Service

Models Definition (’
AlL inputs OK. Click 'Next>' to define custom procedures. é

Source Model Definition

Location |StockService

Name CountrylnfoService. xmi
Status

Source model CountrylnfoService.xmi does not exist and will be created and contain the required invoke() web service procedure.

View Model Definition

Location |StockService

Name CountrylnfoServiceView.xmi
Status

View model CountrylnfoServiceView.xmi does not exist and will be created and contain your generated procedures.

Procedure Generation Options

© User-specified Procedures (recommended)

Define user-specified request and response procedures from your WSDL schema elements. This option also generates a wrapper procedure allowing you to execute your
request and response.

Default Procedures

Generate default request and response procedures. A new procedure will be generated for each complex type. The wrapper procedure must be manually created with
this option.

2
C) < Back MNext > Cancel

Figure 9.40. WSDL Source Selection

6. This wizard generates both request and response procedures that are used in the queryable
wrapped procedure. The next page, Procedure Definition, provides the means to define
the details of your request and response structures.

In the Request tab, select and double-click the schema elements you wish to be input
parameters for your request. These will be added to the Element Info panel and the resulting
generated SQL statement will be updated to reflect the new element. Note the BODY and
HEADER tabs which exist on both the Request and Response tabs. If the selected service mode
for this procedure is set to MESSAGE, the HEADER tab will be enabled and allow you to define
the SOAP header variables utilizing the same schema tree.
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Select the Response tab and create the response procedures result set columns in the same
way.

Repeat this process for all operations by changing the selection target operation via the
Operations selector at the top.

Create Relational Model from Web Service

Procedure Definition

Press the "Finish" button to finish. §

Operations

FullCountrylnfo

Request | Response = Wrapper Procedure
Generated Procedure Name FullCountrylnfo_request

¢t
BODY | HEADER

Schema Contents Element Info

-I [&] FullCountrylnfo Add

=/ ==* sequence

B sCountrylSOCode

[el sCountrylSOCode

Generated 5QL Statement

CREATE VIRTUAL PROCEDURE
BEGIN
SELECT

XMLELEMENT(NAME FullCountrylnfo, XMLNAMESPACES( http://www.oorsprong.org/websamples.countryinfo’ AS tns),

XMLELEMENT(NAME sCountrylSOCode, CountrylnfoServiceView FullCountrylnfo_request.sCountrylSOCode)) AS xml_out;
END

@

< Back Cancel Finish

Figure 9.41. Procedure Definition Page

7. Click Finish. After generation the new models can be found in the specified location in your
workspace.

In the Model Explorer you can see the importer created the following a single physical model containing

a single procedure called invoke. This model and procedure correspond to the single port declared in the
WSDL.

A single view model was also created containing your new procedures named after the operations

declared in the WSDL. For each operation a wrapper procedure was created which can be previewed in
Teiid Designer.

9.9.2. Circular References in WSDL Schemas

It is possible for a WSDL schema to either contain a very deep set of XML type references or indeed for
such references to be circular. This is legal in the WSDL schema but can make processing the schema
in Teiid Designer difficult. If left unchecked such circular references can result in a JVM
StackOverFlow exception and exiting of the application.
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To mitigate this possibility a depth limit of 750 references has been introduced. Should the depth exceed
this limit then a warning is displayed and further processing of that fragment of the schema will end. It
may be the case that the reference in question is not circular but just very deep so in such a case it is
possible to increase the depth limit by setting the JVM property
WsdlSchemaHandlerRecursiveDepth to a larger value, for example, -D
WsdlSchemaHandlerRecursiveDepth=800. This should only be used with caution as on some
systems it is possible the JVM throws a StackOverFlow exception before the new depth limit is
reached.

K Warning X

Nt B ¥
L S

more of the selected operations which may adversely affect the generated
transformations. If desired, you may use the Default Procedures option
instead.

c Detected possible circular references in the response schema for one or

This warning was triggered at a recursive depth of 750, If you know this was
rot a circular reference, the recursive depth can be increased by setting
the following java property and restarting:

-CWsdlSchemaHandlerRecursiveDepth

Figure 9.42. Warning message displayed if depth limit has been reached

9.10. IMPORT WSDL INTO WEB SERVICE

9.10.1. Import WSDL Into Web Service

You can create a Web Service model by selecting a WSDL file in your workspace, importing WSDL files
from the file system or by defining a URL. The Teiid Designer will interpret the WSDL, locate any
associated or dependent XML Schema files, generate an XML View of the schema components and
create a Web Service model representing the interfaces and operations defined in the WSDL.
There are three options for selecting the WSDL for your Web Service generation:

e Workspace Location

e File System Location

e URL

Detailed steps for each of these options is described below, as well as a description of how the wizard
handles WSDL errors.

9.10.2. Import WSDL from Workspace Location

You can create a Web Service model by selecting a WSDL file from your workspace.
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1. Click the File > Import action £ in the toolbar or select a project, folder or model in the
tree and click Import. ..

2. Select the import option Teiid Designer > WSDL File or URL >> Web Service
Model option shown below and click Next>.

3. Enter a valid name for your Web Service model and click the Workspace. . . button. Locate
your workspace WSDL file in the selection dialog and click OK>. Click Next> to continue.

L Create Web Service from WSDL File
WSDL File Selection .
Press the "MNext =" button to continue.

Web Service Model Name |onHandws

Workspace. .. | |_FI|E System. .. | |QRL... |

WSDL Fles

lder/Test In JBDS/|IBDS H45/workspace/WSDLImportProject/OnHand. wsdl

® | < Back |I Next = Cancel | | Enish

Figure 9.43. WSDL File Selection Dialog
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WSDL File Selection

Choose a WSDL file to add:

< [=% WSDLImportProject

&7 0OnHand. wsdl

® Cancel oK

Figure 9.44. WSDL File Workspace Selection Dialog

NOTE

o If no WSDL is selected or specified then the importer will only create an
empty Web Service model. No XML Schema or XML View models will be
generated.

o Any referenced files (WSDLs or schemas) must either be embedded in the
WSDL file or exist on your file system.

4. The next page is titled Namespace Resolution. This page identifies successful and errant
WSDL namespace resolution. The main WSDL document will essentially always be resolved,
since the workspace file chooser is used to obtain the path. Problems will occur when the main
WSDL file imports other WSDL files that cannot be resolved. If no errors, click Next to proceed,
or Finish (if enabled) to complete with default options.
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Create Web Service from WSDL File

Mamespace Resolution .
All namespaces are resolved. Select "Next" to modify the created schemas workspace
locations.
Mamespaces ‘=
-'fb Mamespace Path
http:/fdladb07/ fhomejblafond/Test Designer Folderfexample files/wsdls/OnHand. wsdl
® <= Back " MNext = I [ Cancel ] | Fnish

Figure 9.45. Namespace Resolution Dialog
5. The next page WSDL Operations Selection allows customizing the resulting content of

your Web Service model by selecting/deselecting various operations and interfaces in the
following dialog.
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Create Relational Model from Web Service

WSDL Operations Selection
Press the "Fnish" button to finish.

-Select the desired WSDL Operations
= ;5 Share_BSM _Real Time_Data_Design_Server_RealTimeData_portService Select All
- = Share_BSM_Real_Time_Data_Design_Server_RealTimeData_portPort0
- [] share_BSM_Real_Time_Data_Design_Server RealTimeData_portBinding

Deselect All

* OnHand

Selection Details:

OnHand [Operation]

id: {http://dladb07/}Share_BSM_Real Time_Data_Design_Server_RealTimeData_p

input message: _OnHandinput

output message: OnHandQutput

fault names: none

D)
® [ < Back “ Next | [ Cancel ] I Finish I

Figure 9.46. Namespace Resolution Dialog

6. The next page is titled Schema Workspace Location Selection. This page lists all
schemas imported by the WSDL (along with any dependent schemas referenced within
schemas) as well as schemas embedded in the WSDL and indicates whether or not they are
resolvable. All resolved schemas will be created in a separate file and added to the workspace.
The editor panel allows you to change the default file name of the new schema file(s).

If no errors, click Next to proceed, or Finish to complete with default option.
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Create Web Service from WSDL File

Schema Workspace Location Selection .

All workspace schema locations are wvalid. Click "Next" to continue.

Schema Location Information I

Source Fle

2 Namespace

B

@' Editor - http:/flocalhost/Share_BSM_Real_Time_Data/Design_Server/RealTimeData_port/OnHand X

| Folder: [MSDLImpor‘tPro]ect ¢ ] E]

[ ] Name (without file extension): [OnHand l

@ [ < Back ][ Next > H Cancel “ Finish |

Figure 9.47. Namespace Resolution Dialog

7. The last page titled XML Model Generation allows you to change the name of the XML View
model if the Generate virtual XML document model is checked. Enter desired name or use the
default name provide. Click Finish to complete.
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Create Web Service from WSDL File

HML Model Generation .

Ready to generate the Web service model

Generate virtual XML document model

Location: [MSDLImpur‘tF’ruject v ] [:]

XML Model: [UnHandWSRespunses ]

@ ‘ < Back ’I Next = | [ Cancel ] [ Enish

Figure 9.48. Namespace Resolution Dialog

In order to successfully generate Web Services from WSDL, the WSDL must be error free. WSDL
validation is performed during Step 3 above. If errors do exist, a error summary dialog will be displayed
(shown below) and you will not be able to finish the wizard until the WSDL problems are fixed or you re-

import and select a valid WSDL file.

Create Web Service from WSDL File

Validation Problems .

ﬂ One or more selected WSDL files have errors. Please correct or remove the fileisito proceed.

WsDL Validation Panel

wszd| file

& message
http:ffterraservice. netfterraservice2. asmx?wsd|

cve-elt.1: Cannot find the declaration of element 'wsdl: definitions".

R

| D]

@ [ < Back “ Next = | [ Cancel l [ Fnish

Figure 9.49. WSDL Validation Problems Dialog

9.10.3. Import WSDL from File System Location

108



CHAPTER 9. IMPORTERS

You can create a Web Service model by selecting a WSDL file from your local file system.

1. Click the File > Import action £ in the toolbar or select a project, folder or model in the
tree and click Import. ..

2. Select the import option Teiid Designer > WSDL File or URL >> Web Service
Model and click Next>.

3. Input a valid name for your Web Service model and click the File System. .. button. Locate
your file system WSDL file in the selection dialog and click 0K>.

Create Web Service from WSDL File

WSDL File Selection
Press the "Mext =" button to continue.

Web Service Model Mame |UnHandW‘5 |

'H_'l.l'nrkspace...] [_Hle S:,rstem...l [QRL...]

WSDL Files ®

fhomefblafond/Test Designer Folderfexample filesfwsdls/OnHand. wsdl

@ < Back Next = Cancel l | Bnish

Figure 9.50. WSDL File Selection Dialog

NOTE

o If no WSDL is selected or specified then the importer will only create an
empty Web Service model. No XML Schema or XML View models will be

generated.

o Any referenced files (WSDLs or schemas) must either be embedded in the
WSDL file or exist on your file system.
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4. The next page is titled Namespace Resolution. This page identifies successful and errant
WSDL namespace resolution. The main WSDL document will essentially always be resolved,
since the workspace file chooser is used to obtain the path. Problems will occur when the main
WSDL file imports other WSDL files that cannot be resolved. If no errors, click Next to proceed,
or Finish (if enabled) to complete with default options.

Create Web Service from WSDL File

Mamespace Resolution
All namespaces are resolved. Select "Next" to modify the created schemas workspace
locations.
Mamespaces ‘=
-'fb Mamespace Path
http:/fdladb07/ fhomejblafond/Test Designer Folderfexample files/wsdls/OnHand. wsdl
® <= Back " MNext = ] [ Cancel ] | Fnish

Figure 9.51. Namespace Resolution Dialog
5. The next page WSDL Operations Selection allows customizing the resulting content of

your Web Service model by selecting/deselecting various operations and interfaces in the
following dialog.
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Create Relational Model from Web Service

WSDL Operations Selection
Press the "Fnish" button to finish.

-Select the desired WSDL Operations
= ;5 Share_BSM _Real Time_Data_Design_Server_RealTimeData_portService Select All
- = Share_BSM_Real_Time_Data_Design_Server_RealTimeData_portPort0
- [] share_BSM_Real_Time_Data_Design_Server RealTimeData_portBinding

Deselect All

* OnHand

Selection Details:

OnHand [Operation]

id: {http://dladb07/}Share_BSM_Real Time_Data_Design_Server_RealTimeData_p

input message: _OnHandinput

output message: OnHandQutput

fault names: none

D)
® [ < Back “ Next | [ Cancel ] I Finish I

Figure 9.52. Namespace Resolution Dialog

6. The next page is titled Schema Workspace Location Selection. This page lists all
schemas imported by the WSDL (along with any dependent schemas referenced within
schemas) as well as schemas embedded in the WSDL and indicates whether or not they are
resolvable. All resolved schemas will be created in a separate file and added to the workspace.
The editor panel allows you to change the default file name of the new schema file(s).

If no errors, click Next to proceed, or Finish to complete with default option.
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Create Web Service from WSDL File

Schema Workspace Location Selection .

All workspace schema locations are wvalid. Click "Next" to continue.

Schema Location Information I

Source Fle

2 Namespace

B

@' Editor - http:/flocalhost/Share_BSM_Real_Time_Data/Design_Server/RealTimeData_port/OnHand X

| Folder: [MSDLImpor‘tPro]ect ¢ ] E]

[ ] Name (without file extension): [OnHand l

@ [ < Back ][ Next > H Cancel “ Finish |

Figure 9.53. Namespace Resolution Dialog

7. The last page titled XML Model Generation allows you to change the name of the XML View
model if the Generate virtual XML document model is selected. Enter the desired name or use
the default name provided. Click Finish to complete.
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Create Web Service from WSDL File

HML Model Generation .

Ready to generate the Web service model

Generate virtual XML document model

Location: [MSDLImpur‘tF’ruject v ] [:]

XML Model: [UnHandWSRespunses ]

@ ‘ < Back ’I Next = | [ Cancel ] [ Enish

Figure 9.54. Namespace Resolution Dialog

In order to successfully generate Web Services from WSDL, the WSDL must be error free. WSDL
validation is performed during Step 3 above. If errors do exist, a error summary dialog will be displayed
(shown below) and you will not be able to finish the wizard until the WSDL problems are fixed or you re-

import and select a valid WSDL file.

Create Web Service from WSDL File

Validation Problems .

ﬂ One or more selected WSDL files have errors. Please correct or remove the fileisito proceed.

WsDL Validation Panel

wszd| file

http:ffterraservice. netfterraservice2. asmx?wsd|

& message
cve-elt.1: Cannot find the declaration of element 'wsdl: definitions".

R

| D]

“ Vendoh | [ Cancel l [ Fnish

Figure 9.55. WSDL Validation Problems Dialog

9.10.4. Import WSDL from URL
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You can create a Web Service model by selecting a WSDL file based on a URL.

1. Click the File > Import action £ in the toolbar or select a project, folder or model in the
tree and click Import. ..

2. Click the import option Teiid Designer > WSDL File or URL >> Web Service Model
and click Next>.

3. Input a valid name for your Web Service model and click the URL. . . button.

a. Enter a valid WSDL URL. If the URL cannot be validated then an error will be displayed and
the OK> button will be disabled.

b. If the WSDL is protected by basic HTTP authentication then this option should be selected
and the appropriate username and password entered.

c. Click OK> to continue.

Click Next> to continue.

WSDL URL

Enter WSDL Url: [http:ﬂterrasenrice.netrterrasewicez.asmx?wsdl ]

Security Type HTTPBasic | |

Lisar Mame User

Password 2000

Cancel | [ oK ]

Figure 9.56. WSDL URL Dialog

NOTE

o If no WSDL is selected or specified then the importer will only create an
empty Web Service model. No XML Schema or XML View models will be
generated.

o Any referenced files (WSDLs or schemas) must either be embedded in the
WSDL file or exist on your file system.

4. The next page is titled Namespace Resolution. This page identifies successful and errant
WSDL namespace resolution. The main WSDL document will essentially always be resolved,
since the workspace file chooser is used to obtain the path. Problems will occur when the main
WSDL file imports other WSDL files that cannot be resolved. If no errors, click Next to proceed,
or Finish (if enabled) to complete with default options.
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Create Web Service from WSDL File

WSDL File Selection

Press the "MNext =" button to continue.

Web Service Model Name [TerrﬂSEr'ui[EwS ]

Workspace. .. | |_FI|E System. .. | |QRL... |

WSDL Fles

http:/fterraservice. netfterraservice2. asmx?wsdl

® | < Back Next = Cancel | | Enish

Figure 9.57. Namespace Resolution Dialog

5. The next page WSDL Operations Selection allows customizing the resulting content of
your Web Service model by selecting/deselecting various operations and interfaces in the
following dialog.
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Create Web Service from WSDL File

Mamespace Resolution

All namespaces are resolved. Select "Mext" to modify the created schemas
workspace locations.

Namespaces

-—'fb Mamespace Path

: http:/fterraservice-usa.com/; http:/fterraservice.net/terraservice2. asmx?wsd|

@ < Back ][ﬂext:- """""" Cancel l | Enish

Figure 9.58. Namespace Resolution Dialog

6. The next page is titled Schema Workspace Location Selection. This page lists all
schemas imported by the WSDL (along with any dependent schemas referenced within
schemas) as well as schemas embedded in the WSDL and indicates whether or not they are
resolvable. All resolved schemas will be created in a separate file and added to the workspace.
The editor panel allows you to change the default file name of the new schema file(s).

If no errors, click Next to proceed, or Finish to complete with default option.
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WSDL Operations Selection

Press the "Mext =" button to continue or the "RAnish" button to finish.

-Select the desired WSDL Operations

- = TerraServiceSoap
#8 ConvertLonLatPtToMearestPlace
# ConvertLonLatPtToUtmPt
@ ConvertUtmPtToLonLatPt
# ConvertPlaceTolLonlLatPt
# CountPlacesinRect
@ GetAreaFromPt
# GetAreaFromRect
# GetAreaFromTileld
@ GetlLatLonMetrics
# GetPlaceFacts
% GetPlacelist
+ GetPlaceListinRect
# GetTheme
@ GetTileMetaFromLonLatPt
# GetTileMetaFromTileld

% GetTile

= [] i Definitions: file:/tmp/terraservice23962930517375020849 wadl

Select All

Deselect All

® = Back ][ MNext = l [ Cancel

Bnish

Figure 9.59. Namespace Resolution Dialog

7. The last page titled XML Model Generation allows you to change the name of the XML View

model if the Generate virtual XML document model is checked. Enter desired name or use the

default name provide. Click Finish to complete.
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Create Web Service from WSDL File

Schema Workspace Location Selection .

All workspace schema locations are walid. Click "Next" to continue.

Schema Location Information

-'fb Namespace Source Ale Target Path

~ http:/fterraservice-usa.com/ /tmp/terraservice2 WSDLImportProject/terraservice23962930517375020849.xsd

@ Editor - http:/fterraservice-usa.com/ *
[ | Folder: [M‘SDLImportProject < l E]
| Name (without file extension): [terraservice23962930517375020849 |

@ [ < Back ][ Next = H cancel ]| Finish |

Figure 9.60. Namespace Resolution Dialog

In order to successfully generate Web Services from WSDL, the WSDL must be error free. WSDL
validation is performed during Step 3 above. If errors do exist, a error summary dialog will be displayed
(shown below) and you will not be able to finish the wizard until the WSDL problems are fixed or you re-
import and select a valid WSDL file.
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Create Web Service from WSDL File

Validation Problems .
ﬂ One or more selected WSDL files have errors. Please correct or remove the fileisito proceed.
WSDL Validation Panel
& message wsdl file

"X gve-elt.1: Cannot find the declaration of element 'wsdl:definitions'.  http:/fterraservice. netfterraservice2. asmx?wsd|

@ [ < Back “ Next = | [ Cancel l [ Fnish

Figure 9.61. WSDL Validation Problems Dialog

9.11. IMPORT DATA FROM REST SERVICES

Procedure 9.2. Import Data from REST Services

1. Go into the Model Explorer.

2. Choose the File - Import action from the toolbar.

NOTE

Alternatively, you can select a project, folder or model from the tree and choose
Import...

3. Select the import option Teiid Designer - File Source (XML) - Source and View Model and
click Next.

4. Select XML file via remote URL and click Next.
5. Select an existing or previous connection profile from the drop-down selector.

Alternatively, press the New. . . button to launch the New Connection Profile dialog or
Edit. .. to modify or change an existing connection profile prior to selection.

6. If you are creating a new connection profile, choose the REST Web Services URL option
when prompted and then click the OK button.

7. Name your new REST Connection Profile and click Next.

8. Set your REST URL in the Connection URL text field and your Security Type and credentials,
if applicable. Click Next to see a summary of your properties or click Finish to end.
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10.

11.

12.

13.

14.

15.

There is also an option to add Request Header parameters. The importer assumes an Accept
header value of application/xml and a Content-Type header value of application/xml. These
defaults can be overriden in the Optional Request Header Properties section. You can also add
any other header properties required for the service. Click the Test Connection button to
validate your connection properties.

. After selecting or creating a new Connection Profile, the REST XML result from the connection

profile will be displayed in the Available Data Files panel. Check the data file you wish to
process.

The data from this web service, along with your custom import options, will be used to construct
a view table with the required SQL transformation for querying your data and returning a result
set.

Enter a unique source model name in the Source Model Definition section at the bottom
of the page.

Alternatively, you can select an existing source model using the Browse button.

NOTE

The Model Status section which will indicate the validity of the model name,
whether the model exists or not and whether the model already contains the
getTextFiles() procedure. In this case, the source model nor the table will be
generated.

Click Next.

The primary purpose of this importer is to help you create a view procedure containing the
transformations required to query the user-defined data file. The panel contains an XML tree
view of your result contents and actions/buttons you can use to create column entries displayed
in the middle, Column Information panel.

The root path is used for xpath parsing of the result document. The importer sets a root path for
you. You can change the root path, if needed, by selecting an XML element and right-click select
Set as root path action.

Next, select columns in the tree that you wish to include on your query and select Add button.
You can also modify or create custom columns, by using the ADD, DELETE, UP, DOWN to
manage the column info in your SQL.

Click Next.

On the view Model Definition page, select the target directory location. This is where your
new view model will be created. (You can also select an existing model for your new view
tables.)

NOTE

The Model Status section which will indicate the validity of the model name,
whether the model exists or not.

Enter a unique, valid view table name.
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16. Click Finish to generate your models and finish the wizard.

9.12. LIGHTWEIGHT DIRECTORY ACCESS PROTOCOL (LDAP)

Lightweight Directory Access Protocol (LDAP) is a protocol for accessing distributed directory information
over over TCP/IP. A directory contains a collection of related data, organized hierarchically in a tree
format. Each node in the tree is a directory entry, and each entry consists of a set of attribute-value pairs.
Each directory entry has a unique identifier, known as its Distinguished Name (DN). The DN consists of

a Relative Distinguished Name (RDN), constructed from an attribute from the entry itself, followed by the
parent entry’s DN.

9.13. LDAP IN TEIID DESIGNER
In Teiid Designer, an LDAP Server can be modeled in this way:

e LDAP subtrees are represented as if they were tables in a relational database.

e Each node in the subtree is represented as a row in the table.

e Each attribute of the given node can be represented as a column in the table.

e The RDN (or DN) can be used to represent a primary key.
The LDAP metadata is modeled using the relational metamodel. Each table in the relational model
represents a directory entry while each row in the table represents a child entry of the directory entry.
Each column of the table represents an attribute of the child entry that may exist. In general, each table
and column defines the LDAP-specific information in the property “Name In Source”. This allows the
connector to identify the attribute or Base DN name within the data source, ie. within LDAP. The actual

name of the table and column can differ from the name in source, allowing for more descriptive labeling
in models and queries.

9.14. CREATE A RELATIONAL SOURCE MODEL FROM LDAP DATA

Procedure 9.3. Create a Relational Source Model from LDAP Data

1. Go into the Model Explorer.
2. Choose the File - Import action in the toolbar.
Alternatively, you can select a project, folder or model in the Tree and choose Import. ..

3. Select the import option by clicking Teiid Designer - LDAP Service - Source Model and then
click Next.

4. Select an existing or previous LDAP connection profile from the drop-down selector.

Alternatively, click the New. . . button to launch the New Connection Profile dialog or
Edit. .. to modify or change an existing connection profile prior to selection.
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7.

8.

NOTE

You must supply the following information when you create a new connection:

o A connection Username and password - this is an administrator account to
browse the Idap tree, eg. cn=Manager,dc=birds-of-prey,dc=org

o A connection URL, for example Idap://falcon:389
o Principal Distinguished Name (DN) Suffix - this is the root DN of the Idap tree

o An LDAP Connection Factory implementation class, for example
com.sun.jndi.ldap.LdapCtxFactory

When you select the connection profile, it automatically populates the LDAP Service URL and
DN Suffix fields. The remaining requirements for the wizard page is the choosing of a suitable
model file as the destination of the imported tables. If the selection is an existing model then the
wizard will merge the new tables with the model's current content.

. After selecting a Connection Profile, click Next.

. Onthe Select LDAP Entries to be modeled as tables page, select the LDAP

entries from the tree to be created as tables in the source model. (Select entries by ticking their
respective checkboxes in the tree.)

If you highlight an entry, the following information about it is displayed:
o Table Name - this is the table's label and can be modified to a more readable value

o Table Source Name - the fully qualified entry name. This is not editable in the wizard and
should remain unchanged in the subsequently created source model

o Table Source Name Suffix - an additional suffix can be added that further limits the scope of
the table's search criteria. The suffix is in the format of ?search_scope?objectClass_name
where search_scope is one of OBJECT_SCOPE (first and only one entry returned),
ONELEVEL_SCOPE (only entries directly below the selected entry are returned) or
SUBTREE_SCOPE (recursively return all entries below the selected entry) and
objectClass_name is the name of a specific type of objectClass in the LDAP tree, eg. return
only the 'inetOrgPerson’ entries. Both criteria are optional (but the '?'s are not) so it is
possible to have a suffix such as ? ? inetOrgPerson.

Click Next.

The Select the LDAP Attributes to be modeled as columns page displays the
previously selected LDAP entries and the attributes of their child entries. The purpose of a
selected attribute is to be created as a column in the relevant source model table. Select
attributes by ticking their respective checkboxes in the tree.

If you highlight an entry, the following information about it is displayed:

o Column Name - this is the column's label and can be modified to a more readable value

o Column Source Name - the real LDAP attribute name. This is not editable in the wizard and
should remain unchanged in the subsequently created source model

o Column Distinct Value Count - The number of distinct values assigned to the specific
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attribute in the LDAP service. This value is useful in optimising queries using the source
model. This is not editable in the wizard and should remain unchanged in the subsequently
created source model.

o Column Null Value Count - The number of entries where the specific attribute has no value
assigned in the LDAP service. This value is useful in optimising queries using the source
model. This is not editable in the wizard and should remain unchanged in the subsequently
created source model.

o Column Length - The maximum length of existing values assigned to the attribute in the
LDAP service. This value is assigned as the maximum length of the column. This is not
editable in the wizard but can be edited in the source model later should this be required.

9. Click Finish.

9.15. LDAP CONNECTOR UPDATE CAPABILITIES

The LDAP connector also provides an update capability. However, additional modeling requirements are
imposed beyond those required for read-only access. Here is a list of these additional requirements:

e Supports Update table property - to enable updates, each source model table must have this
property set to 'true’;

e Updateable column property - to enable updates, each column in the source model table must
have this property set to 'true’;

e You also need these additional columns:

o DN - for all update types (INSERT, UPDATE, and DELETE), the distinguished name must
be modeled as a column, setting the name in source to dn. For UPDATE and DELETE
capability, the DN must be specified in the criteria clause while for INSERT, the DN must be
one of the column values to be set.

o objectClass - for INSERT, the objectclass must be modelled as a column, setting the name
in source to objectClass. It must also be one of the column values to be set.

o additional - each entry defined in the LDAP directory’s schema may also have one or more
additional required columns. This is dependent on the LDAP server implementatation so
consult the LDAP documentation accordingly.

Here are some sample queries:

I SELECT * FROM LdapModel.People

INSERT INTO LdapModel.People (dn, sn,

objectclass, Name) VALUES

('cn=JoeYoung, ou=people, dc=example,dc=org', 'Young', 'person’,
'Joe Young')

PhoneNumber="(314) 299-2999' WHERE
DN="'cn=JoeYoung, ou=people, dc=example,dc=org'

DELETE FROM LdapModel.People WHERE

| UPDATE LdapModel.People SET
I DN="'cn=JoeYoung, ou=people, dc=example,dc=org'
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9.16. XSD SCHEMA FILE

You can import XML Schema file (XSD) files using the steps below.

1. In Model Explorer, click the File > Import action £ in the toolbar or select a project, folder
or model in the tree and choose Import...

2. Select the import option Metadata Modeling > XSD Schemas and click Next>.

3. Select either Import XSD Schemas from file systemor Import XSD Schemas via
URL and click Next >.

4. a. If importing from file system, the Import XSD Files dialog is displayed. Click the Browse
button to find the directory that contains the XSD file(s) you wish to import.

m To select all of the XSD files in the directory, click the checkbox next to the folder in the
left panel.

m To select individual XSD files, click the check boxes next to the files you want in the
right panel.
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Import XML Schema Files

File system

Import resources from the local file system.

From directory: |np/testdatafjohndoeftest-datafschemas/bookls | H Browse. .. l

[] [%] BookDatatypes.xsd
Fi Books.xsd

[[] [%] Booksinput.xsd

Flter Twpes... H Select All H Deselect All l

Into falder: [E!unksPrnject ] [ Browse. ..

-Options

[] Owerwrite existing resources without warning

() Create complete folder structure

(@ Create selected folders only

Add Dependent Schema Fles

@ < Back “ Next = | [ Cancel Enish

Figure 9.62. Select XSD From File System

b. If importing from URL, select the Import XML Schemas via URL option and click OK to
display the final Add XML Schema URLs wizard page.
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Import XML Schema Files

Add XML Schemas URLs

XML schema URLs ™1
Into folder: [E!nuksFrnject l [Elrnwse...]
Options

[ ] Owerwrite existing resources without warning

Add Dependent Schema Fles

@ l Next = l | Cancel | l Enish

Figure 9.63. Add XML Schema URLs Dialog

o
5. Click the Add XML Schema URL button . Enter a valid schema URL. Click OK. Schema
will be validated and resulting entry added to the list of XML Schema URLs.
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KML Schema Url

Enter XML schema URL: |http://ns.hrxml.org/2_4/HR-XML-2_4/StandAlone/Resume.xsd |

-Optional

User Name [ ]

Password [ ]

Verify Hostname (HTTPS)

Cancel l I o] 4 I

Figure 9.64. Add XSD Schema URLs

The schema URL is now displayed in the XML Schema URLSs list.
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Import XML Schema Files

Add XML Schemas URLs

XML schema URLs T X

http:/fns.hr=xml.org/2_4/HRXML-2_4/StandAlone/Resume. xsd

Into folder: [EluuksF’ruject ]

Options

[ | Owerwrite existing resources without warning

Add Dependent Schema Fles

@ | < Back ” Next = | | Cancel | | Bnish

Figure 9.65. Add XSD Schema URLs

6. Click Finish.

NOTE

XSD files may have dependent files. This importer will determine these
dependencies and import these as well if Add Dependent Schema Files is
selected.
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CHAPTER 10. CREATING AND EDITING MODEL OBJECTS

10.1. CREATING NEW MODEL OBJECTS

10.1.1. Creating New Model Objects

This section summarizes Teiid Designer features for creating and editing existing model objects
contained in your models. Teiid Designer provides a framework to model various types of metadata.
Each metamodel type has a set of parent-child relationships that establish constraints on what can be
created and where. You cannot, for example, create a column attribute in a stored procedure, nor can
you create a mapping class column in a Web service operation's output message.

The Teiid Designer provides a common set of actions to create new children of these models as well as
children of children.

You can create new model objects directly in the Model Explorer view, Diagram Editor or Table Editor
using the following actions:

e New Child Action
e New Sibling Action

o New Association Action

10.1.2. New Child Action

To create new child model objects in the Model explorer view:

1. Select the parent object to which you want to add a child. For example, you can add a package
to a package or an attribute to a class.

2. Right-click on a container object. From the pop-up menu, click New Child. You can now select
the child object you would like to add.

= :L::}TwnSuurceParts
— [lg PartsDB2. xmi
[»

‘= import declarations (2)
%= Package Diagram

P H
Mew Siblin >

b E STATUS a ; & column

b & SUPPLIER New Association El Foreign Key
Maodeling >

[* & SUPPLIER_

> [, Data Sour Bl uUnigue Constraint

[» Cg PartsSQLxm

Figure 10.1. New Child Action In Model Explorer

3. The new model object displays on the Model Explorer view and is highlighted for renaming.
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= [ TwoSourceParts
~ 5@ PartsDB2.xmi
[ ‘= import declarations (2)
2 Package Diagram
- B ParTS
£\ PART ID : string(4)
E PART MAME : stringi255)
B PART COLOR : string(30)
B PART WEIGHT : stringi255)
% [encoumn
Fl PK_PARTS
[ B SHIP_vIA
b B sTATUS

Figure 10.2. New Model Object In Explorer
To create new child model objects in the diagram editor:

1. Select the parent object to which you want to add a child. For example, you can add a package
to a package or an attribute to a class.

2. Right-click on a container object. From the pop-up menu, click New Child. You can now select
the child object you would like to add.

L LY SHIFFER_ID : ﬁg'b':_"‘d Mew Association >
Iy SHIPPER | : ol Modeling >

Fl Foreign Key
P Prim any Kge

] PK_SHIP VIA o
- - < Undo Create NewColumn Ml Unique Constraint

Figure 10.3. New Child Action In Diagram

3. The new model object displays on the diagram and is highlighted for renaming.
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4 SHIPPER_ID : bigdecimal
* 1y SHIPPER NAME : string(30) *

NewCqumn

P] PK_SHIP_VIA

Figure 10.4. New Model Object In Diagram
To create new child model objects in the table editor:

1. Select the row for the parent object to which you want to add a child. For example to add a
column, click the Base Table tab and select base table row.

2. Right-click on a table row. From the pop-up menu, click New Child. You can now select the
child object you would like to add.

% PartsViews.xmi

E Base Tables

A Columns I Fl Foreign Keys | P| Primary Keys |

Location MName MName In Source System Cardinality Supports Uj

F—

Mew Child | Al Access Pattern

. SHIP_VIA ——— >

s ew Siblin

e MNew Association > Fl Foreign Key
: Modeling >

1 Pr man K:‘f_

| SUPPLIER_

<) Undo Delete multiple objects Ml Unique Constraint

Figure 10.5. New Child Action In Table Editor

3. The selected tab in the Table Editor changes to the tab for the child object type, the new model
object row is displayed and the row's name table cell is highlighted for renaming.

10.1.3. New Sibling Action

To create new sibling model objects in the Model Explorer view:

1. Select the object to which you want to add a sibling. For example, you can add a column sibling
to a column.

2. Right-click on that object. From the pop-up menu, click New Sibling. You can now select the
sibling object you would like to add.
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= [E PARTS

PART
B paART
Y PART
Fl PK_PA

wm e L L]

'EI

Mew Child
Mew Sibling

Mew Association >

E sHIPP

~ B SHIP_VIA| < Undo Delete multiple objects

Pl

Modeling > Fl Foreign Key

Prirm EII'- I{‘_:-

Unique Constraint

B sHIPP

Figure 10.6. New Sibling Action In Model Explorer

3. The new model object displays in the Model Explorer view and is highlighted for renaming.

To create new sibling model objects in the diagram editor:

1. Select the object to which you want to add a sibling. For example, you can add a column sibling

to a column.

2. Right-click on that object. From the pop-up menu, click New Sibling. You can now select the
sibling object you would like to add.

CI
Mew Child

Mew Sibling

F] PK_SHIP_VIA

MNew Association

Modeling

<) Undo Delete multiple objects

Al Access Pattern

Fl Foreign Key

Prirm EII'- I{'\_:-

P
Bl unique Constraint

Figure 10.7. New Sibling Action In Diagram

3. The new model object displays on the diagram and is highlighted for renaming.

To create new sibling model objects in the Table Editor section:

1. Select the row for the object to which you want to add a sibling. For example, you can add a
column sibling to a column.

2. Right-click on a row. From the pop-up menu, click New Sibling. You can now select the
sibling object you would like to add.
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0@ PartsSourceA.xmi [ﬁ PartsSourceB.xmi £ ‘

E Base Tables Columns | FlForeign Keys | ®l Primary Keys

Location MName NamelIn £ System Cardinalil Supports Materializ Logical R Materializ

PartsSourc

PARTS

MNew Child >
PartsSourc ;

MNew Sibling
PartsSourc

MNew Association > Procedure...
PartsSourc SUPP

Maodeling > View..
PartsSourc SUPP

Index...
Cut Ctri+x
Copy Ctri+C Custom Diagram

Figure 10.8. New Sibling Action In Table Editor

3. The selected tab in the Table Editor changes to the tab for the child object type, the new model
object row is displayed and the row's name table cell is highlighted for renaming.

10.1.4. New Association Action
To create new associations between model objects in the Model Explorer view:
1. Select two objects you wish to associate. For example, select columns in different base tables.

2. Right-click. From the pop-up menu, click New Association > Foreign Key

Relationship.
v 13 Mosourceparts B —
w [i§ PartsDB2.xmi 1 SHIPPER_ID : bigdecimal

b “= import declarations (2) ) 1 SHIPPER_MNAME : string(30)

s Package Diagram =

F| PE_SHIP_VIA
> E PARTS B PK_SHIP.
= E SHIP via
A SHIPPER_ID : bigdeciri New Child 3

E SHIPPER_NAME : string
Fl PK_SHIP_VIA

~ [E STATUS

A STATUS_ID : bigdecimi
B STATUS_NAME : string <f'd_'5' Undo Delete multiple objects
[Pl PK_STATUS Redo

[» & SUPPLIER

> & =11PPIIFR PARTS

New Sibling ¥

> Foreign Key Relationship
Modeling > =, Relationship

New Association

o Cut Ctrl+X
Figure 10.9. New Association Action In Model Explorer

3. The new relationship link is displayed in the diagram.
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4 SHIPPER_ID : bigdecimal L
Ty
L4 SHIPPER_NAME : string(30) | PK_SHIP VIA

OME

F] PK_SHIP_VIA

ZERP To MANY LY STATUS_ID : bigdecimal

————= | STATUS NAME : string(30) [&—
MewForeignkey — PE

IEI HEnFurnignKnyI
P] PE_STATUS

Figure 10.10. New Association In Diagram

To create new associations between model objects in the diagram editor:

[ ] o a.

Select two objects you wish to associate. For example, select columns in different base
tables.

Right-click. From the pop-up menu, click New Association > Foreign Key
Relationship.

The new relationship link is displayed in the diagram. The Column, Foreign Key, Primary
Key reference properties are properly set on the selected columns, new primary key and
new foreign key.

Select a column in table.

Drag the column to another table and drag over a column and drop onto this column.
The target column should highlight in Yellow.

The new relationship link is displayed in the diagram. The Column, Foreign Key, Primary
Key reference properties are properly set on the selected columns, new primary key and
new foreign key.

To create new associations between model objects in the Table Editor:

1. Select two objects you wish to associate. For example, select columns in different base tables.

2. Right-click. From the pop-up menu, select New Association > Foreign Key
Relationship.

3. New Foreign Key and Primary Key objects will be added to the contents of their respective tabs
in the Table Editor. The Column, Foreign Key, Primary Key reference properties are properly set
on the selected columns, new primary key and new foreign key.

10.1.5. New Model Objects Wizard
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Teiid Designer provides New Child and New Sibling wizards for children of view and source relational
models,namely tables, views, procedures and indexes.

e The Create Relational Table Wizard allows you to create a complete relational table
including columns, unique keys, foreign keys definition and indexes.

NOTE

Note that the relational view wizard is identical to the relational table wizard.

e The Create Relational Procedure Wizard allows you to create a complete relational
procedure including columns, unique keys, foreign keys definition and indexes. The relational
procedure object can represent different types of procedures, including a standard procedure
and source function (pushdown function). When the New Child - Procedure... action is
launched, the first dialog gives you the option of selecting the procedure type.

NOTE

You can model the user-defined functions in a view model.

The second dialog in this wizard customizes the Create Relational Procedure dialog based on
your selected type.

Source functions are procedures that are already deployed and accessable on your database.

By defining source functions in your relational model, you can call these functions from within
your transformation SQL and the functions will be pushed down to your database for execution.

e Create Relational Index Wizard: Indexes can be created at the same time as your
relational table object or via New Child - Index... action and dialog.

e Create View Model Objects Wizards: For view models, only tables, procedures
(standard procedures and user defined functions) and indexes can be created. For view tables
and procedures, the primary difference in the wizards is that they include a SQL Transformation
tab.

e Create User Defined Functions Wizard: You can define custom functions as view
model procedures of the type "function”. When you launch the New Child - Procedure... for a
view model, the first dialog gives you the option of selecting the procedure type which includes
either a standard view procedure or a user-defined function.

User Defined Functions require additional properties such as Java Class and Method as well as
a path to the jar file containing the code.

10.2. MODEL OBJECT EDITORS

The primary actions for editing model objects are:
e (Cut - Deletes the selected object(s) and copies it to the clipboard.
e Copy - Copies the selected object(s) to the clipboard.

e Paste - Pastes the contents of the clipboard to the selected context.
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e Clone - Duplicates the selected object in the same location with the same name; user is able to
rename the new object right in the tree.

o Delete - Deletes the selected object(s).
e Rename - Allows a user to rename an object.

These actions are presented in Teiid Designer's Edit menu and also in the right-click context menus for
model objects selected in the Model Explorer, Dialog Editor and Table Editor.

Modeling Sub-Menu

In addition to the New Child/Sibling/Association menus available for object creation Teiid Designer
provides a Modeling sub-menu which presents various object-specific actions which can be performed.

If you select a source table, for instance, the Modeling menu below would be presented:

= 5@ Northwind.xmi
B

import declarations (2]

s Package Diagram
[ B Alphabetical_list_of products

Mew Child >
[+ E Categon .
Mew Sibling >
[+ E Current o
T Mew Association >
[+ E Custom i
j odeling & Create Web Service
> B Custom
I B Custome Unde %2 Add To New Custom Diagram

Figure 10.11. Modeling Sub-Menu for Source Table

If a view table is selected, the menu would reflect the actions related to virtual operations:

w 5 Customerviews.xmi

P “= import declarations (3)
E, Package Diagram
> = Alphabetical_list_of products
b Cateqory Mew Child >
b Current F Mew Sibling >
b cu stnml_s Mew Association >
b E cu stnme) odeling F Create Materialized Views
b & custome Inde @ Create Web Service
> Custome . Generate SQL Relationships
T %= Add To New Custom Diagram
E & Dg- cut Ctrl+x o Show Dependency Diagram
E—] f:upg,.r Ctrl+C ﬁ Generate Dependency Report

Figure 10.12. Modeling Sub-Menu for Source Table
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Teiid Designer also provides specialized object editors to handle complex model objects and their unique
properties.

10.3. TRANSFORMATION EDITOR

10.3.1. Transformation Editor

The Teiid Designer's Transformation Editor enables you to create the query transformations that
describe how to derive your virtual metadata information from physical metadata sources or other virtual
metadata and how to update the sources.

The Transformation Editor provides a robust set of tools that you can use to create SQL queries.
You can use the tools, or you can type an SQL query into the Transformation Editor.

To edit a transformation:
e Double-click Edit.
o Arelational view table or procedure in the Model Explorer or Diagram Editor
o A transformation node in a transformation diagram or mapping transformation diagram
o A transformation node in a transformation diagram or mapping transformation diagram

e Right-click Edit action on selected object in the Model Explorer, Diagram Editor or
Table Editor.

o A relational view table or procedure
o A transformation node in a transformation diagram or mapping transformation diagram
o A mapping class in a mapping diagram or mapping transformation diagram

A Model Editor is opened if it is not currently open for the selected object's model.

After the corresponding transformation diagram is opened in the Diagram Editor, the
Transformation Editor is displayed in the lower section of the Diagram Editor.

Transformation Editor =47 Cursor at (1. 1) [] Supports Update B2 A & gl 8 O x

SELECT
PartsSourceA SUPPLIER_PARTS.SUPPLIER_ID, PART_ID, QUANTITY, SHIPPER_ID, SUPPLIER_MAME, SUPPLIER_STATUS,
SUPPLIER_CITY, SUPPLIER_STATE
FROM
PartsSourceA.SUPPLIER_PARTS, PartsSourceB.SUPPLIER
WHERE
PartsSourceA SUPPLIER_PARTS.SUPPLIER_ID = PartsSourceB.SUPPLIER.SUPPLIER_ID

Figure 10.13. Editing String Property

If this virtual class supports updates, the tabs on the bottom of the Transformation Editor allow you
to enter SQL for each type of query that virtual class supports. If this virtual class does not support
updates, only the SELECT tab is available.

You can enter separate SQL queries on each available tab to accommodate that type of query.
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Within the Transformation Editor, you can:

e Disable specific update transformation types on this virtual class.

Start your transformation with a provided SQL Template.

Build or edit a criteria clause to use in your transformation.

Build or edit an expression to use in your transformation.

Find and replace a string within your transformation.

Validate the transformation to ensure its content contains no errors.

Reconcile target attributes to ensure the symbols in your transformation match the attributes in
your virtual metadata class.

You can also set preferences that impact the display of your Transformation Editor.
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e The Transformation Editor toolbar actions are summarized below.

o ?::’ Preview Virtual Data - executes a simple preview query for the target table or procedure

of the transformation being edited.

e Search Transformations - provides a simple way select and edit another transformation
based SQL text search criteria.

Edit Transformation - provides a simple way to change which transformation to edit
without searching in a diagram or the Model Explorer. Click the action and select from a list
of views, tables, procedures or operations from the currently edited model.

Cursor at (1, 1) Cyrsor Position (line, column) - shows the current line and column position
of the insertion cursor. For example, Cursor Position(1,4) indicates that the cursor is
presently located at column 4 of line 1.

I Supports Update Supports Update - checkbox allows you to enable or disable updates
for the current transformation target. If Supports Update is selected, the editor shows four
tabs at the bottom for the Select, Update, Insert and Delete transformations. If Supports
Update is cleared, all updates are disabled and only the Select transformation is displayed.

e .
. 4 Reconcile - allows you to resolve any discrepancies between the transformation symbols
and the target attributes. Clicking this button will display the Reconcile Virtual Target
Attributes dialog box in which you can resolve discrepancies.

Wl Save/Validate - saves edits to the current transformation and validates the transformation
SQL. Any Warning or Error messages will be displayed at the bottom of the editor in the
messages area. If the SQL validates without error, the message area is not displayed.

Criteria Builder - allows you to build a criteria clause in your transformation. The button
will enable if the cursor position is within a query that allows a criteria. Pressing the button
will launch the Criteria Builder dialog. If the Criteria Builder is launched inside an existing
criteria, that criteria will be displayed for edit, otherwise the Criteria Builder will be initially
empty.
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Expression Builder - allows you to build an expression within your transformation. The
button will enable if the cursor position is at a location that allows an expression. Pressing
the button will launch the Expression Builder dialog. If the Expression Builder is launched
inside an existing expression, that expression will be displayed for edit, otherwise the
Expression Builder will be initially empty.

Expand Select * - allows you to expand a SELECT * clause into a SELECT clause which
contains all of the SELECT symbols. The button will enable only if the cursor is within a
query that contains a SELECT * clause that can be expanded.

rFs

A Increase Font Size - increases the font size of all editor text by 1.

-

& Decrease Font Size - decreases the font size of all editor text by 1.

Show/Hide Messages - toggles the display of the message area at the bottom of the
transformation editor.

B Optimize SQL - when toggled ON, will use the short names of all SQL symbols that can
be optimized. Some symbol names may remain fully qualified in the event of a duplicate
name or if the optimizer is unable to optimize it. When the action is toggled OFF, all symbol
names will be fully qualified.

[g Import SQL Text - allows you to import an SQL statement from a text file on your file
system. Pressing this button will display an import dialog in which you can navigate to the
file.

% Export SQL Text - allows you to export the currently displayed SQL statement into a text
file on your file system. Pressing this button will display an export dialog in which you can
choose the location for export.

Close X - closes the transformation editor.

e The Transformation Editor context menu can be displayed by clicking the right mouse
button within the editor's text area. The context menu is show below:
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Transformation Editor T | 90
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Select A
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ERROR: SQL - d
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Figure 10.14. Transformation Editor context menu

Following is a summary of the context menu actions:
o Cut - Copy - Paste - Typical text editor actions to cut, copy or paste text within the editor.
o Undo - Redo - Allows you to Undo or Redo the previous action.

o Find - Displays a Find and Replace Dialog which allows you to search and replace text
within the transformation.

o Apply Template... - Displays the Choose an SQL Template Dialog, which allows you to
choose a starting SQL Template from a list of common SQL patterns. See View Table
wizard section for a description of this dialog.

10.3.2. Using the Reconciler

The Transformation Editor's Reconciler offers you a quick, graphical means to reconcile the Target View
attributes and the Transformation SQL. As you make changes, the overall status will appear at the top of
the dialog to assist you in successfully completing your edits.

h
To launch the Reconciler, click the Reconcile Transformation button o # in the Transformation
Editor.
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Reconcile Virtual Target Attributes

Reconciler Status

{3 The SOL contains unmatched symbols - Remove them or create new attributes.

SCOPE: Reconciling Query Unmatched SQL Symbols
Mote: The data types shown are the runtime data types. PART ID
QUANTITY
[T] Target Locked Attribute - SQL Bindings ®
(& SHIPPER_ID

Wirtual Target Attributes SQL Symbol

4| SUPPLIER_ID : string = SUPPLIER_ID : string

Ed SUPPLIER_MAME : string (%) SUPPLIER_NAME : string

A SUPPLIER_STATUS : bigdecimal &) SUPPLIER_STATUS : bigdecimal

N

El SUPPLIER CITY : string (& SUPPLIER_CITY : string

El SUPPLIER_STATE : string (%) SUPPLIER_STATE : string

A PART_ID : string 6] PART_ID : string

B QUANTITY : bigdecimal (%) QUANTITY : bigdecimal

B SHIPPER_ID : bigdecimal (5) SHIPPER_ID : bigdecimal

Add] | Remove | | Clear | | Sort |

Show SQL Display

SELECT
PartsDB2. SUPPLIER. SUPPLIER_ID, SUPPLIER_NAME, SUPPLIER_STATUS, SUPPLIER_CITY, SUPPLIER_STATE, PART_ID, QUANTITY,
SHIPPER_ID. PartsSQL.SUPPLIER_PARTS.PART_ID, PartsSQL.SUPPLIER_PARTS. QUANTITY, PartsSQL.SUPPLIER_PARTS.SHIPPER_ID
FROM
PartsDB2. SUPFLIER, PartsSOL.SUFPPLIER_PARTS

@ cancel | | oK

Figure 10.15. Reconciler Dialog
To summarize the different sections of the dialog:

e Target Attributes - SQL Symbol Table: This table shows the target attributes in the left column
and the SQL Symbols in the right column. The SQL Symbols are the symbols that are projected
from the SQL transformation. A symbol is referred to as being bound to a target attribute when it
is displayed next to the attribute.

If a target attribute is unbound, its row is highlighted in red. The transformation is not valid until
all attributes have a corresponding SQL symbol binding.

Here are a few things you can do in the table section:

o Lock Target Attributes: To lock the target attribute ordering, select the Lock Target Attributes
checkbox. This will lock the attributes in place.

o Re-Order Attributes: To change the ordering of the target attributes, use the Top, Up, Swap,
Down, and Bottom controls beneath the table. Select single or multiple table rows, then click
the desired action button.

o Delete Attributes: To delete one or more of the target attributes, select the table row(s) that
you want to delete and then click the Delete button.

o Resolve Types: If an Attribute-SQL Symbol binding has a datatype conflict, a message will
be displayed. To assist in resolving the datatype conflict, a Datatype Resolver Dialog is
provided. Click on the table row, then click the Type Resolver... button to display the dialog.
See Using Datatype Resolver section for further information.
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e Unmatched SQL Symbols list: This list is to the right of the attribute-symbol binding table, and
shows the SQL symbols from the transformation SQL that are not bound to a target table
attribute.

Here are a few things you can do in the list section:

o

o

o

Add SQL Symbols: To add SQL Symbols to the list, click the Add button. You will be
presented with a dialog showing all available symbols from your transformation source
tables. Click on the symbols that you want to add, then click OK.

Remove or Clear Symbols: To remove one or more of the SQL symbols, select the list items
then click the Remove button. To clear the entire SQL symbols list, click the Clear button.

Sort Symbols: By default, the symbols are shown in the order that they appear in the SQL
query. To show them alphabetically in the list, click the Sort button.

e Binding Controls: The Binding Controls are located between the Attribute-Symbol table and the
Unmatched SQL Symbols list. Use these buttons to define the Attribute-Symbol bindings.

Here are a few things you can do with the binding controls:

o

Bind: This button will bind an SQL Symbol to a target attribute. Select an Unmatched SQL
symbol and select a target attribute, then click Bind to establish the binding.

Unbind: This button will unbind an Attribute-Symbol binding. Select an already bound
attribute in the table, then click Unbind. The SQL Symbol will be released to the Unmatched
Symbols list.

New: This button will create a new target attribute, using an Unmatched SQL Symbol. Select
an Unmatched Symbol from the list, then click New. A new target attribute will be added to
the bottom of the Attribute-Symbol table, bound to the selected SQL symbol.

Null: This button allows you to bind null to a target attribute instead of binding an SQL
Symbol to it. Select a row in the Attribute-Symbol table, then click Null. The target attribute
will be bound to null. If it was originally bound to an SQL Symbol, the symbol will be released
to the Unmatched Symbol list.

Function: This button allows you to define an expression instead of an SQL Symbol for the
binding. To define the expression, select a row in the Attribute-Symbol table, then click the
Function button. The Expression Builder Dialog will display, allowing you to define any type
of expression. See Using Expression Builder section for further information about the
Expression Builder.

e SQL Display: The current transformation SQL is shown at the bottom of the Reconciler dialog.
As you add/remove SQL symbols and make other changes, you can see the SQL display
change to reflect those changes. When you click OK, this SQL will be your new transformation
SQL. If desired, the SQL Display can be hidden by clearing the Show SQL Display checkbox.

Once you are finished defining the bindings and resolving datatypes, click OK to accept the changes.
The transformation SQL will change to reflect your edits.

10.3.3. Using the Datatype Resolver

This dialog is accessible from the Reconciler dialog (See Using Reconciler section) and offers you a
quick way to resolve datatype conflicts between a target attribute and its SQL Symbol. You can resolve
the conflicts in the datatype bindings either by converting all source SQL symbol datatypes or by
changing all target column datatypes.

142



CHAPTER 10. CREATING AND EDITING MODEL OBJECTS

Resolve Datatype Conflicts

Datatype Status

@ One or more of the bindings has a type conflict.

Feconci\.e conflicts in your datatype bindings below. You canconvert your SQL symbol to match the datatypes of your virtual columns or you can change the virtual
column (target) datatypes to match your SGL symbol datatypes. NOTE: these changes will NOT be applied to your model until you click OK.

# Convert all source SQL symbol datatypes =Ere “» Change all target column datatypes

Source SQL Symbol Matched Datatype

SHIPPER_ID : short : short : xs:nt

Selected Binding Info
convert(PartsSourceA SUPPLIER_PARTS.SHIPPER_ID, bigdecimal) AS SHIPPER_ID

@ Cancel oK

Figure 10.16. Datatype Resolver Dialog
To summarize the different sections of the dialog:

e Convert all source SQL symbol datatypes: Click this button to apply a CONVERT function to all
of SQL symbols in the table so that their datatype is compatible with the corresponding attribute
datatype.

e Change all target column datatypes: If the suggested datatype is not acceptable, click this button
to choose your own datatype from the datatype dialog.

e Source SQL Symbol - Matched Datatype Table: This table shows all SQL Symbol datatype
information for the selected binding. Select on a table row to populate the lower panel.

e Selected Binding Info: The lower panel shows the binding information for the selected SQL
symbol. hows all SQL Symbol datatype information for the selected binding. Select on a table
row to populate the lower panel.

Once you are finished resolving datatypes, click OK to accept the changes. You are directed back to the
Reconciler Dialog, which will be updated to reflect your edits.

10.3.4. Using the Criteria Builder

The Transformation Editor's Criteria Builder offers you a quick, graphical means to build criteria clauses
in your transformations based on meta objects in your diagram. If you launch the Criteria Builder
with your cursor within an existing criteria in your transformation SQL, the builder will open in Edit mode.
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If your cursor is not in an existing criteria location, the builder will open in create mode and allow you to
create it from scratch.

This procedure provides an example of building a criteria clause using the Criteria Builder. When
building your own criteria, you can mix and match the values and constants with whatever logic you need
to build powerful and complex criteria.

To use the Criteria Builder:

1. Inthe Transformation Editor, click the Launch Criteria Builder button.

2. The Criteria Builder displays.

£ Criteria Builder

Initial Expression:  PartsSourceA. SUPPLIER_PARTS.SUPPLIER_ID = PartsSou...

LLCERNETE SOL View

PartsSourceA SUPPLIER_PARTS.SUPPLIER_ID = PartsSourceB. SUPPLIER. SUPPLIER_ID
Delete

NOT

Criteria Editors

(@ Attribute () Constant () Function (@ Attribute () Constant () Function
Value is unchanged. Value is unchanged.
< [E PartsSourceA SUPPLIER_PARTS = [E PartsSourceA SUPPLIER_PARTS
o 1 1 D A PartsSourceA SUPPLIER_PARTS.SUPPLIER_ID

B PartsSourceA SUPPLIER_PARTS.PART_ID B PartsSourceA SUPPLIER_PARTS.PART_ID

B PartsSourceA. SUPPLIER_PARTS. QUANTITY S] B PartsSourceA. SUPPLIER_PARTS.QUANTITY Apply

B PartsSourceA SUPPLIER_PARTS.SHIPPER_ID B PartsSourceA SUPPLIER_PARTS.SHIPPER_ID

eS¢

— E PartsSourceB.SUPPLIER =~ & PartsSourceB.SUPPLIER

B PartsSourceB. SUPPLIER. SUPPLIER_ID A PartsSourceB. SUPPLIER. SUPPLIER_ID

& PartsSourceB. SUPPLIER. SUPPLIER_NAME & PartsSourceB.SUPPLIER. SUPPLIER_NAME

B PartsSourceB. SUPPLIER. SUPPLIER_STATUS B PartsSourceB. SUPPLIER. SUPPLIER_STATUS

B PartsSourceB. SUPPLIER. SUPPLIER_CITY B PartsSourceB. SUPPLIER. SUPPLIER_CITY
P Do iecousaR SUIDDLIED SUIDDLIED STATE P o tecnunsaR SUIDDIIED SIDDLIED STIATE

Cancel ] I oK I

Figure 10.17. Editing String Property

The two tabs at the top, Tree View and SQL View, show the current contents of the criteria you
have built.

The Criteria Editor atthe bottom allows you to build a criteria clause. To build a criteria
clause, you must add information to the left side of the predicate, select a comparison operator,
and add a value to the right side.

3. The radio buttons on either side of the Predicate Editor let you choose what type of content
to place in that side of your predicate. Click the radio button of the type of content you want to
place in your criteria. You can click:

o Attribute to add an attribute to the predicate. If you click the Attribute radio button, the
Predicate Editor looks like this:
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(@ Attribute () Constant () Function

Value is unchanged.

=~ & PartsSourceA SUPPLIER_PARTS £
A PartsSourceA SUPPLIER_PARTS.SUPPLIER_ID
A PartsSourceA. SUPPLIER_PARTS.PART _ID
A PartsSourceA. SUPPLIER_PARTS. QUANTITY
A PartsSourceA. SUPPLIER_PARTS.SHIPPER_ID
— & PartsSourceB.SUPPLIER

I PartsSourceB. SUPPLIER.SUPPLIER_ID

I PartsSourceB. SUPPLIER. SUPPLIER_MNAME
B PartsSourceB. SUPPLIER.SUPPLIER_STATUS
I PartsSourceB. SUPPLIER. SUPPLIER_CITY

Figure 10.18. Attribute Panel

From the tree, select the attribute you want to add to the expression. You can select an
attribute from any of the source classes in the transformation.

o Constant to add a hardwired constant value to the predicate. If you click this radio button, the
Predicate Editor looks like this:

() Attribute (@ Constant () Function

'‘Apply' to replace selected Attribute with Constant below.

L

Twpe: | string

Malue

CompanylD|

Figure 10.19. Constants Panel

Select the datatype for this constant from the Type drop-down list and enter the value in the
Value edit box.

o Function to add a function.
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() Attribute () Constant (@ Function

Choose Function below to replace selected Attribute.

CONCAT(PartsSourceA SUPPLIER_PARTS.SHIPPER_ID,
PartsSourceB. SUPPLIER.SUPPLIER_STATUS)

Figure 10.20. Functions

Click the Edit button to use the Expression Builder to construct a function to use in the
predicate of your SQL Criterion.

4. Set a value left side of the predicate and, when necessary, the right side of the predicate. If the
right side of the predicate does not require a value of some sort, the Criteria Builder will not let
you enter one.

5. Click Apply.

6. When you have created both a Left Expression and a Right Expression in the Predicate Editor,
click Apply to add the criterion to the tree view at the top of the dialog box.

The criteria clause displays in the Criteria tree.

You can create complex criteria by joining other criteria with this one. To join criteria with this one, select
the criteria in the Criteria tree and click:

e Delete to remove the selected criterion.

e AND to create a new criterion that must also be true.

e OR to create a new criterion that can be true instead of the selected criterion.

e NOT to establish negative criterion.
If you join a criterion to the one you just completed, you build the expression the same way, using the
Expression Editors panel and the Predicate Editor panel. You can create complex, nested criteria by

judicious use of the AND and OR buttons.

Once you have created the complete criteria you want, click OK to add it to your transformation.

10.3.5. Using the Expression Builder
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The Transformation Editor's Expression Builder offers you a quick, graphical means to build expressions
in your transformations. This Expression Builder lets you create:

e Attributes by selecting an attribute.

e Constants by selecting the datatype and value.

e Functions from both the standard Teiid Designer SQL functions and your enterprise's custom
user defined functions. If you select a function before you launch the Expression Builder, you

can use the Expression Builder to edit the selected function; otherwise, you can create a new
function from scratch.

NOTE

The functions made available through the expression builder are described in the
Teiid Reference Guide.

To use the Expression Builder:

1. Inthe Transformation Editor, click the location where you want to insert the function.

2. Click the Expression Builder button. The SQL Expression Builder displays.

Expression Builder
Initial Expression: =undefined=

BLEERYETE SOL View

7% <undefined=

[D-elet-e |

Expression Editors

(@ Attribute () Constant () Function

Choose Attribute below to replace selected <undefined=.

7 PartsSourceA SUPPLIER_PARTS

[ PartsSourceA SUPPLIER_PARTS. SUPPLIER_ID

A PartsSourceA SUPPLIER_PARTS.PART ID

E PartsSourceA SUPPLIER_PARTS. QUANTITY

[ PartsSourceA SUPPLIER_PARTS.SHIPPER_ID
[ B PartsSourceB.SUPPLIER

Figure 10.21. Expression Builder

The two tabs at the top, Tree View and SQL View, show the current contents of the
expression you have built. To build an expression, you must specify the type of expression you
want to build and populate it. In most cases, you will use the Expression Builder to construct a
complex expression.
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3. Click the Function radio button to add a function.

' NOTE
You can simply add constants and attributes as expressions by themselves using

the Attribute or Constant radio buttons; however, the Expression Editor is
most useful for functions.

4. The Expression Editor displays the Function editor.

Expression Builder

Initial Expression: <undefined=

LCERUENTE SQL View

T =undefined=

| Delete |

Expression Editors

() Attribute () Constant (@ Function

‘Apply' to replace selected <undefined= with Function below.

L

Category [ STRING

Apph.r|
Function: [ECGNCATISTRINGI. STRING2) s ] -
2 Reset
Argument Name Value
STRING1 <undefined=
STRINGZ <undefined=

Cancel || oK

Figure 10.22. Function Panel Selected

From the Category drop-down list, choose the type of function you want to add. By default, the
Teiid Designer offers the following categories:

o Conversion for functions that convert one datatype into another.
o Datetime for functions that handle date or time information.

o Miscellaneous for other functions.

o Numeric for mathematical and other numeric functions.

o String for string manipulation functions.
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' NOTE

Any additional categories represent those containing user defined functions your
site has created.

e

5. From the Function drop-down list, select the function you want. The table beneath the drop-
down lists displays the number of arguments required for this function.

6. Click Apply.

7. Your function displays in the tree at the top. Sub nodes display for each argument you need to
set for this function.

Expression Builder

Initial Expression: <undefined=>

LEERNEE SOL View

=~ # CONCATIBooks _SourceB AUTHORS.FIRSTNAME, <undefined=)
(% Books_SourceB.AUTHORS.FIRSTMNAME

7 =undefined=

Expression Editors

(@ Attribute () Constant () Function

Choose Attribute below to replace selected <undefined=.

— & Books_SourceB.AUTHORS
E Books_SourceB.AUTHORS.AUTHOR_ID

A Books SourceB AUTHORS. FIRSTMAME
= | | Apply

Il Books_SourceB.AUTHORS.LASTMAME

K Books SourceB.AUTHORS.MIDDLEINIT
~ InputSet

) INPUT.isbn

— [E Books_SourceA BOOK _AUTHORS
E Books_SourceA BOOK_AUTHORS.ISBN
E Books_SourceA BOOK_AUTHORS AUTHOR_ID

Cancel ] [ QK

Figure 10.23. New Blank Function Created

You need to set an attribute or constant value for each sub node in the tree to specify the

arguments this function needs. You can also nest another function in the tree using the Function

editor.
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Expression Builder

Initial Expression: =<undefined=

B-ERYETR SOL View

CONCAT(Books_SourceB. AUTHORS . FIRSTNAME, Books_SourceB. AUTHORS. LASTNAME)
% Books_SourceB.AUTHORS FIRSTNAME

% Books SourceB.AUTHORS.LASTNAME
- elete

Expression Editors

() Attribute () Constant (@ Function

Walue is unchanged.

L8]

Category. [STRING

L]

Function: [ECUNCAT(STRINGI. STRINGZ)

Argument Mame Value
STRING1 Books SourceB AUTHORS.FIRSTMAME
STRING2 Books_SourceB. AUTHORS. LASTMNAME

Cancel ] [ oK ]

Figure 10.24. Nested Function Example

8. Click each sub node in the tree and use the editors at the bottom of the dialog box to apply an
attribute, constant, or function value to it.

9. When you have added values to all nodes, as shown below, click OK to add this expression to
your query or Cancel to close the dialog box without inserting the expression.

If the OK button does not enable, you have not added a value to all nodes in the tree.

You can also nest functions within your expressions by selecting an argument and selecting a function
for that argument. The nested function displays in the tree beneath your root function and its arguments
display as well. Using the Expression Builder and nested functions, you can create complex logic within
your query transformations.

10.4. INPUT SET EDITOR (XML)

The Input Set represents a special class that contains attributes from a parent mapping class. When you
create mapping classes for an XML Document model, the Teiid Designer automatically adds an Input
Set to all XML transformation diagrams for mapping classes beneath the highest node in the Document
meta object.

The Input Set proves especially useful for information integration using the Teiid Designer Server.
Through the Input Set, you can access a row of data generated by any XML transformation in a mapping
class higher in the XML document's hierarchy. You can use Input Set attributes, which are individual
columns from the rows of data, within the criteria of an XML transformation query of the child mapping
class.
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You cannot use the Input Set attributes within the SELECT portion of the XML transformation query.
To use an Input Set, you must use the Input Set Editor to bind attributes from parent classes.

Once you have created an Input Set, you can use the attributes within it as source material for the XML
transformation diagram's query.

The Input Set only serves to enable data flow between nested mapping classes. If you use the Teiid
Designer Server for data access, your applications cannot directly query an Input Set. Input Sets only
display in the XML transformation diagram to which they belong. Input Sets do not display on the Model
Explorer view and you cannot use them as you would a normal class, such as for source classes in
other transformations.

To open the Input Set Editor, either double-click the input set in the Mapping Transformation
Diagram or click the edit button on the Input Set in the diagram.

I @?| <<input Set==
T

= Input Set

[ ishbn : string

Figure 10.25. Edit Input Set Button

Input Set Editor by

Input Parameters Mapping Class Bindings
4 isbn : string ﬂ book.isbn : string @ H isbn : string

M type : string

E title : string

H publisher : string
M publishDate : string
B edition : string

| | >

Figure 10.26. Input Set Editor Panel

The Input Parameters table contains a list of mapping attributes within the input set and the mapping
attributes bound to input set mapping attributes. The tree on the right displays the parent mapping
classes and the attributes available from each.

Using the Input Set Editor, you can:

e Add a mapping attribute from a parent mapping class to the Input Set. In the tree on the right,
select the symbol for which you want to create an attribute and click New. The item displays in
the Input Parameters and Mapping Class Bindings table.

e Delete a mapping attribute from the Input Set. Click the row in the Input Parameters and
Mapping Class Bindings table that you want to delete and click Delete. The Teiid Designer
removes this row from the table and this mapping attribute from your Input Set.

e Bind and Unbind Input Parameters.
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Once you have created the mapping attributes within the Input Set that you need, you can use the Input
Set Parameters within a mapping class transformation to produce mapping attributes you can map to
your XML document.

10.5. CHOICE EDITOR (XML)

10.5.1. Choice Editor (XML)

Within an XML Document model, a choice compositor defines all possible document data structures
(sometimes called fragments) that can appear at that location in an XML instance document. When the
Teiid Designer Server populates an XML instance document at runtime based upon your virtual XML
document, it will choose the first fragment that matches the criteria you specify within the Choice Editor.

To view the choice editor, right-click on the choice node in the mapping diagram's XML Document tree
view and click Edit from the right-click pop up menu.

: -4e} hardcoverBook

EI;{-:.} seqUEnCE

D—
4B title
----- {er subtitle

Figure 10.27. Opening The Choice Editor

Wel 2B B

Choice Editor: bookSetMized [ choice Default: I{S} audicBook j | £ ok
| Ciption Mame | Include | Criteria |
{9} hardcoverBook AudioBooks, bookSetMixedDocument, MappingClasses bookSetMixed, TYPE = ‘Hardback!
Z {8} softcoverBook | UCAasE(AudioBooks, bookSetMixedDocument. MappingClasses, bookSetMixed, TYPE) LL... iy
3 {8} audioBook [ AudioBooks  bookSetMixedDocument. MappingClasses . bookSetMixed. TYPE IM ('Books. ..
Lo

El:IiI:J SUMmarsy |

Figure 10.28. The Choice Editor

The table on this panel displays fragment options for the choice, each represented by the top node of the
document fragment.

The Summary tab, shown below, displays an SQL like version of the current choice criteria.
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Choice Editor: bookSetMized [ choice Diefault: I{S} audicBook j | AR

(1) hardcoverBook: ;l
AudioBooks, bookSetMixedDocument . MappingClasses . bookSetMixed. TYPE = 'Hardback!
(2} softcoverBook:
UCASE(AudioBooks, bookSetMixedDocument  MappingClasses . bookSetMixed TYPE) LIKE 'SOF %"
(3} audioBook:
AudioBooks, bookSetMixedDocument . MappingClasses . bookSetMixed, TYPE IM {'Books an Tape', 'Books on 8-Track!, "audic’, 'Books on C0%
Defaulk:
(3} audicBook,

Edit: Summary]

Figure 10.29. Choice Criteria Summary

Using the Choice Editor

You can address each choice option by performing one of the following:

e Specify a criteria statement for the Teiid Designer Server to apply in order to determine which
elements or elements to insert into the result document.

e Exclude or include the option's fragment from the document.
e Set the criteria test order for elements.

e Set a default action that occurs if none of the criteria you set is met.

10.5.2. Excluding Fragments

The XML Schema upon which you based the XML Document model determines the nature of the options
available to the choice. A schema you share with other, external sources (such as business partners)
might include information that you do not want to include within XML files.

For example, Sample Financial Services shares an XML schema with its partners Example Mutual
Insurance, lllustrative Brokerage, and FinancialPartners.com. The partners created the schema broadly,
to cover all possibilities for information they might need to interchange. As such, the customer information
XML document might include a choice compositor based on a list of all products all companies offer.

However, Sample Financial does not offer a credit card; so it could exclude those elements from the
XML documents its Teiid Designer Server creates since it will never have credit card information for an
XML document.

The table on the Choice Editor contains the Includes column. By default, all elements specified by
the schema are included. You can click to remove the check mark beside any element you do not want
to include within your XML documents generated by this virtual XML document metadata model. By
removing the check mark, you are not removing the element from the XML Document model; you are
merely telling the Teiid Designer Server that it will never use this element as part of the choice.

You cannot edit criteria for excluded elements. However, if you exclude an option for which you have
established a criteria, Teiid Designer will retain the criteria if you want to include the option in the future.

10.5.3. Editing Choice Criteria
To edit the criteria for a choice element:

1. In the table on the Choice Editor panel, select the element you want to edit..

2. Click Edit Criteria button to launch the Criteria Builder dialog.
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3. Use the Criteria Builder to create the conditions for which the Teiid Designer Server will
test to determine whether to choose this option in the XML instance document.

4. Click OK. The criteria you set displays both in the table and in the summary tab.

You must set a criterion for each option in your document unless you have selected to exclude that
option or specify that option will be the default option.

10.5.4. Setting Choice Element Order

To edit the criteria for a choice element:

The Teiid Designer Server evaluates the choice criteria in the order in which they appear, and when
one choice criteria is met, the Teiid Designer Server populates the XML instance document with that
option. The Teiid Designer Server might not test all criteria for all options, so their order matters a great
deal.

Therefore, the order in which your options appear within the choice criteria often determines what
information appears ultimately in your XML instance documents. You can reorder the option list within
the choice to set the order in which the Teiid Designer Server tests the criteria.

P~ L2

To set this order, select an element in the table and use the or button to move it into a
new position in the table. The new order displays both in the table and in the Choice Criteria box and
reorders the XML document as well.

10.5.5. Setting a Default Choice Action

The default action represents the course the Teiid Designer Server takes if none of the criteria you set
evaluates to true.

You can set this default using the combo box available in the Choice Editor's toolbar to:
e Any of the options within the table except those you have excluded from the document.
e THROW to throw a Teiid Designer Server exception.
e RECORD to record the Teiid Designer Server exception.

e DISCARD to place no element within the XML instance document.

NOTE

You must set a default action for your choice criteria.

10.6. RECURSION EDITOR (XML)

10.6.1. What is Recursion?

Some XML schema define data structures that contain self referencing elements or datatypes. When
generating XML documents, such data structures can produce an endless repetition of nested tags. This
self nesting pattern is known as recursion.
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When generating virtual documents from XML Schema, the Teiid Designer detects recursive data
structures in the XML Schema model and halts the recursive nesting pattern after two cycles. These two
cycles serve different purposes when mapping the document:

e The first cycle can be thought of as an entry condition for the recursion. The mapping class
located at this node defines a normal mapping transformation like that of any other in the
document model.

e The second cycle defines a mapping transformation that will be performed repeatedly until
conditions are met that will halt the document instance being generated by the Teiid Designer
Server. This fragment of the document model is called the recursive fragment. The mapping
transformation for this fragment is no different from the first, except that you can access the first
cycle's mapping class attributes, plus you have the opportunity to specify the conditions that will
halt the recursion.

You can recognize a mapping class located at the second, recursive document fragment by the looping
arrow button in the top left hand corner of the diagram object as shown below.

When you model a virtual document based on an XML Schema model containing recursion, you can
choose whether to treat the nested fragments as recursive. Use recursion only when the data access
pattern from your data source(s) is also recursive; in other words, when the same query transformation is
to be executed over and over to generate and map the nested document's data content.

By default, the Teiid Designer does not mark the recursive fragments in document models to execute
recursively in the Teiid Designer Server. To take advantage of this behavior, you must open the

Recursion Editor in the recursive mapping class , mark the transformation query as recursive, and
specify the recursion limit properties.

10.6.2. Recursion Editor (XML)

The Recursion Editor lets you enable and limit recursion. The Recursion Editor button only
displays on mapping classes, which have recursive patterns. For example, if you have an element
named Employee which contains a element named Supervisor which itself contains an Employee
element nested within it, you might need to limit the number of times the elements are nested within the
document.
You can set the following conditions to limit the recursion:

e A fixed number of results to the query.

e An SQL based criteria limit condition.

e A combination of both.

To open the Recursion Editor, click the Recursion Editor button Y on the displayed mapping class.
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U/ ) /f -z Employee

I LastMame : string
ot A FirstMame : string

- I Middlelnitial ; skring
o 4 Skreet : skring
54 Ciky @ string

4 Skate ; Statelanonymous bype)
M Empld : positivelnteger

= =Mapping Tlaz
=& Phone

|

S PhoneType : PhoneTypelanal
A PhoneMurber : Phonefumbe:
I PhoneExt : PhoneExk{anonyn

==Mapping Clasz==

4 SUpErvisor

Figure 10.30. Open Recursion Editor Button

Recursion Editor: Supervisar ¥ Enable Recursion g x

Countk Limit: |5 — Action When Courk Limit Exceeded:  |[THROW

Limit Condition  Edit

Emploveelbocs, Employveebocument . MappingClasses, Supervisar.name = 'Joe Smikh’

Figure 10.31. Recursion Editor

10.6.3. Edit Recursion Properties

To edit recursion properties:

1. Select the Enable Recursion checkbox if you want the Teiid Designer Server to perform the
query you specify to generate the nested tags within the XML document.

2. Click the arrows beside the Count Limit box to limit the number of times to recursively
perform the query. If you do not seta Limit Condition in the text area, the recursion finishes
when the query reaches this limit. You can only set this limit to a maximum supported by your
Teiid Designer Server. For more information about this limit, contact your system administrator.
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3. Clickthe Action When Count Limit Exceeded drop-down menu to instruct the Teiid

Designer Server what to do if it encounters more results for the query than the count limit before
it reaches the limit condition.

4. Click the Edit button to launch the SQL to build a limiting condition for this recursion.

NOTE

The Teiid Designer Server will evaluate this condition each time it recursively performs
this query. If this criteria clause evaluates false, the Teiid Designer Server performs the
query recursively again unless it has reached the Count Limit. If the criteria evaluates
true, the Teiid Designer Server performs the mapping for the current level and ends its
recursive loop.

When you have created the criteria, it displays in the Limit Condition box.

When the Teiid Designer Server dynamically populates your XML documents at runtime, it will use the
recursion specifications you entered here.

10.7. OPERATION EDITOR
Editing of Web Service Operation transformations is simplified via the Operation Editor. When editing a
Web Service model, an additional editor tab labeled Operation Editor is available. This editor,

shown below is comprised of:

e Operations section showing a tree view of Interfaces and Operations contained within the Web
Service model.

e Input Variables section providing editing of desired Input Variable declarations.

e Procedure section providing SQL editing of the procedure.
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m BooksXML. xmi

Operation Editor 7 % Cursorat(l, 1) W OA A = Gy

Operations Input Variables

< € bookCollection The va_ria?les representing values from the request document that are available to the selected
operation's procedure.

£} getbookCallection Add or Remowe variables. ..

IN_author : string

IN_edition : string
IN_isbn : string
IN_publishDate : string
Procedure
The body of the selected operation's procedure (i.e., it is not necessary to include the CREATE or
BEGIN/END clauses).
CREATE VIRTUAL PROCEDURE
BEGIM
DECLARE string VARIABLES.IN_isbn = xpathvalue
(BOOKCOLLECTION_WS.BOOKCOLLECTION.GETBOOKCOLLECTION. baokCollectioninpu
t, 'f*:bookCollectionf*:book/@*:isbn'};
DECLARE string WARIABLES.IN_title = xpathvalue
(BOOKCOLLECTION _WS.BOOKCOLLECTION.GETEQOKCOLLECTION. bookCollectioninpu
t, '*:bookCollection/:boaok/*title');
DECLARE string VARIABLES.IN_subtitle = xpathvalue

% Package Diagram [5] Table Editor | [ Operation Editor

Figure 10.32. Operation Editor
The Operations section contains all interfaces and operations currently defined in the model.

Selecting an operation will display the variables related to the input parameter's content in the Input
Variables section and the body of its procedure (minus the CREATE VIRTUAL PROCEDURE BEGIN
- END keywords and the input variable declarations and assignments) in the Procedure section.

When pasting in SQL, do not include the CREATE VIRTUAL PROCEDURE BEGIN - END keywords.
Input variables will be automatically generated when the Content via Element property is set on an
operation's input parameter. Input variables may be edited using the Add or Remove link in the Input
Variables section, and may only represent XPath values to single attributes and elements within the
input contents; other variable declarations and assignments must be typed directly into the Procedure
section. Clicking the Add or Remove link will display the following dialog:

158



CHAPTER 10. CREATING AND EDITING MODEL OBJECTS

Edit Input Varnables

Request Document Input Variables

Check a request document component to define an input variable for the Web Service Select an input variable to see
procedure. Uncheck a request document component to delete an existing input the XPath that will be used to
variable. zelect itz value from the

= [] [e] bookCollection : BooksNS:BookSetNested request document.

= [_] |2l book : BooksNS:BookNested
[] @ isbn : BookTypesNS:ISBN

IN_author : string
IN_edition : string
IN_ishn : string

@ title : xsd:string
[e] subtitle : xsd:string
[e] edition : BookTwpesNS:BookEdition
P[] [e] authors : BooksNS:Authors
[* [] [g] publishinglnformation : BooksNS:Publishinginformation

IN_publishDate : string
IN_publisher : string
IN_subtitle : string
IN_title : string

XPath for IN_title
M bookCollection/*: bookf*:title

Figure 10.33. Edit Input Variables Dialog
10.8. MANAGING MODEL OBJECT EXTENSIONS

10.8.1. Managing Model Object Extensions

Extending a model adds extra properties to its model objects. One good use of these extension
properties is for passing data to a customized Data Services translator. The Teiid Designer model
extension framework consists of:

e Model Extension Definitions (MEDs)

e MED Registry - keeps track of all the MEDs that are registered in a workspace. Only registered
MEDs can be used to extend a model.

e MED Editor

10.8.2. Create New MED

To create a new MED select the File > New > Other. .. action to display the New wizard dialog.
Select the Teiid Designer > Teiid Model Extension Defn option which displays the New
Model Extension Definition dialog. Browse and select existing project or project folder location
for MED file and specify unique file name and click Finish.

NOTE

If a project is already selected when wizard is launched, the location field will be pre-
populated.
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New Model Extension Definition

New Model Extension Definition
Press the "Rnish" button to finish.

Faolder Location: [ExtendedPar‘ts ] E]

Model Extension Definition Name: [ExtraF'arts ]

Open in Extension Editor

@ < Back Next > Cancel ||  Fnish |

Figure 10.34. MED Editor Overview Tab

10.8.3. Edit MED

To edit an MED file select an existing . mxd file in your workspace and right-click select the Open action.
The MED Editor will open to allow editing .

On the Overview tab, you can specify or change the Namespace Prefix, Namespace URI, the Model
Class you wish to extend (Relational, Web Service, XML Document, and Function) and a description.

After entering the basic MED info, you can now switch to the Properties tab and begin creating your
extended property definitions for specific model objects supported by selected model class.
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s mymxd.mxd £

& Properties ~ B
~ Extended Model Objects

Manage the extended model objects that have extension properties

BaseTable

~ Extension Properties f'l] B

Manage extension properties for each extended model object

[v] Runtime Type Required Modifiable Advanced Masked Indexed Default Value Fixed Value Allowed Values Display Name Descripl
copyable boolean v vl true,false  Copyable Indicat

W Source |

Figure 10.35. MED Editor Properties Tab

Start by clicking the Add Extended Model Object toolbar button to display the Model Object
Name selection dialog. Select an object and click OK.

] Add Model Object Name A

ﬁ' Model ObjECt Name choose the Model object that will have extension properties.

= BaseTable

Calumn
Primarykey
Foreignkey
AccessPattern
UniqueConstraint
= View
Calumn
AccessPattern
< Procedure
=~ ProcedureResult
Calumn
ProcedureParameter

Index

@ " caneel [ ox

Figure 10.36. Select Model Object Name Dialog
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Next, select the model object in the Extended Model Objects section and use the actions and
properties table in the lower Extension Properties section to add/remove or edit your actual
extended properties. Selecting the add or edit extension properties actions displays a dialog containing
sections to edit general properties, value definition (required, masked, allowed values) as well as display
name and description values which can be internationalized.

Edit Property Definition

L? Property Definition Enter the property's general information, value information, descriptions, and display names.

* General
Enter general property characteristics

Model Object: BaseTable

Namespace Prefix: mymodelextension

1D: copyable

Runtime Type: boolean E

| | Should only be modified by advanced users
I\_I‘TWiII be used by Teiid server

* Value Definition
Enter the characteristics of the property value
| | Avalue is required

|| Mask the property value when shown to user

v The value must be one of the following:

true
false

|| Use this initial value:

The value can only be this value

b Display Name -'
} Description -'

@) |  Cancel | oK

e

Figure 10.37. Edit Property Definition Dialog

10.8.4. Extending Models With MEDs

MEDs must be applied to a model in order for their extension properties to be available to that model's
model objects. To manage the applied MEDs for a specific model select the model and right-click select
the Modeling > Manage Model Extension Definitions action. This will display a dialog listing
the current applied MEDS and actions and buttons to add or remove MEDs from a model, extract a MED
from a model and save a copy of it locally as a . mxd file and lastly, update the version of MED in a model
if it differs from a version in your MED registry.
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800 Manage Model Extension Definitions

Manage Model Extension Definitions

Add or Remove Model Extension Definitions to be associated with this model.

Location: Test/

Maodel: View

Current Model Extensions for the selected model:

'Flegistered Different Namespace Prefix Version Description ' | Add... |
Remowve
Save
Update
ﬁ'} | Cancel | |  Finish |
Figure 10.38. Manage Model Extension Definitions Dialog
Clicking the Add button displays a list of applicable MEDS based on model class.
8 00 Available Model Extension Definitions
Select the Model Extension Definition(s) to be added to the model.
Model Extension Definitions
Mamespace Prefix Version | Description
mymodelextension 1 This is my model extension
rest 1 REST extended virtual procedure properties

&9 Select at least one Model Extension Definition

() '\ Cancel | oK

hoE S

Figure 10.39. Add Model Extension Definitions Dialog
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NOTE

After adding/removing MEDs from the model, click Finish to accept all of the changes.
Canceling the dialog will discard all changes and revert to the original model state.

10.8.5. Setting Extended Property Values

Extension properties are user defined properties available to any extended model object via the
Properties View. All extension properties are available under the Extension category and are
prefixed with a MED's namespace prefix. If there is an initial value for an extension property it will be set
to the default value using the property definition found in the MED.

=l Properties 33 ™. Descriptinn] BB = ¥ =0
Property Yalue
¥Extension
mymodelextension:Copyable  true
¥Info
Object URI
T Misc
Cardinality 110
Logical Relationships
Materialized % false
Materialized Table =
Name tANewBaseTable

Figure 10.40. Properties View For Extended Model Object
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CHAPTER 11. USER DEFINED FUNCTIONS

11.1. USER DEFINED FUNCTIONS

Teiid Designer enables you to extend Teiid's function library by using custom or User Defined
Functions(UDFs). You can define a UDF with follwing properties.

e Function Name - When you create the function name, remember that:

o You cannot overload existing Teiid System functions.

o The function name must be unique among user defined functions in its model for the
number of arguments. You can use the same function name for different numbers of types
of arguments. Hence, you can overload your user defined functions.

o The function name cannot contain the '.' character.
o The function name cannot exceed 255 characters.

e Input Parameters- Input Parameter defines a type specific signature list. All arguments are
considered required.

e Return Type- the expected type of the returned scalar value.

e Pushdown - Indicates the expected pushdown behavior. It can be one of REQUIRED, NEVER,
ALLOWED. If NEVER or ALLOWED are specified then a Java implementation of the function
must be supplied. If REQUIRED is used, then user must extend the Translator for the source and
add this function to its pushdown function library.

e invocationClass/invocationMethod- optional properties indicating the method to invoke when the
UDF is not pushed down.

e Deterministic - if the method always returns the same result for the same input parameters.
Defaults to false. It is important to mark the function as deterministic if it returns the same value
for the same inputs as this leads to better performance.

Even Pushdown required functions need to be added as a UDF to allow Teiid to properly parse and
resolve the function. Pushdown scalar functions differ from normal user defined functions in that no code
is provided for evaluation in the engine. An exception is raised if a pushdown required function cannot be
evaluated by the appropriate source.

11.2. MODELING YOUR FUNCTIONS
Teiid Designer provides a new object wizard to assist you in modeling your User Defined Functions.
Right-click the existing model and click New — Procedure. In the wizard, you can see an option to

specify the function's jar location on your file system, as well as the java class and java method.

If you create a function using alternative methods, you must select the procedure and edit the different
properties for the procedure in the Properties view.
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roperties rvers | |E]| Description | us
E=l Properties 33 | 4k Se =] Descript ¥ Stat = O

— - | -* =
= () »

Property Value

=
relational: Aggregate false
relaticnal:Deterministic false
relational:Function Category ~ nameUtils
relational: Java Class - org.teiid.designer.examples.NameBuilder
relational: Java Method — buildMame
relational:Mative Query
relational:Mon-Pre pared false
relaticnal:Returns null on null false
relational: UDF Jar Path — lib/name_builder.jar
relational:Variable Arguments false

Figure 11.1. VDB UDF Jar Files

A User Defined Function represents a defined method in a java class. In order for the Teiid runtime to
register the function and allow its use in the transformations, you must specify the following as
properties:

e Function Category - unique name for a grouping of user defined functions. This category is
displayed in the Expression Builder wizard so you can locate and select your function.

e Java Class - fully qualified name of the java class containing your function method.
e Java Method - the name of the function method in your java class.

e UDF Jar Path - the relative path in your project for the jar containing your UDF which will be in a
lib folder in your project. If you are defining your jar for the first time and there is no jars in your
lib folder, the property editor will allow you to select a jar from your file system. If one or more
jars already exist in a lib folder, the editor will allow you to choose between selecting from your
workspace or your file system.

11.3. UTILIZING YOUR FUNCTIONS IN TRANSFORMATIONS

Once you have finished modeling your functions, you can use your function calls in your transformation
SQL. These functions are accessible through the Transformation Editor's expression builder wizard.

11.4. INCLUDING FUNCTIONS IN YOUR VDB

In order for JBoss Data Virtualization to become aware of your functions, the actual code must be
deployed on your server and available to your Teiid submodule. Teiid Designer workspace is aware of
any models containing functions and their referenced jars and class information. When a source model
containing user defined functions is added to a VDB, the jar containing the defined function is also added
to VDB and visible in the VDB Editor's UDF Jars tab.
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ER ViewModelxmi 52

@ AlModelsvDB.vdb 33

Location:  fAllModelsProject

Version |1 Synchronize All | | Show Import VDBs

=

|

Wed Jun 11 09:56:00 COT 2014

Teiid runtime version :

8.7.0

m Other Files | Description |

File

Locationin VDB

name_builder.jar

! ik

B G

B

Figure 11.2. VDB UDF Jar Files
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CHAPTER 12. METADATA-SPECIFIC MODELING

12.1. RELATIONAL SOURCE MODELING

12.1.1. Source Function

To improve ability to utilize database functions within View transformations, Source Function action and
wizard is added to Teiid Designer. Source Function assists you in building a source procedure that
conforms to a function structure, including input and output parameters. Click New Child >
Procedure toopentheProcedure Type dialog.

New >)_VIA | SHIP_VIA | fals
New Child

Modeling ld Procedure...

View...

Open

Index...

clarations (1) c Custom Diagram
opy

Paste Ctri+v

Jiagram

Paste Special... Ctri+V
' Delete

Refactor »

Imrnrt
Figure 12.1. New Source Function Action

Select Source Function actiontoopen Create Relational Source Function dialog. Enter
your database function name, define input parameters including datatype and length, specify output
parameter info, set options and click OK.
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Select Procedure Type

Select desired relational procedure type and click OK

" Procedure

Simple relational procedure containing parameters and an optional result set

@ |source Function

Represents a source function assumed to be present on a database. This function can be used in your virtual queries and the function
call will be pushed down to your source in the final query execution plan

@ Cancel OK

Figure 12.2. New Source Function Action

The resulting source function will be added to your model and will be represented by the k.4 icon.

Create Relational Source Function

Create Relational Source Function

Click OK to add new object to model

Model File
PartsSupplier.xmi
Mame
getEmployeelnfo

MName In Source

H Properties | ¥ Parameters | #Description
Add | | Delete | | Move Up | | Move Down
Parameter Name Data Type Length Direction
employeelD integer 12 IN
@ Cancel OK

Figure 12.3. Create New Source Function Dialog

When finished, the new source function will be displayed in your model's package diagram.
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1= Model Explorer 2 = 8 & *PartsVirtual.xmi |G *PartsSourceA.xmi &

R EBe = |25 7
. Bécuuntrylnfu ____

5= EmployeesProject

i PART_ID : string(50) SHIPPER_ID : short STATUS_ID : short SUPPLIER_ID : string(10)
i PART_NAME : string(255) JH SHIBDER _RIAME - ctrinal2 STATUS_NAME : string(3C SUPPLIER_NAME : string(30)

+ = data g PART_COLOR : string{!ﬂ]_: SUPPLIER_STATUS : short
SUPPLIER_CITY : string(30)

+ & readme PART_WEIGHT : string(25
SUPPLIER_ID ; string(10) SUPPLIER_STATE : string(2)

PART_ID : string(50) 5

¥ PartsSourceA.xmi - n
QUANTITY : short
+/ G@ PartsSourceB.xmi PEEERL s e
_ID : shor il 1

< 63 PartsVirtual.xmi

Sh= PartsProject

1] .project

% employeelD : integer

& Test_WSDL

7 1 TestDDL

Figure 12.4. New Source Function In Package Diagram
After saving your model, your new source function will be available for use in your transformations. If you

open the Expression builder, your source functions will be selectable in the Function drop-down selector
for a Category named for the model.

12.1.2. Create Relational Table Wizard

You can create table with the action New Child > Table...

MNew > |
MNew Child > Table...
Modeling > Procedure...
View...
Open
Index...
l Open With >
] Custom Diagram
Copy
| Paste Ctri+V
Paste Special... Ctri+V
Delete
Refactor >
Import...

Figure 12.5. New Relational Table Wizard Action

Running the action will display the Create Relational Table wizard. The wizard page contains
tabbed panels representing the various properties and components that make up the possible definition
of a relational table. Enter your table name, define columns, keys, constraints and other options, then
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click OK.

This wizard is designed to provide feedback as to the completeness of the relational table information as
well as the validation state of the table and its components. Note that although errors may be displayed
during editing, the wizard is designed to allow finishing with the construction of an incomplete table
containing errors.

The first tab labeled Properties contains the input for the simple table properties including name,
name in source, cardinality, supports update and is system table properties.

Create Relational Table

Create Relational Table

I No columns defined for table

Model File
PartsSupplier.xmi
Name

Partsinfo

MName In Source
Partsinfo

B Properties | M Columns | ®lPrimary Key = 8 Unique Constraint | Fl Foreign Keys | Mindexes = =l Native Query

Cardinality O

¥ Supports Update Is System Table

Materialized

Materialized Table

Description

@j Cancel OK

Figure 12.6. Properties Tab

The Columns tab allows creation and editing of basic relational columns. This includes adding, deleting
or moving columns as well as changing the name, datatype and length properties.
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Create Relational Table

Create Relational Table

Click OK to add new object to model

Model File
PartsSupplier.xmi
Name

Partsinfo

MName In Source

Partsinfo

8 Properties | ® Columns | El Primary Key = M Unique Constraint =l Foreign Keys [ indexes | &l Native Query

Add Move Up
Column Name Data Type Length
E D string 10
E name string 10
@ category string 10
E quantity string 10
® Cancel Ok

Figure 12.7. Columns Tab

The Primary Key tab allows editing of the name, name in source and column definitions.Note that
clearing the box will clear the data. The Unique Constraint tab contains the identical information.
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Create Relational Table

Create Relational Table

Click OK to add new object to model

Model File
PartsSupplier.xmi
MName

Partsinfo

Mame In Source

Partsinfo

E Properties Columns | Bl Primary Key | B Unique Constraint | FlForeign Keys = [@Indexes | 2l Native Query
¥ Include
Name | p_partinfo
Name In Source [PK_Par'tInfo
Change... Column Name
ID
@ Cancel OK

Figure 12.8. Primary Key Tab

The Foreign Keys tab allows creating, editing and deleting multiple foreign keys.
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Create Relational Table

Create Relational Table

Click OK to add new object to model

Model File
PartsSupplier.xmi
Mame

Partsinfo

Mame In Source

Partsinfo

8 Properties | © Columns | I Primary Key =M Unique Constraint | ElForeign Keys | @Indexes | 3l Native Query
Add|| | Edit... | | Delete

Foreign Key Name

El FK_Supplier

@ Cancel OK

Figure 12.9. Foreign Keys Tab

To create a new Foreign Key, select the Add button and enter/select the properties, key references in

the tables shown below. Note that the Select Primary Key or Unique Constraint table will display any
PK/UC existing in the selected relational model. If no tables in that model contain a PK or UC, then the

table will be empty.
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Create Foreign Key

Create Foreign Key

Enter valid name, select a key or constraint, select column references and press OK

Mame FK_Supplier

Mame |n Source IFK-SUPPUEF

Foreign Key Multiplicity 'ONE v |
Unique Key Multiplicity | ONE v |
¥ Allow Join

Select Primary Key or Unique Constraint

L @ Partsinfo: PK_Partinfo

Select Column References To FK

M@ name

1@ category

@ | Cancel | OK I

Figure 12.10. Create Foreign Key Dialog

12.2. RELATIONAL VIEW MODELING

12.2.1. Create Materialized Views

For any relational view table you can enable its materialized view option by setting the Materialized
property to TRUE and setting the Materialized Table reference, as shown in the figure below. Note that
you are required to have already created your relational tables.
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= Properties 232 | Description | <= Tags :{——:D ﬂ' = =08 Ef
Property Value 0 iten
= Misc

Cardinality 41 0

Logical Relationships

Materialized i true [If true, the table can be materialized (cached). Only applies to virtual tables.|

Materialized Table & PARTS (Path=/PartsTest/MaterializedParts. xmi/MaterializedParts)

Name C& PARTS

Name In Source 4 PARTS

Supports Update v false

i
System vz false
0* BaseTable: PartsViewModel/PARTS

Figure 12.11. Materialized Table Properties

Teiid Designer includes a feature to assist in quickly creating materialized relational tables based on
your existing view tables.

To create materialized views:

1. Right-click on one or more view tables in the Model Explorer View and select the Modeling
> Create Materialized Views action.

i Fackage Liagiain
& PARTS

b B SHIP g
= = New Child >

B STAT o

b R supt Mew Sibling >
= MNew Association >

~
W

B supt :
b G Product Madeling ® Create Materialized Views
roduc

& Create Web Service

LT salesforce <:ﬂ Undo Delete multiple objects

o SearchF.’raj Redo & Add To New Custom Diagram
g -IS_EF;;I'::ltslng of Cut CirleX 'ﬁ Add to Metadata Favorites
_ Capy ctri+c “
[ 1 | Paste Crlay

Figure 12.12.

2. Inthe Create Materialized View Model dialog specify or select a target relational model
for your generated relational tables.
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] Create Materialized View Model ¥

Create Materialized View Model

All inputs QK. Press Fnish to create materialized view tables.

Materialization Mode| [Mﬂteriﬂ“zedpﬂrts l B

Target Location [MﬂterializedPﬂrts l

Selected Virtual Tables

PARTS
SHIP_WIA

@ Cancel ] [ Finish

Figure 12.13.

3. Selecting the Browse . .. button displays the Relational Model Selector dialog where
you select an existing relational model or specify a unique name for a new model.

177



User Guide Volume 1: Teiid Designer

[l Relational Model Selector Dialog o

Select the Relational Model or schema location within a model in which the entities will be created.

= f= PartsTest

[* g Morthwind.xmi

[* C§ PartsSupplier.xmi
[l PartsTestvDB.vdb

[* 63 PartsViewModel xmi

[ ﬁ ProductsOracle. xmi

New Model Name: [MaterializedPar‘ts ]

Click OK to create the relational maodel

@ Properties... | [ Cancel l I QoK

Figure 12.14.

4. Click OK to create relational tables corresponding to your selected view tables and automatically
set the Materialized property to TRUE and the Materialized Table reference value to your newly
generated table.

When finished your view tables will be configured with their new materialized properties and the
corresponding relational tables will be shown in their package diagram.
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(5]
£
[

B Package Diagram  [=] Table Editor

Figure 12.15. Materialized Table Properties

12.2.2. Create Relational View Table Wizard

You can create relational view tables by clicking New Child > Table. .. action. This action also
includes creating view tables with its target columns and SQL transformation.

# B STA™ " e —rT‘l":shurt
MNew »
+ 8 suP
New Child e Table...
o Hsup Modeling *  Procedure...
Index...
Open
Open With > Custom Diagram

Figure 12.16. New View Table Wizard Action

Running the action will display the Create Relational View Table wizard. The wizard page
contains tabbed panels representing the various properties and components that make up the possible
definition of a relational view table. Enter your table name, define the desired columns and specify the
SQL transformation, then click OK.

This wizard is designed to provide feedback as to the completeness of the relational view table
information, as well as the validation state of the table and its components. Note that although errors or
warnings may be displayed during editing, the wizard is designed to allow finishing even if the table
definition is incomplete.
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The first tab labeled Properties contains the input for the simple table properties including name and

supports update.

Create Relational View Table

Create Relational View Table

Mo columns defined for table

Model File
PartsVirtual.xmi
Name

myTable

Name In Source

El Properties| | El Transformation SQL | © Columns
Cardinality O

# Supports Update | |s System Table

| Materialized

Table Reference

Description

®@

Figure 12.17. Properties Tab

Fl Primary Key = M Unigue Constraint | Fl Foreign Keys [ Indexes

Cancel 0K

The Columns tab allows creation and editing of basic relational columns. This includes adding, deleting
or moving columns as well as changing the name, datatype and length properties.
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Mo columns defined for table

Model File
PartsVirtual.xmi
Name

myTable

Name In Source

El Properties = El Transformation SQL
Add

Column Name Data Type

®@

Figure 12.18. Columns Tab

The Transformation SQL tab allows editing of the SQL Transformation for the relational view. The
desired SQL can be entered directly into the text area or a SQL Template may be selected by clicking
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Create Relational View Table

Length

the Select SQL Template button.

B Columns| | ® Primary Key | 8 Unigue Constraint | ElForeign Keys

Cancel

I |ndexes

0K
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Create Relational View Table

Create Relational View Table

MNo columns defined for table

Model File
PartsVirtual.xmi
Name

myTable

Name In Source

Properties | &l Transformation SQL Columns | B Primary Key | M Unigue Constraint =l Foreign Keys | @ Indexes

Select SQL Template

SQL Definition

SELECT [TABLEA.COL1), [TABLEB.COL1] FROM [TABLEA], [TABLEB]
WHERE [TABLEA.COL1]=[TABLEB.COL1]

@ Cancel OK

Figure 12.19. Transformation SQL Tab

If the Select SQL Template button is selected on the Transformation SQL tab, the Choose a
SQL Template dialog is displayed.

182



CHAPTER 12. METADATA-SPECIFIC MODELING

= Choose a SQL Template E=lES
Choose a SQL Template

Choose a SQL Template from the available options. —

-Template Options

\SELECT Queries|| PROCEDURES

@ Simple SELECT

() SELECT with Join Criteria
() UNION Query

(") Flat File - Local Source
() XML File - Local Source
(") XML File - URL Source

-SQL Template
SELECT * FROM [TABLEA]

@ Cancel | | oK

Figure 12.20. SQL Templates Dialog
A number of common SQL templates may be chosen using the dialog. Depending on usage context, the

PROCEDURES tab may also be available in addition to the SELECT queries tab. The SQL Template
dialog can also be accessed in the Transformation Editor, from the right-click context menu.

12.3. XML DOCUMENT MODELING

12.3.1. Create XML View Documents from Schema

You can create XML View Documents by selecting an element in the Model Explorer and selecting the
Modeling > Create XML View Documents action.
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Db GLdLy P e Ao

= EI Books.xsd
— [5] Books.xsd
4_ BookDatatypes.xsd
Iﬂ__,| MetaMatrix Data Set Library Version 1.1. Boo...

B bibliography _ BooksNS- Biblinoraohw
Mew Child >

8] bookListing :

8] bookCollectic New Sibling b

[€] bookSetMixe New Association >

Bibliography odeling Create Scalar To XML Transformation

Bilbiographyt Create XML To Scalar Transformation

BookSxifiat. <r"5' Undo Set org.ecli...) to FK_Account_Accountld Create XML View Documents

Redo
BookFlat
BookSethMest sf Cut Ctrl+X |
BookNested - L

& Add to Metadata Favorites

VWV WV VY WV VWV Vi

)

Figure 12.21. Create XML View Documents Action

The action will query you for a target XML Document model. You can either select an existing XML
Document model from your workspace, or enter a unique model name and the wizard will create a new
model for you.

[ Select or create XML View model o

= = BooksXMLTest
[> ‘-El BookDatatypes.xsd
> fgl Books.xsd
[> ‘-EI Booksinput.xsd
> ﬁ'] BooksXML.xmi
= {é PartsTest
[» Ci§ Northwind. xmi
> ﬂ PartsSupplier.xmi
(1 PartsTestvDB.vdb
[> El§ ProductsOracle.xmi

Mew Model Name: ]

€3 Enter name and click OK to create a new XML View Maodel in folder "BooksXMLTest"

@ Properties... l [ Cancel l I (8].4

Figure 12.22. Select or Create XML View Model Dialog

After selecting or creating your new XML Document model, the XML Document builder page will be
displayed. This page is explained in greater detail in the document view from schema section.
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Build XML Documents From XML Schema

Select XML Schema

Select XML Schema file, then select Schema Root Elements. Or press RAnish to create an empty XML Document.

XML Schema Fle: [FEnnksKMLTestFEonks.xsd ] E]

Select one or more Schema Root Elements to generate Virtual Documents
Schema Root Elements

Virtual Documents

[8] bookCallection : BooksNS:BookSethNested [2] bibliography : BooksNS:Bibliography
[2] bookListing : BooksNS:BookSetFlat

[e] bookSetMixed : BooksNS:BookSetMixed

»|
«

[] Keep sorted alphabetically

-Document Options

@ Build full virtual documents from the schema

() Build only first level of each document (for large schema where many portions will not be used)

-Mapping Options
Build Mapping Classes

‘Mapping Class Locations

(@ Locate at XML Schema iteration nodes (max occurs = 1) - for schema-compliant data access

(1 Locate at XML Schema complex types - for semantic use only

‘Mapping Class Column Datatypes
(@ Use XML types from the document

() Use "String" mapping type (disables automatic output conversion to closest built-in XSD type)

@

[ Next = ][ Cancel H Finish |

Figure 12.23. Build XML Documents From XML Schema Dialog

12.4. WEB SERVICES MODELING

12.4.1. Create Web Service Action

This method is recommended for experienced users for consistent and rapid deployment of Web
services designed to query relational sources. It provides detailed control of all Web service interfaces,
operations and required transformations from XML Views.

To create a Web service model from relational models or objects:
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1. Select any combination of relational models, tables and/or procedures in the Model Explorer
view tree.

NOTE

It is recommended that the user selects single source models, which enables
auto-naming of input/output schema and Web service models in Step 3.

2. Right-click select Modeling > Create Web Service action. .

| [» C§ PartsSourceB.xmi |
MNew >

Mew Child >

Modeling > | ¥, Create Web Service

Generate SQL Relationships

Open
Ep With 5 Transformations - Export SQL
en Wi
P - Transformations - Import SQL
[ﬁ Teiid &3 ) copy _

Figure 12.24. Create Web Service Action

3. Inthe Create Web Service dialog, specify file names for the generated Input Schema file,
Output Schema file and Web service model. Change options as desired. Click Finish when
done.
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E Create Web Service

Create Web Service

Click Anish to generate.

-Location

Specify location for generated modelis) (i.e. Project aor Falder)

| Testws|

| |Browse... |

-Output Schema Model

Mame: [F’arts_ﬂ_ﬂutput

Generate flat XSD

Input Schema Model
Generate

Mame: [F’arts_t]_lnput

Generate flat XSD

‘Web Service Model

Mame: [F’ﬂrts_ﬂ_ws

Generate default SQL for XML mappings

@ Cancel

Bnish

Figure 12.25. Create Web Service Dialog

4. When model generation is complete, a confirmation dialog appears. Click OK.
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Generation completed successfully.
@ Generation completed successfully

-

NewMudeIF’artshﬁrtual_ﬂutput}sdcreated
New Model PartsVirtual Input.xsd created

MNew Model PartsVirtual _Output View.xmi created
New Model PartsVirtual WS.xmi created

(8]

Figure 12.26. Generation Completed Dialog

12.4.2. Web Services War Generation

12.4.2.1. Web Services War Generation

Teiid Designer allows you to expose your VDBs via a SOAP or REST interface. JBossWS-CXF or
RESTEasy wars can be generated based on models within your VDBs.

12.4.2.2. Generating a JBossWS-CXF War

The Teiid Designer provides web service generation capabilities in the form of a JBossWS-CXF war.
Once you have added your Web Service Models, as described in New Web Service View Model
section, to your VDB, deployed the VDB to a running JBoss Data Virtualization instance and created
your VDB's data source, you are ready to expose the web service using the generated war.

To generate a new JBossWS-CXF war using the VDB:

1. Right-click on the VDB containing your web service model(s) and select the Modeling >
Generate JBossWS-CXF War action.

L ey

b £ MarketDataView e e ; [ T . Rkl it ML) sl
b i MarketDataView.x
i PortfolioVDB.vdb
7 RestfulBooks Open
v &% indateahleRankewel  Open With

ew > tput.xsd : fPortfolic
'-;'._ delifng al Deﬂﬂ‘ll'
Execute VDB

Figure 12.27.

2. Fill in missing properties in Web Service War Generation Wizard shown below.
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e e

Create Web Service WAR File

Create a WAR file to deploy as a Web Service
Enter the required information, then click OK to create the WAR file. ‘ﬁ

WAR Creation Information

Context Name: PortfoliovDB

Web Server Host: localhost

Web Server Port: 8080

VDB JNDI Name: PortfoliovVDB
Security

When using HTTPBasic security, a local Teiid connection is required using the PassthroughAuthentication property.
(=) None
() HTTPBasic
O WS-Security (Username Token)
_HTTPBasic Options
Realm:

Role:

~ WS-Security Options

Username:

Password:

General Options
"1 Enable MTOM

Target namespace: http://teiid.org

WAR File Save Location: /Users/macuser/WARFiles

@ ( Cancel ) ( OK )

Figure 12.28. Generate a JBossWS-CXF War Web Service Dialog

Table 12.1. Field Descriptions

Field Name Description

Name The name of the generated war file.

Host The server host name (or IP).

Port The server port.

VDB JNDI Name The JNDI connection name to the deployed Teiid
source VDB.
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Field Name Description

Security options ]
o None - no username/password required to

connect to the VDB through the generated
web service.

o HTTP Basic - the specified security realm
and role will be used. The default realm
value is the realm that comes out of the box
with JBoss Data Virtualization (teiid-
security). The role needs to be defined in
the appropriate security mechanism. In the
case of Teiid, use the teiid-security-
roles.properties file. When using
HTTPBasic, a local Teiid connection using
the PassthroughAuthentication property is
required.

o WS-Security - a password callback class will
be generated for you which will validate that
the username/password values you
specified in the war generator dialog are
passed in. This is meant to be a testing
mechanism for your WS-Security enabled
web service and your own security
mechanism should be implemented in this
class. All source code is included in the
generated war along with the compiled
class files.

Target namespace This is the target namespace that will be used in
the generated WSDL and subsequent generated
web service classes.

MTOM (Message Transmission Optimization If selected, MTOM will be enabled for the web

Mechanism) service endpoint(s). You will also need to update
your output schema accordingly by adding the
xmins:xmime="http://www.w3.0rg/2005/05/xmImi
m" schema and adding
type="xs:base64Binary"xmime:expectedContent
Types="application/octet-stream" to the output
element you wish to optimize.

War File Save Location The folder where the generated WAR file should
be saved.

3. Click OK to generate the web service war. When war generation is complete, a confirmation
dialog should appear. Click OK.
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Web Service WAR File Created

@ The WAR file PortfolioVDB was successfully created.

-

OK

Figure 12.29. Generation Completed Dialog

4. Click OK to create relational tables corresponding to your selected view tables and automatically
set the Materialized property to TRUE and the Materialized Table reference value to your newly
generated table.

When finished your view tables will be configured with their new materialized properties and the
corresponding relational tables will be shown in their package diagram.

E 5 a B %

Bfs Package Diagram [=] Table Editor

Figure 12.30. Materialized Table Properties

12.4.2.3. Generating a RESTEasy War

In Teiid Designer, it is also possible to expose your VDBs over REST using a generated RESTEasy
war. Also, if your target virtual model has update, insert and delete SQL defined, you can easily provide
CRUD capabilities via REST. Accepted inputs into the generated REST operations are URI path
parameters, query parameters, and/or XML/JSON. JSON is exposed over a URI that includes "json". For
example, http://{host}: {port}/{war_context}/{model_name}/resource will accept URI
path parameters and/or XML while http://{host}:
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{port}/{war_context}/{model_name}/json/resource will accept URI path parameters and/or
JSON. You can specify query parameters in the target REST procedure's URI property using & as a
delimiter. For example, REST:URI = authors&parmil&parm2.
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1. In a virtual model, add a procedure(s) that returns an XMLLiteral object. The target of your

procedure can be any models in your VDB. Here is an example procedure that selects from a
virtual table (VirtualBooks) and returns the results as an XMLLiteral:

[
]
F <<Procedure=> | <<Base Table>=>
#l rgetBooks \.:J = VirtualBooks
¥ isbn_in : string Z1 ISBN : string(255)
I TITLE : string(255)
<<Procedure ResultSet>> 21 SUBTITLE : string(255)
o g NewProcedureResult £ PUBLISHER : integer
e £ result : XMLLiteral(2147483647) & PUBLISH_YEAR : integer
gy 2 EDITION : integer
2 TYPE : string(255)
& AUTHOR_ID : integer
7l

&4 Transformation Diagram | 5] Table Editor

Transformation Editor | =2 Cursor at (4, 4) By @ A o
CREATE VIRTUAL PROCEDURE
BEGIN

SELECT XMLELEMENT{NAME books, XMLAGG(XMLELEMENT(NAME book, XMLFOREST(RestfulBooks.VirtualBooks.ISBN, RestfulBooks.VirtualBooks.TITLE,
RestfulBooks.VirtualBooks.SUBTITLE, RestfulBooks.VirtualBooks.PUBLISHER, RestfulBooks.VirtualBooks.PUBLISH_YEAR, RestfulBooks.VirtualBooks.EDITION,
RestfulBooks.VirtualBooks.TYPE, RestfulBooks.VirtualBooks. AUTHOR_ID)))) AS result FROM RestfulBooks.VirtualBooks WHERE RestfulBooks.rgetBooks.isbn_in =
RestfulBooks.VirtualBooks.ISBN;

END|

Figure 12.31.

Notice the syntax used to convert the relation table result of the select from VirtualBooks, to an
XMLLiteral.

Here is an example of an update procedure that will insert a row and return an XMLLiteral
object:

=]
#
<<Procedure>> | <<Base Table>>
| rputBook \-:J & VirtualBooks
& isbn_in : string 4 ISBN : string(255)
¥ title_in : string ZI TITLE : string(255)
“ ¥ subtitle_in : string LI SUBTITLE : string(255)
T 9 publisher_in : int 1 PUBLISHER : integer
© ¥ publish_year_in : int 1 PUBLISH_YEAR : integer
& & edition_in : int {21 EDITION : integer
) type_in : string £ TYPE : string(255)
¥ author_id_in : int {8 AUTHOR_ID : integer
<<Procedure ResultSet>>
= NewProcedureResult
A result : XMLLiteral
]

&< Transformation Diagram | ] Table Editor

Transformation Editor

| Cursor at (10, 6) By 8@ A &

kZREATE VIRTUAL PROCEDURE
BEGIN

DECLARE integer VARIABLES.insert_count = 0;

INSERT INTO RestfulBooks.VirtualBooks (RestfulBooks.VirtualBooks.ISBN, RestfulBooks.VirtualBooks. TITLE, RestfulBooks.VirtualBooks.SUBTITLE, RestfulBooks.VirtualBooks.PUBLISHER,
RestfulBooks.VirtualBooks.PUBLISH_YEAR, RestfulBooks.VirtualBooks.EDITION, RestfulBooks.VirtualBooks.TYPE, RestfulBooks.VirtualBooks.AUTHOR_ID) VALUES (RestfulBooks.rputBook.isbn_in,
RestfulBooks.rputBook fitle_in, RestfulBooks.rputBook.subtitle_in, RestfulBooks.rputBook.publisher_in, RestfulBooks.rputBook.publish_year_in, RestfulBooks.rputBook.edition_in,
RestfulBooks.rputBook.type_in, RestfulBooks.rputBook.author _id_in);

VARIABLES.insert_count = VARIABLES.ROWCOQUNT;

IF(VARIABLES.insert_count = 1)

BEGIN

SELECT XMLCOMMENT('Insert was successfull') AS result;

END

ELSE

BEGIN

SELECT XMLCOMMENT('Insert failed!") AS result;

END

END

Figure 12.32.
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The input format for the REST procedure could be URI parameters, an XML/JSON document, or
some combination of both. When using an XML document your root node must be <input> and
the XML nodes must correspond to order of the procedure's input parameters. For example,
here is the input for the above insert procedure:

<input=
<|SEN=0-13-014714-1-99999</ISEN>
<TITLE=The XML Handbook</TITLE=
<SUBTITLE=Updated Edition</SUBTITLE=>
<PUBLISHER>16</PUBLISHER>
<PUBLISH_YEAR=>2000</PUBLISH_YEAR=>
<EDITION=2</EDITION=>
<TYPE=Hardback<,/TYPE=
<AUTHOR_ID=>49</AUTHOR ID=>
<finput=

Figure 12.33. Sample XML Input

When using a JSON document, ensure your values match the order of your procedure input
parameters as well. Here is the input for the above insert procedure:

{

"ISBN": "1-55615-484-4",

“TITLE": “Code Complete”,

"SUBTITLE": A Practical Handbook of Software Construction”,
"PUBLISHER": 5,

"PUBLISH_YEAR": 1993,

"EDITION": 1,

"TYPE": "Hardback",

"AUTHOR_ID": 31

1

Figure 12.34. Sample JSON Input

. Now we need to identify our procedure as REST eligible. To do this we add enable REST
properties for the procedure(s) via the Modeling > Enable context menu option.

New Child «:«:Prmedure ResultSet>> LA
New Sibling > GetCustomerProcResult Rl
New Association > Lsult : XMLLiteral | -
Modeling > » Create Web Service

o
<7 Undo Disable REST for Procedures ~Z = Enale S

& Preview Data for GetCustomerProc

Redo ~Y
Figure 12.35.
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This will enable two new properties in the property tab for all procedures defined in the model.
The two required properties are defined in the table below:

Table 12.2. Required Extended Properties for RESTful Procedures

Property Name Description

Rest Method The HTTP method that will determine the REST
mapping of this procedure. Supported methods
are: GET, PUT, POST and DELETE

URI The resource path to the procedure. For
example, if you use books/{isbn} as your URI
value for a procedure, http://{host}:
{port}/{war_context}/{model_name}/books/123
would execute this procedure and pass 123 in as
a parameter.

Here is what the above example would look like in the Property tab:

{ -}

Descriptinn| B T

Value

rest:Rest Method  GET
rest:URI ~ books/f{isbn}

Property

Figure 12.36.

Note that the generated URI will have the model name included as part of the path, so full URL
would look like this: http://{host}:{port}/{war_context}/{model_name}/books/123. If you wanted a
REST service to return all books, you would write your procedure just as it is above, but remove
the input parameter. The URI property would then just be 'books' (or whatever you want) and the
URL would be http://{host}:{port}/{war_context}/{model_name}/books.

Once you have added all of your procedures along with the required extended properties, be
sure and add the model to your VDB or synchronize if it's already included in the VDB. You will
then need to redeploy the VDB.

IMPORTANT

If you redeploy your VDB during development, you may receive an "Invalid
Session Exception"due to a stale connection obtained for the pool. This can be
corrected by flushing the data source or, alternatively, you could add a test query
to your VDB connection's -ds.xml file. This will insure you get a valid connection
after redeploying your VDB. The syntax for the test query is as follows: <check-
valid-connection-sqgl>some arbitrary sql</check-valid-connection-sgl>"

. If you have not already done so, you will need to create a data source for your VDB. This can be

done in the Server view of Designer. Right-click on your deployed VDB and selectCreate
Data Source. The Generate REST WAR dialog will ask you for the JNDI name for your
created source so that it can connect to your VDB.
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4. Right-click on the VDB containing your virtual model(s) with REST eligible procedures and select
the Modeling > Generate RESTEasy War action. If there are no procedures that are REST
eligible, the "Generate RESTEasy War" option will not be enabled.

g MY>SUL BODKS.XITI i [BUOKSRED I WEDZ

2 1 Deploy

Open
Open With

& Execute VDB
Generate |BossWS-CXF War

[EECT g ¥ T

Figure 12.37.

*; Generate RESTEasy War

5. Fill in missing properties in the REST War Generation Wizard shown below.

w Create REST WAR File X
Create a REST WAR file to deploy as a REST Web Service
Enter the required information, then click OK to create the WAR file. ‘@

‘REST WAR Creation Information

Context Name: [BooksREST

VDB JNDI Name:

|{REPLACE_WITH_VDB_JNDI_NAME} |

REST WAR File Save Location: |,fh0me,ftejr_:-nes,FRuntim&kaspacestARFiles ‘

Change...

®@

= Include RESTEasy Jars in lib Folder of WAR

Restore Default|

Cancel | | OK |

Figure 12.38. Generate a REST WAR War File Dialog

Table 12.3. Field Descriptions

Field Name Description

Name

Connection JNDI Name

War File Save Location

Include RESTEasy Jars in lib Folder of WAR

The name of the generated war file.

The JNDI connection name to the deployed Teiid
source VDB.

The folder where the generated WAR file should
be saved.

If selected, the RESTEasy jars and there
dependent jars will be included in the lib folder of
the generated WAR. If not selected, the jars will
not be included. This should be cleared in
environments where RESTEasy is installed in
the classpath of the server installation to avoid
conflicts.
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Field Name Description

6. Click OK to generate the REST war. When war generation is complete, a confirmation dialog
appears. Click OK.

w REST WAR File Created x

The REST WAR file BooksREST was successfully created.

OK

Figure 12.39. Generation Completed Dialog

12.4.2.4. Deploying Your Generated WAR File

Once you have generated your war file, you will need to deploy it to your JBoss AS instance. There are a
few ways to accomplish this.

From JBDS or JBoss Tools

1. Insure target JBossAS is configured and running.

2. Select your WAR file in the Model Explorer view. If you did not generate your war to that
location, you can copy and paste it there.

3. Right-click on the WAR file and select Mark as Deployable. This will cause you WAR file to
be automatically deployed the JBoss AS instance you have defined.
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~ =% SoapyBooksProject
A Booksws.vdb % Dynamic Web Project
New
b £} MySqlBooks_C
Open
b £3 MySqlBooks_C Open With >
b G MySqlBooks W ~
=| Copy
b C§ MysqlBooks.xi Pacte e
b 5 test Delete
b % US_States Refactor >
gig Import... |
3 Export... |
# | Refresh ]
~q Mark as Deployable _I
Validate

Figure 12.40.

Using the JBoss AS Administration Console

1. Using the administration console that comes with JBoss AS, you can deploy WAR files. The
administration console is available at http://{host:port}/admin-console. Once logged on, use the
Add a New Resource button of the Web Application (WAR) resource folder.

Manual Deployment to JBossAS

1. Itis possible to deploy the generated WAR by manually copying the file to the deploy folder of
the target JBoss AS. If the server is running, the WAR will deploy automatically via hot deploy.
Otherwise, the WAR will deploy at the next start of the server.

12.4.2.5. Testing Your Generated WAR Files

Once you have deployed your war file, you are ready to test it out. There are a few ways to accomplish
this.

SOAP WAR Testing

Determining Your WSDL URL

You can get your WSDL URL at http://{server:port}/joossws/services. This is where all the deployed
web services for the target JBossAS server will be listed. Find your service and click the Endpoint
Address link. This will retrieve your web service's WSDL and the WSDL URL address will appear in
the browser's address bar.
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Endpoint Name jbossws:context=books endpoint=My5qlBooks_BOOKS
Endpoint Address  http:/f127.0.0.1:8080/books/My5SqlBooks _BOOKS

StartTime StopTime
Mon Jun 11 15:16:02 COT 2012
RequestCount ResponseCount FaultCount
0 0 0
MinProcessingTime MaxProcessingTime AvgProcessingTime
0 0 0

Figure 12.41.

Now that you have your WSDL URL, you can use any SOAP testing tool such as the Web Service
Tester that comes with JBDS and JBoss Tools or an external tool like soapUl.

Using the JBoss AS Administration Console

Using the administration console that comes with JBoss AS, you can deploy WAR files. The
administration console is available at http://{host:port}/admin-console. Once logged on, simply use the
"Add a New Resource" button of the "Web Application (WAR)" resource folder.

REST WAR Testing

What is my URI?

198

When you modeled your REST procedures, you assigned a URI for each HTTP Operation you
defined along with the corresponding operation (GET, PUT, POST or DELETE). The full path of each
URI is defined as /{war_context}/{model_name}/{resource} for XML input/output and
Hwar_context}/{model_name}/json/{resource} for JSON input/output.

Using your REST URL, you can use any testing tool with REST support such as the Web Service
Tester included with JBDS and JBoss Tools or an external tool like soapUl or cURL.
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CHAPTER 13. EDITING MODELS AND PROJECTS

13.1. EDITING MODELS AND PROJECTS

Teiid Designer offers three basic model edit actions: Rename, Move and Save As... and one project
related action, Clone Project.

13.2. RENAME A MODEL
To rename a model in your workspace:

1. Select a model in the Model Explorer view.

2. Right-click select the Refactor > Rename action.

—_— T ra ¥ —_— e

- 5:_—15 AllCustomerAccounts

» @ Northwind.xmi
> =% BooksProject
[+ =% PartsProject
[» =% WSDLImportProje

New ?
New Child >
Maodeling >

Open
Open With >

Copy
[ Paste Ctrl+v

Paste Special... Ctrl+

Delete

R o Unda

Redo

E=g Import...

Export..

e
Mamespace LRI
@ Refresh Maove

Figure 13.1. Refactor Rename Action In Model Explorer

3. Specify unique model name in the Rename Model File dialog. Click OK.
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Rename Model File

Enter new name: [AIIEustamers ]

@ Cancel ] [ oK ]

Figure 13.2. Rename Model File Dialog

NOTE

Renaming a model that is a dependency to another model will automatically change the
model imports for those models. If source model CustomerSource is renamed to
OldCustomerSource, for instance, the import statement for the view model
CustomerAccounts which imports CustomerSource will be changed to reflect the new
name.

13.3. MOVE MODEL
To move a model in your workspace:

1. Select a model in the Model Explorer view.

2. Right-click select the Refactor > Move action.
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vy QAIICustnmemcmunts
= Sources
3 ifr' Morthwind. xmi New >
b =% BooksProject MNew Child >
b 2% PartsProject Modeling >
b =% WSDLImportProject
Open
Open With >
Copy
Paste Ctrl+v
Paste Special... Ctrl+Y
Delete
Heractin Undo
Redo
Exy Import
ﬁ Export... Rename
Mamespace LRI
2 Refresh

Figure 13.3. Refactor Move Action In Model Explorer

3. Select a new location (that is, Project or Folder) and click OK.

Move Northwind.xmi

Select the mowve destination:

~ '@-AIICustumerﬁ.ccuunts
[* g Morthwind. xmi

[» =% BooksProject

[» =% PartsProject

[» =% WSDLImportProject

@ Cancel oK

Figure 13.4. Move Model Dialog

13.4. SAVE COPY OF MODEL

The Save As. .. action performs a similar function as the Refactor > Rename action except the
renamed model is a structural copy of the original model.
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NOTE

Each model object maintains its own unique ID, so copying a model will result in a exact
structural copy of your original model but with regenerated unique object IDs. Be aware
that locating and copying your models via your local file system may result in runtime
errors within Teiid Designer. Each model is expected to be unique and duplicate models
are not permitted.

To create a duplicate model using Save As...:

1. Open the model you wish to copy in a Model Editor by double-clicking the model in Model
Explorer view or right-click and click Open action.

2. Select the editor tab for the model you opened.

Figure 13.5. Select Editor Tab

3. Click File > Save As... action to open theSave Model As dialog.
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Save Model As

Select a destination for the copy

* B AllCustomerAccounts
[* g Morthwind. xmi
= Sources
[» =% BooksProject
[» =% PartsProject
[» =% WSDLImportProject

Enter the new model name

Northwind West]

Ready to copy

@

Cancel

8].4

Figure 13.6. Save Model As Dialog

4. Enter a unique model name in the new model name text field and click OK.

5. If dependent models are detected, the Save Model As - Import References dialog is
presented to give you the opportunity to change any of the dependent models imports to

reference the new model or not.
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Save Model As - Import References

The following model files use or reference the model to be copied.

Select any that should be modified to use the new copy

3% AllCustomerAccounts/Customeryiews. xmi

| Select All || Deselect All

@ Cancel | | ok |

Figure 13.7. Save Model As Dialog

13.5. CLONE PROJECT

Because each instance of a model contains a unique ID and each object in each model contains a
unique ID, copying a project is a delicate task. For this reason, the Clone Project action was created
to manage the creation of exact structural copies of all models in the source project.

The following lists specific rules and limitations for this action.

e This action clones a complete model project containing any number of model (XMl or XSD) files
organized in a user defined directory structure.

e All object references (UUIDs) within the original project will be replaced with new unique
references.

e Any model dependencies or internal object references are refactored to reflect the dependencies
within the cloned project.

e Any model references to models in projects external to the original project will NOT be replaced.

e Only XMI and XSD files are cloned. All other file types in your project will NOT be processed nor
copied into your newly cloned project including VDBs.

e If one or more editors that require save are open, the user will be asked to save them before
continuing with the cloning process.

To clone a model project:
1. Select an existing model project in the Model Explorer view.
2. Right-click, then select Model Project > Clone in the context menu. Otherwise you can

select the Project > Clone Project action located in the Teiid Designer's main menu bar.
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ﬂetadata Bun Window Help

Open Project

Close Project

oo Build All Ctrl+B
Build Project
Build Working Set >
Clean...

Build Automatically

- Clone Project

‘= Build Project Imports
Build All Imports

]

Build Packages

""PEEI Validate Model Transformations

Properties

Figure 13.8. Clone Project In Project Menu

3. Onthe Clone Project wizard page, provide a name for your new project.
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Clone Model Project

Clone Model Project .
Specify cloned model project name. B

Project name: |ValuedCustomerAccounts

Use default location

Location: | /home/blafond/Test Designer Folder/T | Browse...

-

Choose file system: | default

® Cancel Bnish

Figure 13.9. Clone Project In Project Menu

4. (Optional) If you wish to create your cloned project in a location other than your default
workspace location, clear the Use default location checkbox and specify (type in or
browse to) a new directory location on your local file system.

5. Click Finish to generate your new project.

206



CHAPTER 14. MANAGING YOUR VIRTUAL DATABASES

CHAPTER 14. MANAGING YOUR VIRTUAL DATABASES

14.1. CREATE A VIRTUAL DATABASE

Procedure 14.1. Create a Virtual Database

1. Launch Red Hat JBoss Developer Studio's New wizard.

2. Open the Teiid Designer category directory and select Teiid VDB.

NOTE

You can also select one or more models in a model project. To do so right-click
and select New - Teiid VDB action.

Launching this wizard will open the New VDB dialog. If you launched with one or more models
selected the dialog will contain the pre-selected models for inclusion in the new VDB.

NOTE

A VDB is scoped to be aware of models and files within the same model project
as the VDB. You will not be allowed to add models to a VDB that exist in a
different project.

14.2. EDIT A VIRTUAL DATABASE

Procedure 14.2. Edit an Existing Virtual Database

1. Select the VDB you want to edit in the Explorer.
2. Right-click and select the Open action. (You could also double-click it.)

The VDB will then open in the Editor.

14.3. MULTI-SOURCE BINDING SUPPORT
Teiid Designer allows you to define relational source models and binding them to multiple data sources.

Use Multi-source models to quickly access data in multiple sources with homogeneous metadata. When
you have multiple instances using identical schema, Red Hat JBoss Data Virtualization can help you
gather data across all the instances, using "multi-source" models. In this scenario, instead of
creating/importing a model for every data source, one source model is defined to represents the schema
and is configured with multiple data "sources" underneath it. During runtime when a query issued against
this model, the query engine analyzes the information and gathers the required data from all sources
configured and gathers the results and provides in a single result. Since all sources utilize the same
physical metadata, this feature is most appropriate for accessing the same source type with multiple
instances.

The VDB Editor's Models tab contains a simplified model table on the left and a new tabbed panel on
the right containing Model Details and Source Binding Definition tabs. Click the Multi-
source check box if you wish to add additional source bindings.
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NOTE

Note that each binding must be defined with a unique source name as well as unique
JNDI name representing a deployed data source you your server.

14.4. USER-DEFINED FUNCTIONS SUPPORT

In Teiid Designer you can create, manage and use User-Defined Functions (UDFs). These functions
allow you to perform simple or complex Java operations on your data during runtime. This is
accomplished by deploying your custom UDF jars on your server and creating a scalar function
representation of your function method to use in your view transformation. In the VDB Editor, you have
the option of including your UDF jars as part of the VDB artifact. If included in the VDB, the jars will
automatically be deployed to the server for you when the VDB is deployed.

When a UDF model is added to a VDB, each scalar function is interrogated and its referenced UDF jar
(if available) is added to the VDB as well as shown in the UDF Jars tab in the editor

14.5. REUSING VIRTUAL DATABASES

You can treat your deployed VDB as just another database where the database category is your VDB
name and each visible model in your VDB is treated as a schema. This is accomplished via a import-vdb
XML element in the vdb . xm1 definition. By allowing VDB's to referenced other VDBs, users can create
reusable database components and reduce the amount of modeling required to create complex
transformations.

This sample vdb . xm1 file highlights the import-vdb element and the corresponding import-vdb-reference
within the view model's model element:

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<vdb version="1" name="PartssupplierViewsVDB'">
<property value="false" name="preview"/>
<import-vdb import-data-policies="false" version="1"
name="PartssupplierSourcesVDB"/>
<model visible="true" type="VIRTUAL" name="PartsViewModel"
path="/PartssupplierProject/PartsViewModel.xmi">
<property value="1623826484" name="checksum"/>
<property value="Relational" name="modelClass'"/>
<property value="false" name="builtIn"/>
<property value="655076658.INDEX" name="indexName"/>
<property value="PartssupplierSourcesVDB" name="import-vdb-
reference"/>
</model>
</vdb>

Teiid Designer exposes this capability by allowing users to import metadata from deployed VDBs via the
JDBC Import option. Through this import, relational VDB source models are created which structurally
represent the Catalog (VDB), Schema (Model) and Tables in Virtual DataBase.

When dealing with the these VDB source models there are some limitations or rules, namely:

e VDB source models are read-only

e VDB source model name is determined by the deployed model name (schema) from the VDB it
was imported from
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e Model names have to be unique within a model project

e VDB source models have to be imported/created in a project different than the project used to
create and deploy the Reuse VDB

e The JDBC Import Wizard will restrict your options to comply with these rules

14.6. CREATE A VDB SOURCE MODEL

Procedure 14.3. Create a VDB Source Model

1. Deploy your VDB.

2. Launch the JDBC Import Wizard by clicking Import - Teiid Designer - JDBC Database
Source Model.

3. On the first page of the wizard select a valid connection profile for your deployed VDB.

The wizard will detect that the connection profile is a Teiid VDB connection and a section will be
displayed on the wizard page titled Teiid VDB Source Options.

NOTE

If Import as VDB source modelis NOT checked, then the wizard will
continue importing as a normal JDBC import

4. Onthe Select Database Objects page, select a single schema to use in order to create as
VDB source model.

5. The final page shows the name of the resulting VDB source model. The name is NOT editable.

NOTE

All other options are disabled

NOTE

The target Into Folder must NOT contain a model with the same name or the
Finish button will be disabled.

NOTE

You can use your VDB source model like any other source model in your project.
VDB source model tables can be used in your transformation queries and the
view models will contain model imports to your VDB source models. However,
when your view model is added to a VDB, any referenced VDB source models do
NOT get added to your VDB. Instead, an import-vdb element reference is added
in its place.

If VDB imports exist for a VDB, the Show Import VDBs button will be enabled and allow
viewing the names of the imported VDBs as shown below.
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14.7. SECURITY AND DATA ACCESS

You have some options on defining your data access security for your VDB via the VDB Editor.
The first level is provided by the model visibility check-box in the Models section (Spyglass column). If
unchecked, that model and its contents will not be returned by the Teiid runtime with the standard JDBC
metadata.
The next level of security is provided defining permissions for your data roles which can be managed via
the lower panel in the VDB Editor. For a unique data role, each model and most objects within that model
can have specific values of data access including the following:

e Security (Row-based condition and column masking)

e Create

e Read

e Update

e Delete

e Execute

e Alter

Double-clicking the Security box for a table or column will launch the Model Object Security
Definition dialog where you can define applicable values. In order to edit or remove security, select
the Conditions or Masking tabs and use the Edit or Remove buttons.

The Conditions and Masks tabs in the Permissions section allow you to manage (add, remove and
edit) these values for your model objects.
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CHAPTER 15. TESTING YOUR MODELS

15.1. MANAGE CONNECTION PROFILES

15.1.1. Manage Connection Profiles

As described earlier, you can test your models in Teiid Designer by using the Preview Data action

H’ or test your models via your deployable VDB.

Teiid Designer utilizes the Eclipse Data Tools Platform (DTP) Connection Profile framework for
connection management. Connection Profiles provide a mechanism to connect to JDBC and non-JDBC
sources to access metadata for constructing metadata source models. Teiid Designer also provides a
custom Teiid connection profile template designed as a JDBC source to a deployed VDB.

By selecting various Teiid Designer Import options, any applicable Connection Profiles you have defined
in your Database Development perspective will be available to use as your import source. From these
import wizards you can also create new connection profiles or edit existing connection profiles without
leaving the wizard.

The Server view provides access to running Teiid instances and shows data source and VDB artifacts
deployed there. The Create Data Source action available on this view utilizes the available and
applicable connection profiles.

15.1.2. Set Connection Profile for Source Model

Teiid Designer integrates Data Tools Connection Profiles by persisting pertinent connection information
in each source model. This can occur through Importing process or through the Modeling > Set
Connection Profile action.

15.1.3. View Connection Profile for Source Model

In addition to setting the connection profile on a source model you can also view a source model's
connection profile information via the Modeling > View Connection Info action which displays
the detailed properties of the connection.
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Model Connection Info

AInfo

The properties in the table below are currently stored in the source model:

PartsSourceB.xmi

Properties
name value
connectionProfileDescription
connectionProfileCategory org.eclipse. datatools. connectivity db. category
connectionProfileProviderld org.eclipse.datatools. enablement. oracle. connectionProfile
connection-url jdbc:oracle:thin: @englxdbs1l. mm. atl2. redhat. com:1521:ORCL
connectionProfileMame PartsOraclell
connectionProfilelnstancelD org.eclipse.datatools. enablement. oracle. connectionProfile
driver-class oracle.jdbc. OracleDriver
translator name oracle
user-name partssupplier

cancel || ok |

Figure 15.1. Connection Profile Information Dialog

NOTE

If a source model has no associated connection profile the following dialog will be
displayed.

Mo Connection Info Available

Use Modeling > Set Connection Profile action to select and apply connection

@ Mo connection info stored in model RelModel&. xmi.
- info to model.

Figure 15.2. No Connection Info Dialog

15.1.4. Remove Connection Profile from Source Model

As a user, you may not want this connection information (i.e. URL, username, etc...) shared through your
VDB. Designer provides a means to remove this connection information via a Modeling > Remove
Connection Info action. When adding a source model without connection information will require the
user to supply or select the correct translator type.

15.2. PREVIEWING DATA FOR A MODEL
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15.2.1. Previewing Data For a Model

Designing and working with data is often much easier when you can see the information you're working
with. The Teiid Designer's Preview Data feature makes this possible and allows you to instantly preview
the information described by any object, whether it's a physical table or a virtual view. In other words, you
can test the views with actual data by simply selecting the table, view, procedure or XML document.
Previewing information is a fast and easy way to sample the data. Of course, to run more complicated
queries like what your application likely uses, simply execute the VDB Via DTP and type in any query or
SQL statement.

After creating your models, you can test them by using the Preview Data action H’ . By selecting a
desired table object and executing the action, the results of a simple query will be displayed in the
Preview Results view. This action is accessible throughout the Teiid Designer in various view
toolbars and context menus.

There are two requirements for previewing your data:
1. The selected object must be one of several previewable model object types.
2. All source models within the model dependency tree must reference a connection profile.

Model objects that can be previewed include: relational tables and views (including tables involving
access patterns), relational procedures, Web service operations and XML document staging tables.

NOTE

any virtual table, view or procedure is previewable as long as all physical source models
reference sufficient connection info.

After clicking the Preview Data action, Teiid Designer will insure that all source models are
associated with connection profiles and that all required passwords are set.

If the model selected for preview is a source model and there is insufficient connection info for that
model, the following dialog will be displayed and the action terminated.

Preview Not Available

Preview not available for model >> ProductsSQLServer.xmi

Use "Modeling = Set Connection Profile" action first, then retry

Figure 15.3. Preview Not Available

If any of the source models in the corresponding project require a password that cannot be retrieved from
an existing connection profile, the user will be queried for each missing password.
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Missing Password Required

Preview data requires password for model >=> Products.xmi
Referenced connection profile == AllProducts

Password: [***ﬂ ]

Cancel | l oK I

Figure 15.4. Missing Password

Testing Your Transformations
When editing transformation SQL in the Transformation Editor, a special SQL Results data action is

provided in the editor toolbar E . You can change your transformation SQL, re-validate and preview
your the data for your modified SQL. The following sections provide steps for previewing your data. Note
that all steps assume that all source models referenced by your models, either directly or through
dependencies, are bound to connector bindings.

15.2.2. Preview Relational Table or View

To preview a relational table, relational view or staging table:
1. Select a relational table or view in the Model Explorer view or diagram. The table or view can be

in a view model as well as a source model. Staging tables are not visible in the Model Explorer
view, so you need to open the mapping diagram and select it there.

2. Right-click select the Preview Data action H’ . You can also select the same action in the
toolbar of either the Model Explorer view or diagram.

3. Your query results will be displayed in the Preview Results view. The view will automatically
open or get focus if not visible in your perspective.

15.2.3. Preview Relational Table With Access Pattern

To preview a relational table or view with access pattern:

1. Select a relational table or view in the Model Explorer view or diagram that contains an access
pattern. The table or view can be in a view model as well as a source model.

2. Right-click select the Preview Data action H’ . You can also select the same action in the
toolbar of either the Model Explorer view or diagram.

3. A column input dialog is presented. Select each access pattern and enter a value for each
required column.

NOTE

If data entered does not match the column datatype (String, integer, etc...), an
error message will be displayed in the dialog header.
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When all required values are entered, click the OK button to execute the query.

Preview Data

To preview data from this table, select an access pattern and provide a value for each required column.

All access pattern column walues are sek, Select OK to continue,

Access Patterns -~ Required Columns -
Al NameandID PUELISHER_ID : long | 20022
MAME : string(255) | riFlin|

Ok | Cancel

Figure 15.5. Access Pattern Column Input Dialog
4. Your query results will be displayed in the Preview Results view. The view will automatically

open or get focus if not visible in your perspective.

15.2.4. Preview Relational Procedure
To preview a relational procedure:

1. Select a relational procedure in the Model Explorer view or diagram. The procedure can be in a
view model as well as a source model.

2. Right-click select the Preview Data action H’ . You can also select the same action in the
toolbar of either the Model Explorer view or diagram.

3. An input parameter input dialog is presented. Enter a valid value for each parameter.

NOTE

If data entered does not match the parameter datatype (String, integer, etc...), an
error message will be displayed in the dialog header.

When all required values are entered, click the OK button to execute the query.
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Preview Data

To execute this procedure, input values are required.

all parameter walues are sek, Select QK to continue,

Input Parameters

calorIn : string | blue

Cancel

Figure 15.6. Procedure Parameter Input Dialog

4. Your query results will be displayed in the Preview Results view. The view will automatically
open or get focus if not visible in your perspective.

15.2.5. Preview Web Service Operation

To preview a Web service operation:

1. Select a Web service operation in the Model Explorer view or diagram. The operation can be in
a view model as well as a source model.

2. Right-click select the Preview Data action H’ . You can also select the same action in the
toolbar of either the Model Explorer view or diagram.

3. An input parameter input dialog is presented. Enter a valid value for each parameter.

NOTE

If data entered does not match the parameter datatype (String, integer, etc...), an
error message will be displayed in the dialog header.

When all required values are entered, click the OK button to execute the query.
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n Preview Data

To execute this procedure, input values are required.

all parameter values are set, Select OF to continue,

~Input Parameters 1

AUTHOR_ID ¢ xs:long i 1II|II|22|

CIE, Zancel

Figure 15.7. Procedure Parameter Input Dialog

4. Your query results will be displayed in the Preview Results view. The view will automatically
open or get focus if not visible in your perspective.

15.2.6. Sample SQL Results for Preview Data
Preview Data results are displayed in the Eclipse Datatools SQL Results view as shown below.
' NOTE

There are a number of display preference and filter options for this view via toolbar
buttons and the drop-down menu.

e
B_l‘ Problems @Message Leg [ | SCOL Results F3 % & E 3=:=> - =8
['ﬁ,.rpe query expression here ] INSTR_ID NAME TYPE ISSUER EXCHANGE
Status ~ Operation | Date Connection Profile 1 PRD01088 Movell Incorporated Stock 1 NasdagNM
-« Succee select * from Aug 28, 201C Transient org.teiid.d 2 PRD01089 | Amazon.com, Incorporated Stock ;2 NasdagNM
v Succee select * fram Aug 28, 201C Transient org.teiid.d 3 PRDO1020 : Juniper Metworks, Incorporated | Stock | 3 NasdagNM
4 PRDO1091 ; Red Hat. Incerporated Stock ;4 NasdagNM
5 PRDOL092 | Boston Scientific Corporation Stock {5 NYSE
[ PRDO1093 | Inex Pharmaceuticals, Incorpora Stock |1 Toronto
i PRDO1094 ; Pfizer, Inc. Stock 2 NasdaghM
PRDO1095 ;| Cytovax Biotechnologies Incorpc Stock | 3 Toronto
9 PRDO1096 | Commonwealth Biotechnologies! Stock | 4 NasdagsSC
10 :{ PRDO1097 : British Biotechnology plc Stock 5 NasdaghM
11 : PRDO1220 : Unisys Corporation Stock : NULL NYSE
12 { PRD0O1099 | Honeywell International Stock |2 NYSE
13 { PRDO1100 : Hilton Hotels Corparation Stock (3 NYSE
14 : PRDO110L : Hilton Hotels Corporation Corpors 4 NYSE
15 : PRDO1102 ;| Mercury Interactive Corporation | Stock | 5 NasdaghM
16 { PRD01103 | FAdelity Freedom Income Fund Mutual | 1 NasdaqsC ™
N I N TP e [PV [P bl
[ — DL B

Figure 15.8. SQL Results View

15.2.7. Execution Plans
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When Preview Data is executed, the Teiid Execution Plan is also displayed as shown below. The
Execution Plan may also be obtained by right-clicking on a previewable object, then selecting Modeling
> Show Execution Plan in the context menu.

£1 SQL Results | ¢/ Teiid Execution Plan &3

Preview Data for : myTbl
SQL
select * from "vModel"."myTbl"

Execution Plan

Text | Plan Tree

<7xml version="1.0" encoding="UTF-8" standalone="yes"?>
<node name="AccessNode"=>
<property name="0utput Columns">

<value=>INTKEY (integer)</value>
<value=>STRINGKEY (string)</value>
<value>INTNUM (integer)</value>
<value=STRINGNUM (string)</value>
<value>FLOATNUM (double)</value>
<value=LONGNUM (long)</value=
<value>DOUBLENUM (double)</value=

=vrnliiaw OVTER IR Thindacimall = Aol

Figure 15.9. Teiid Execution Plan View

15.3. TESTING WITH YOUR VDB

15.3.1. Testing With Your VDB

In Teiid Designer you can execute a VDB to test/query actual data.
The requirements for VDB execution are:
e A deployed VDB backed by valid deployed Data Sources
e Aninstance of a Teiid Connection Profile configured for the deployed VDB

Teiid Designer simplifies this process via Deploy VDB and Execute VDB actions. Deploy VDB does just
that, deploy a selected VDB to a running Teiid instance. Execute VDB performs the VDB deployment,
creates a Teiid Connection Profile, opens the Database Development perspective and creates a
connection to your VDB.

15.3.2. Creating Data Sources

The mechanism by which VDBs are able to query actual data sources is the Data Source. These are
deployed configurations backed by database or source connection jars. Each source model referenced
within a VDB requires a JNDI name representing a deployed Data Source.

When creating VDBs you do not need to have deployed data sources on your JBoss Data Virtualization
server, but if you wish to test your VDB, the data sources need to be present.

Teiid Designer provides a Create Data Source action so you can create compatible data sources for
your source model. If you wish to create a data source for a specific model you can select that source
model in your workspace and select the Modeling > Create Data Source action. This will extract
the connection profile data from your source model and create a corresponding data source on your
default JBoss Data Virtualization server.
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You can also create data sources from the Server view. Select a JBoss Data Virtualization server

instance in the Server view and right-click select the Create Data Source action. This will launch the
Create Data Source dialog.

Create Data Source

Create Data Source

All inputs are valid. Select FAnish to create data source.

Teiid Server: mm:/flocalhost 31443

Name | BooksDB2 | |

Connection Source

[ ] Use Model Connection Info

Model

Use Connection Profile Info

Connection Profile | gooksDa?

S | [New... | |Edit.|

-Connection Properties

Mame Value

password ok

user-name books

connection-url jdbc:db2: //db000255. org. mydbs.com :50000
driver-class com.ibm.db2. jcc. DB2Driver

@ Cancel H Fnish |

Figure 15.10. Create Data Source Dialog

You can either select and existing Connection Profile from the drop-down list (Use Connection Profile

Info option) or check the Use Model Info option and select an existing source model containing
connection info.

After creating your new data source it should now be shown in the Data Sources folder of the
corresponding JBoss Data Virtualization server.

15.3.3. Execute VDB from Model Explorer
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If you have a JBoss Data Virtualization instance defined and connected in your Server view you can:

1. Right-click a VDB in your Model Explorer select Modeling > Execute VDB action. This action

will insure your selected VDB is deployed to JBoss Data Virtualization, create a Teiid
Connection Profile specific for that VDB, open the Database Development perspective and
create a connection to your VDB.

i ﬁ PartsProject
[+ = data
= readme

Modeling > ﬁ Deploy

*{ Execute VDB

Open
Open With >

Generate |BossWS-CXF War

Figure 15.11. Execute VDB Action

. Select your new Teiid connection profile and right-click select Open SQL Scrapbook, enter

your designer SQL (i.e. SELECT * FROM TableXXXX), select all text and right-click select
Execute Selected Text.

. [J Parts.vdb W =8

Type: [Teiid_?.l o] l Name: [Par‘ts - Teiid Connectii & | Database: Status: Connected, Auto Con

runnectian profile

SELECT * FROM PartsSourceA.PartsI

Figure 15.12. SQL Scrapbook Editor

. Results of query should be displayed in the SQL Results view on the Result1 tab.

= sQL Results 52 R % ¥ T 0

['ﬁ_.!pe query expression here

Status Operation Date Connection Profile

" Succee SELECT * FROM PartsSourceA Parts Oct 15, 2010 Parts - Teiid Connection

[2]
PART ID PART_NAME PART_COLOR PART WEIGHT
FRREET ! Bolt ! Green f12
3 {P302 | Screw  Blue f13
4 ip3os | Bolt | Green P17
5 P304 { cam ! Green f18

Figure 15.13. SQL Results View

15.3.4. Deploy VDB from Model Explorer
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You can also deploy your VDB first by selecting it in the Model Explorer and dragging/dropping it onto a
connected JBoss Data Virtualization instance in the Server view, or right-click select Modeling >
Deploy action.

Once deployed, you can select the VDB in the Server view and right-click select the Execute VDB

action there. This will create a Teiid Connection Profile specific for that VDB, open the Database
Development perspective and create a connection to your VDB. Continue with Step's 2 and 3 above.

NOTE
If you do not have a JBoss Data Virtualization instance defined or your default JBoss Data
Virtualization instance is disconnected, the following dialog will be displayed if the

Modeling > Deploy action is launched.

-
No Teiid Instance IEIW

There is no connected default Teiid instance available.

Create new Teiid instance or reconnect to existing Teiid and retry Deploy VDB.

oK

Figure 15.14. No Teiid Instance Defined

15.3.5. Executing a Deployed VDB

To execute a VDB, that's been deployed manually, follow the steps below:
1. Open the Database Development perspective.

2. Select the Database Connections folder and choose the New action to display the New
Connection Profile dialog.
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New Connection Profile

Connection Profile

Create a Teiid connection profile. r

~-Connection Profile Types:

[type filker text

B Ingres
E4 MaxDB
ModeShape
B4 mysaL
& oracle
@ PostgresQL
@ SOL Server
£ salLite
E4 Sybase ASA
£ sybase ASE

Mame:

[>) ]

a

IF’rnducts |

Description loptional):

| l

@ < Back . MNext = Cancel l I Enish

Figure 15.15. New Connection Profile Dialog
3. Enter unique name for your profile, select an existing connection profile type and hit Next.
4. Inthe Teiid Profile Wizard page, selectthe New Driver Definition button to locate

and select the Teiid client jar on your file system. Configure your URL using your VDB Name,
Host, Port, Username (default = admin) and Password (default = teiid).
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Specify a Driver and Connection Details

connection.

Select a driver from the drop-down and provide login details for the r

Drivers: [Tei.i.d Server |DBC Driver

-Properties

General | Optional

YDBE Mame

[Prnducts

Host

[Incalhnst

Part

[31nuu

Username

[admin

Password

(eseee

[ ] S5L Connection

iSave password

b

Connect when the wizard completes

[[] Connect every time the workbench is started

Test Connection

@ = Back ” Mext =

Cancel Einish

Figure 15.16. Teiid Connection Profile Dialog

5. Select Next to view a summary of your new Teiid Connection Profile.
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Teiid Profile Wizard

summary -q}
Information gathered from previous pages. r

Property Value

MName Products

Description

Auto connect at startup false

Auto connect on finish true

Database Products

Host localhost

Port 31000

Username admin

SSL protocaol false

Save password true

LURL jdbc:teiid: Products@mm:/flocalhost: 31000

@ l Next = | | Cancel | | Bnish

Figure 15.17. Teiid Connection Profile Summary

6. Select Finish.

7. Select your new Teiid connection profile and right-click select Open SQL Scrapbook, enter
your designer SQL (i.e. SELECT * FROM TableXXXX), select all text and right-click select
Execute Selected Text.

(1 Parts.vdb W

=8

Tpe: | Teiid_7.1

C l Name: [Parts - Teiid Connectii & | Database: Status: Connected, Auto Con

ronnection profile

SELECT * FROM PartsSourceA.PartsI

Figure 15.18. SQL Scrapbook Editor
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CHAPTER 16. SEARCHING

16.1. SEARCHING

Designer provides multiple search actions located via Teiid Designer submenu in Eclipses Search menu.

The individual actions in the Teiid Designer submenu are described below:

e Transformations... - Launches the Transformation Search dialog. User can search models

in the workspace for matching SQL text. Search results appear in the dialog and user can select
and view SQL as well as open desired transformations for editing.

Metadata... - Launches the Search dialog. User can search for models in the workspace by
specifying an Object Type, and/or a Data Type, and/or a property value. Search results appear
in the Search Results view, and double clicking a result will open that model in the appropriate
editor.

Find Model Object - Launches the Find Model Object dialog, which can be used to find an
object in the workspace by specifying all or part of its name. Selecting the object will open it in
the appropriate editor.

16.2. FINDING MODEL OBJECTS

The Teiid Designer provides a name based search capability to quickly locate and display model

objects.

To find a model object:

1. Open the Find Model Object dialog by either selecting the action on the main Teiid Designer

toolbar or select the same action via the main menu's Search > Find Model Object action.

2. Begin typing a word or partial word in the Type Object Name field. Wild card (*) characters will

be honored. As you type, the objects which match the desired name will be displayed in the
Matching Model Objects list. If there are more than one objects with the same name, the
locations or paths of the objects are displayed in the Locations list.

If more than one object exists with the desired name, select the one of the locations.

. Click OK. If editor is not open for the object's model, an editor will open. The desired object

results in a diagram (if applicable) and selected.

16.3. SEARCH TRANSFORMATION SQL

The Teiid Designer provides a search capability to string values present in transformation SQL text.

To search for string values in your transformations SQL:

1.

Click search > Transformations. .. action on the Teiid Designer main menu which
opens the Search Transformations dialog.

. Specify a string segment in the Find: field and specify/change your case sensitive preference.

. Select Perform Search button. Any transformation object containing SQL text which contains

occurrences of your string will be displayed in the results section.

225



User Guide Volume 1: Teiid Designer

You can select individual objects and view the SQL. If a table or view supports updates and there is
insert, update or delete SQL present, you can expand the object and select the individual SQL type as
shown below.

If you wish to view the selected object and its SQL in a Model Editor, you can click the Edit button.
An editor will be opened if not already open. If an editor is open its tab will be selected. In addition, the
Transformation Editor will be opened and you can perform Find/Replace (Ctrl-F) actions to
highlight your original searched text string and edit your SQL if you wish.

16.4. SEARCH MODELS VIA METADATA PROPERTIES

The Teiid Designer provides a search capability to find model objects that are characterized by one or
more metadata property values.

To search your models using metadata:

1. Click Search > Metadata. .. action on the main Teiid Designer toolbar which opens the
Search dialog.

2. Specify desired search options for Object Type, Data Type and Properties.

3. Click Search. The search will be performed and the results will be displayed in theSearch
Results View. If the view is not yet open, it will be opened automatically.
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APPENDIX A. SUPPORTED CONFIGURATIONS

A.1. SUPPORTED DATA SOURCES AND TRANSLATORS
The following table provides a list of data sources and translators that are supported by Red Hat.

Table A.1. Supported Data Sources and Translators

Data Source

Translator

Support
ed DV

Version

Driver

Apache Hive 12 - 6.0+ -
Apache Solr solr 6.1+ -
Cloudera Hadoop - 6.1+ -
EDS 5.x teiid 6.0+ -
Files — delimited, fixed length file 6.0+ -
Generic Datasource-JDBC ansi jdbc-ansi 6.0+ -
Generic Datasource-JDBC simple jdbc-simple 6.0+ -
Google Spreadsheet - 6.0+ -
Greenplum 4.x postgresq|l 6.0+ -
Hortonworks Hadoop - 6.1.+ -
HSQL (for test/examples only) - - -
IBM DB2 10 db2 6.1+ Universal Driver v4.x
IBM DB2 9.7 db2 6.0+ Universal Driver v4.x
Ingres 10 ingres 6.0+ -
Intel Hadoop - 6.1+ -
JBoss Data Grid 6.4 (remote client - hotrod) infinispan-cache-dsl 6.2+ -
JBoss Data Grid 6.4 (library mode) infinispan-cache 6.0 - -
post GA,
6.1+
LDAP/ActiveDirectory v3 ldap 6.0+ -
Mainframe (CICS,IMS,VSAM) - 6.0+ -
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Data Source Translator Support Driver

ed DV
Version

MariaDB mysql5 6.1+ -

ModeShape/JCR 3.1 - 6.0+ -

MongoDB 2.2 mongodb 6.0 post GA, 6.1+ -

MS Access 2010 - 6.0+ -

MS Access 2013 - 6.0+ -

MS Excel 2010 excel 6.0+ -

MS Excel 2013 excel 6.0+ -

MS SQL Server 2008 sqlserver 6.0+ Microsoft SQL
Server JDBC Driver 4

MS SQL Server 2012 sqlserver 6.0+ Microsoft SQL
Server JDBC Driver 4

MySQL 5.1 mysql5 6.0+ V5.1

MySQL 5.5 mysql5 6.0+ V5.5

Netezza 6.0.2 netezza 6.0+ -

Oracle 10g R2 oracle 6.0+ Oracle JDBC Driver
v10

Oracle 11g RAC oracle 6.0+ Oracle JDBC Driver
vii

Oracle 12c oracle 6.0 - Oracle JDBC Driver

post GA, vi2
6.1+

PostgreSQL 8.4 postgresq|l 6.0+ -

PostgreSQL 9.2 postgresq|l 6.0+ -

REST/JSON over HTTP ws - -

RHEL 5.5/6 PostgreSQL config - 6.0+ -

Salesforce.com API 22 salesforce 6.0+ -
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Data Source Translator Support Driver

ed DV
Version

SAP Netweaver Gateway (OData) sap-nw-gateway 6.1+ -

Support SAP Service Registry as a Data - 6.2+ -

Source

Sybase ASE 15 sybase 6.0+ jConnect JDBC3.0 v7
Teradata Express 12 teradata 6.0+ -

Webservices WS 6.0+ -

XML Files FILE 6.0+ -

NOTE

MS Excel is supported in so much as there is a write procedure.

A.2. DESIGNER METADATA USAGE REQUIREMENTS IN JBOSS DATA
VIRTUALIZATION RUNTIME

Based on the metadata exposed by the Teiid Designer the below table shows which fields are required
and how that information is being used in JBoss Data Virtualization runtime.

Table A.2. Data Usage for Tables

In Designer In Metadata Required Description
API
FullName String Yes Yes Yes Name of the
Table
NamelnSource  String Yes Yes Yes Name of Table
in the source
system, for

view this can
be empty, also
used on variety
of use cases

Cardinality Integer Yes Yes Yes Cardinality is
used to
calculate the
cost of source
node access
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In Designer In Metadata Required Description

API

TableType Integer Yes Yes Yes Table,View,Do
cument,XmlMa
ppingClass,Xm
IStagingTable,
MaterializedTa
ble

IsVirtual Boolean Yes Yes Yes Used to find if
this is source
table Vs view

IsSystem Boolean Yes Yes No Only used for
System
metadata

IsMaterialized Boolean Yes Yes Yes To identify that
the table is
materialized

SupportsUpdat ~ Boolean Yes Yes Yes To allow
e updates on the
table

PrimaryKeyID String Yes KeyRecord Yes Used for
creating
indexes on
temp tables
and to create
default
update/delete
procedures

ForeignKeylDs  Collection Yes List<ForeignKe  Yes Used in
y> Planning of
query (rule
raise access)

IndexIDs Collection Yes List<KeyRecor Yes Used for
d> creating
indexes on
temp tables
and in planning
(estimate
predicate cost)

UniqueKeylIDs Collection Yes List<KeyRecor Yes Used for query
d> planning
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In Metadata
API

Required

Description

AccessPatternl
Ds

MaterializedTa

blelD

insertEnabled

deleteEnabled

updateEnabled

Select

Transformation

Insert Plan

Update Plan

Delete Plan

Bindings

Collection

String

Boolean

Boolean

Boolean

String

String

String

String

Collection

Yes

Yes

*%

*%

*%

*%

*%

*%

*%

*%

List<KeyRecor
d>

Table

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Used for
enforcing the
criteria on

query

Reference to
Materialization
table

Flag for
checking insert
procedure is
enabled for
view

Flag for
checking
delete
procedure is
enabled for
view

Flag for
checking
update
procedure is
enabled for
view

Transformation
for Select in
case of View

Transformation
for Insert in
case of View

Transformation
for Update in
case of View

Transformation
for Delete in
case of View

XML
Document
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In Designer In Metadata Required Description
API
SchemaPaths Collection b Yes Yes XML
Document

Table A.3. Data Usage for Columns

COLUMN In Designer In Metadata Required Description
API
FullName String Yes Yes Yes Name of the
column
NamelnSource  String Yes Yes Yes Name of the
column in

source system

IsSelectable Boolean Yes Yes Yes Column is
allowed in
select

IsUpdatable Boolean Yes Yes Yes Column is
allowed in
Update/Insert/
Delete

NullType Integer Yes Yes Yes Used for
validation if null
value allowed

IsAutoincreme Boolean Yes Yes Yes During insert

ntable used to
validate if a
value is

required or not

IsCaseSensitiv.  Boolean Yes Yes ?? ??

e

IsSigned Boolean Yes Yes ?? Used in
System
Metadata

IsCurrency Boolean Yes Yes No Only used for
System
metadata
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API

Required

Description

IsFixedLength

IsTranformatio
ninputParamet
er

SearchType

Length

Scale

Precision

CharOctetLen

gth

Radix

DistinctValues

NullValues

MinValue

Boolean

Boolean

Integer

Integer

Integer

Integer

Integer

Integer

Integer

Integer

String

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

2?

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

No

2?

Yes

2?

2?

2?

No

22

Yes

Yes

Yes

Only used for
System
metadata

2?

Used for
defining the
capability of
the source

Used in
System
Metadata

Used in
System
Metadata

Used in
System
Metadata

only used for
System
metadata

Used in
System
Metadata

Used for cost
calculations,
System
metadata

Used for cost
calculations,
System
metadata

Used for cost
calculations,
System
metadata
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COLUMN In Designer In Metadata Required Description

API

MaxValue String Yes Yes Yes Used for cost
calculations,
System
metadata

Format String Yes Yes No Only used for
System
metadata

RuntimeType String Yes DataType Yes Data Type

NativeType String Yes Yes Yes Translators
can use this
field to further
plan

DatatypeObjec ~ String Yes ?? ??
tID

DefaultValue String Yes Yes Yes Used for Insert
and procedure
execute
operations
when the
values are not
supplied

Position Integer Yes Yes Yes Used in the
index
calculations

Table A.4. Data Usage for Primary Keys

PRIMARY In Designer In Metadata Required Description
KEY API
FullName String See the
KeyRecord,
See Table

NamelnSource  String

ColumnlIDs Collection

ForeignKeylDs  Collection Extends
KeyRecord
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Table A.5. Data Usage for Unique Keys

UNIQUE KEY In Designer In Metadata Required Description
API
FullName String See the
KeyRecord,
See Table

NamelnSource  String

ColumnlIDs Collection

ForeignKeylDs  Collection

Table A.6. Data Usage for Indexes

In Designer In Metadata Required Description
API
FullName String See the
KeyRecord,
See Table

NamelnSource  String

ColumnlIDs Collection

Table A.7. Data Usage for Access Patterns

ACCESS In Designer In Metadata Required Description
PATTERNS API
FullName String See the
KeyRecord,
See Table

NamelnSource  String

ColumnlIDs Collection

Table A.8. Data Usage for Result Sets

RESULT SET In Designer In Metadata Required Description

API

FullName String See DataType
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RESULT SET In Designer In Metadata Required Description

API

NamelnSource  String

ColumnlIDs Collection

Table A.9. Data Usage for Foreignh Keys

FOREIGN In Designer In Metadata Required Description
KEY API
FullName String See the
KeyRecord,
See Table

NamelnSource  String

ColumnlIDs Collection

UniqueKeyID String

Table A.10. Data Usage for Data Types

DATA TYPE In Designer In Metadata Required Description

API

FullName String No Only used for
System
metadata

NamelnSource  String No Only used for
System
metadata

Length Integer No Only used for
System
metadata

PrecisionLengt Integer No Only used for
h System
metadata

Scale Integer No Only used for
System
metadata
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In Metadata
API

In Designer

Required

Description

Radix

IsSigned

IsAutolncreme

nt

IsCaseSensitiv
e

Type

SearchType

NullType

JavaClassNam
e

RuntimeTypeN

ame

DatatypelD

BaseTypelD

PrimitiveTypel
D

Integer

Boolean

Boolean

Boolean

Integer

Integer

Integer

String

String

String

String

String

No

No

No

No

No

No

No

Yes

No

No

No

No

Only used for
System
metadata

Only used for
System
metadata

Only used for
System
metadata

Only used for
System
metadata

Only used for
System
metadata

Only used for
System
metadata

Only used for
System
metadata

Maps to
runtime type
based on java
class name

Only used for
System
metadata

Only used for
System
metadata

Only used for
System
metadata

Only used for
System
metadata
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DATA TYPE In Designer In Metadata Required Description

API

VarietyType Integer No Only used for
System
metadata

VarietyProps Collection No Only used for
System
metadata

Table A.11. Data Usage for Procedures

PROCEDURE In Designer In Metadata Required Description
API
FullName String Yes Yes Yes Name of the
column
NamelnSource  String Yes Yes Yes Name of the
column in

source system

IsFunction Boolean Yes Yes Determines if
this function

IsVirtual Boolean Yes Yes If Function
then UDF else
stored
procedure

ParametersIDs Collection Yes Yes Parameter List

ResultSetID String Yes Yes Result set
columns

UpdateCount Integer Yes Yes Update count
defines the
number of
sources being
updated, only
applicable for
virtual
procedures

Table A.12. Data Usage for Procedure Parameters
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PROCEDURE In Designer In Metadata Required Description
PARAMETER API
ObjectID String Same as
Column
FullName String Same as
Column
namelnSource String Same as
Column
defaultValue String Same as
Column
RuntimeType String Same as
Column
DatatypeObjec ~ String Same as
tID Column
Length Integer Same as
Column
Radix Integer Same as
Column
Scale Integer Same as
Column
NullType Integer Same as
Column
Precision Integer Same as
Column
Position Integer Same as
Column
Type String Yes Defines
parameter is
IN/OUT/RETU
RN
Optional Boolean No Defines if the

parameter is
optional or not,
only used
system
metadata
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Table A.13. Data Usage for SQL Transformations

SQL In Designer In Metadata Required Description
TRANSFORM API

ATION(**)

VirtualGroupN String Yes No Yes See Table, the

ame properties
defined on
Table

TransformedO String Yes No Yes See Table, the

bjectID properties
defined on
Table

Transformation  String Yes No Yes See Table, the

ObjectID properties
defined on
Table

Transformation  String Yes No Yes See Table, the

Sql properties
defined on
Table

Bindings Collection Yes No Yes See Table, the
properties
defined on
Table

SchemaPaths Collection Yes No Yes See Table, the
properties
defined on
Table

Table A.14. Data Usage for VDBs

In Designer In Metadata Required Description
API
FullName String Yes vdb.xml Yes Name of the
VDB
NamelnSource  String ?? No No Not required
Version String Yes vdb.xml Yes VDB version
Identifier String Yes No No Not required
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In Designer In Metadata Required Description
API

Description String Yes vdb.xml No Used by
System
metadata

ProducerName  String Yes No No Not required

ProducerVersi String Yes No No Not required

on

Provider String Yes No No Not required

TimeLastChan String Yes No No Not required

ged

TimelLastProd String Yes No No Not required

uced

ModellDs Collection Yes vdb.xml Yes Defines the
model list in a
VDB

Table A.15. Data Usage for Annotations

ANNOTATION In Designer In Metadata Required Description

API

FullName String Yes Yes No System
metadata, as
description on

procedure

parameter
NamelnSource  String Yes No No Not required
Description String Yes No No Not required
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APPENDIX B. USER PREFERENCES

B.1

. USER PREFERENCES

The Teiid Designer provides options or preferences which enable customization of various modeling
and Ul behaviors. Preferences can be accessed via the Edit > Preferences action on the Main
toolbar.

Preferences

I

T o v

[
[
[

Diagrarm
Diagram Printing
Editor
Validation
TestNG
Validation
Web
Web Services
XML [

JHOSS lools
ModeShape

Plug-in Development

[>)

Project Archives
Remote Systems
Run/Debug
Server

Spring

Team

Figure B.1. Preferences Dialog

B.2.

TEIID DESIGNER PREFERENCES

General Teiid Designer preferences include:

e Always open editor without prompting - To change/edit a model, it must be opened

242

for editing. Selecting this box will automatically open the model in an editor if the user attempts to
perform a change in a model. If unchecked, the user will be informed that an editor will be
opened before the operation is completed.

Open Designer perspective when model is opened - If a model is opened via
importing projects, the New > Teiid Metadata Model menu and the Teiid Designer

perspective is not open, you may want to automatically open the perspective and begin working
on your model. This preference has 3 settings. Always open, which means always open the
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perspective without prompting; never open, which means do not open the Teiid Designer
perspective, or prompt, which will always ask you if you wish to open the Teiid Designer
perspective.

e Check and update imports during save - Occasionally editing a model may add or
remove objects in one model that reference objects in another model. Model Imports keep track
of these dependencies within each model. A validation error or warning may appear during a
build. Checking this box will automatically check and update imports during the save process.
This will result in any unneeded imports being removed from the model or any required imports
added to the model. If unchecked, no updating of imports will be performed.

e Enable Preview - If the Designer Runtime feature is installed and a Teiid Instance is defined,
Teiid Designer will automatically keep the preview artifacts (VDBSs) in sync with the
workspace models. Clearing this preference will disable preview feature and not create preview
artifacts.

e Enable Preview Teiid Cleanup - If operating Designer with Enable Preview = TRUE, then
this preference will result in automatic clean-up of your preview artifacts from your JBoss Data
Virtualization servers. Any preview VDBs or preview data sources will be undeployed from your
servers as part of Eclipse's shutdown process.

Teiid Designer A -

Specify values for general Designer preferences.

Preview Data/VDB Execution

| Enable auto-creating of a source model's data source on Teiid server (VDB Execution)
| Enable Preview
| Enable Preview Teiid Cleanup

Teiid Designer
[] Always open editor without prompting
Open Designer perspective when a model is opened

() Always open () Mewer open (@ Prompt

W] Check and update imports during save

| Import Logical ER Models as View Relational Models

Figure B.2. General Teiid Designer Preferences Panel

B.3. DIAGRAM PREFERENCES

Several diagram preferences are available to customize your diagrams.

e Notations - Standard diagram notation for Teiid Designer is based on UML notation.
Future releases may include alternate notations.
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Routers - The relationship link type for Package and Custom diagrams (Foreign Key - Primary
Key relationships) can be customized. Available options include Orthogonal (default), Direct or
Manual (user defined breakpoints).

Font Settings - Select font type, style and size.

Background Color Settings - Select a unique background color for each diagram type to
help differentiate between types.

Model Size - Displaying very large diagram may take a considerably long time. This
preference allows users to set an upper limit on the number of objects to display in a diagram. If
this limit is exceeded, a warning is displayed to the user and the diagram is not constructed.

Relationship Options - UML-type relationships can be customized in a couple of ways.
Role Names and Multiplicity labels can be shown or hidden using the checkboxes labeled Show
Role Names and Show Multiplicity.
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Diagram e —

General settings for Diagrams

Motations
Default Notation: | UML ¢ |
Routers
Default Router Style: | Orthogonal - |
Font Settings
Font Type: Sans - Regular - 8 |.‘-.-"iew f Change... |
Background Color Settings
Dependency Diagram: ||:|| Custorm Diagram: ||:||
Mapping Diagram: ||:|| Relationship Diagram: |-|
Transformation Diagram: ||:|| Custom Relationship Diagram: |-|
Package Diagram: ||:||
Model Size
Warn If Model Size is Larger Than [gnnnn
Relationship Options
Show Role Names
Show Multiplicity
.Restnre Defaults | | Apphy

Figure B.3. Diagram Preferences Panel

B.4. DIAGRAM PRINTING PREFERENCES

Diagram print options are stored as preferences. These can be accessed through this preference page,
by right-clicking diagram Page Setup action , orvia the Modify Diagram Printing

o . .
Preferences action located on the vertical diagram toolbar .
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Diagram Printing =t -

Diagram Print
Orientation
() Portrait (@ Landscape
Scaling
() Atto: One page
(1 Ftto: One page high, as many as necessary wide
() Ftto: One page wide, as many as necessary high

(@ Adjust to:

|1r;||:| |E % normal size

Margins

w o0 g
Left: @ B Right: @ E
Bottom: [E] B

Page Order

(@ Over, then down

() Down, then over

Restore Defaults | | Apphy

Figure B.4. Diagram Preferences Panel

B.5. EDITOR PREFERENCES

B.5.1. XML Document Preferences

XML Document Mapping Preferences provide ways to customize Mapping Diagram and Recursion
Editor (XML) behavior.

246



APPENDIX B. USER PREFERENCES

Editor = -

ML Document Mapping Settings!| Transformation  Table | VDB

XML Mapping Diagram Settings

Auto-expand tree when model has fewer than |21 | mapping classes.
Auto-expand XML document tree to level: |1 |

[ | Hide Mapping Class Columns by Default

XML Document Mapping
Upper XML Recursion Lirmit: |1CI |

[ | Remove Duplicate Attributes on Merge

Figure B.5. XML Document Preferences Panel

B.5.2. Table Editor Preferences

Table Editor Preferences provide a way to customize the order and the information content for
each model object type.
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Editor

%ML Document Mapping Settings ]Transfnrmatinn Table

vos |

Preferences for a given table will only be present if the table editor tab
for it has been viewed. After restoring defaults, the table editor must be
viewed again for the default preferences to become visible.

Table Columns
Base Tables Column Visible 4
Foreign Keys Mame Yes
Function Parameters Mame In Source Yes
Inputs Mative Type Yes
Interfaces Length Yes
Operations Length Fxed Yes
Outputs Numeric Precision Yes
Primary Keys Mumeric Scale Yes
Procedures Mullable Yes
Procedure Parameters Auto Incremented Yes
Procedure Results Default Value Yes
Return Parameters Minimum Yalue Yes
Sample Messages Maximum Value Yes
Scalar Functions Format Yes
Schemas Character Set Name | Yes
Views Collation Name Yes (8
Restore Defaults | | Apphy

Figure B.6. Table Editor Preferences Panel

B.5.3. Transformation Editor Preferences

Transformation Editor Preferences provide a way to customize SQL formatting, diagram

layout, and default view entity properties.
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Editor = -

¥ML Document Mapping Settings [ETransfnrmatinn§ Table | VDB

SQL Clauses
| Start Clauses on New Line |/ Indent Clause Content

[ ] Auto-expand default SELECT * FROM on construction

Diagram Layout

(@ View and Sources

() Tree Layout

Miscellaneous

Default String Length: |1CI |

Figure B.7. Transformation Editor Preferences Panel

B.5.4. VDB Editor Preferences

VDB Editor Preferences provide a way to customize VDB editor behavior.

Editor = -

¥ML Document Mapping Settings  Transformation | Table | VDB |

W iSynchronize without showing warning dialog:

Figure B.8. VDB Editor Preferences Panel

B.6. VALIDATION PREFERENCES

Validation Preferences provide a way to customize the severity of some of the rules checked
during model validation.

The Validation preference pages, shown below, include the validation preferences for Core, Relational,
XML and XSD (XML Schema) models.
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Validation

Specify the Severity Level for validation-related occurrences.

Core | Relational | XSD XML
Core Validation Control Settings

Multiple ECbjects with same uuid.

String functions (SUBSTRING, LOCATE, and INSERT) 0 to 1 base check:

Figure B.9. Core Model Validation Preferences Panel

Validation

Specify the Severity Level for validation-related occurrences.

| xsD | XML

Relational Validation Control Settings

Missing length property on columns with string or character types:
Missing precision property on columns with numeric types:
Columns of builtin twpe integer:

Table mis=sing name in source value:

Mame in source conflicts with sibling entities:

Indexes with columns from more than one table:

Empty transformations:

Restrict name characters to valid unquoted SQL identifiers:

Figure B.10. Relational Model Validation Preferences Panel
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| Ignore

| Warning

| Warning
| Warning
| Warning

| Warning

| lgnore

| Warning

| Error

| lgnore

»

L]
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Validation el —

Specify the Sewverity Level for validation-related occurrences.

Core Relational  X5D

¥ML Validation Control Settings

XML Document Elements/attributes not referencing an XML Schema component: | Warning 2 |
Excluded Element from XML Document required by XML Schema: | Warning 2 |
XML document entity violates max occurs specified by its schema component: | Warning 2 |
Unmapped required XML element or attribute: | Error o |
Excluded Elements/attributes from XML Document are mapped: | Warning 2 |
Mapped ¥ML Element/Attribute has fixed or default value: | Warning 2 |
Mapped XML Elements/Attributes with zero minimum occurrences: | Ignore 2 |
Mapped XML Elements/attributes with one maximum occurrence: |Warr1ing o |
¥ML Root Element mapped to Mapping Class: | Warning 2 |
Mapped XML Elements/Attributes Nillable: | lgnore 2 |
Incompatible Datatypes for Column-to-Elementfattribute Mappings: | Warning 2 |
| Restore Defaults | | Apphy |
Figure B.11. XML Document Model Validation Preferences Panel
Validation =X =
Specify the Sewverity Level for validation-related occurrences.
Core Relational |}
¥SD Validation Control Settings
XML Schema Document validation problems lgnore b

Figure B.12. XSD Schema Model Validation Preferences Panel

NOTE

Increasing the severity level to error will prevent you from testing your VDB or deploying a
web service if violations of that preference are found during validation.
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APPENDIX C. TEIID DESIGNER Ul REFERENCE

C.1. TEIID DESIGNER PERSPECTIVES

Teiid Designer utilizes the Eclipse Workbench environment which controls visual layout via
perspectives. A perspective defines the initial set and layout of views and editors. Within the application
window, each perspective shares the same set of editors. Each perspective provides a set of
functionality aimed at accomplishing a specific set of tasks.

Perspectives also control what appears in certain menus and toolbars. They define visible action sets,

which you can change to customize a perspective. You can save a perspective that you build in this
manner, making your own custom perspective that you can open again later.

C.2. TEIID DESIGNER PERSPECTIVE

The Teiid Designer perspective provides access to fundamental model editing and management
capabilities. This perspective includes the following main Ul components or groups of components:

e Model Explorer View - Teiid tree view of Model Objects.

e Server View - JBoss Data Virtualization Server instance view. Provides view of contents for
connected instances of installed Teiid runtime.

e Model Editors - Custom editors targeted for . xmi metadata model files.
e Properties View - Standard property values for selected workbench objects.
e Guides View - Guides and Status Views which enhance usability.

e Miscellaneous Views - Includes the Problems view, Message Log view and the SQL Results
view (opened if Preview Data action is performed).

Teiid My tModel.xmi - Eclipse SDK DEE
File Edit Refactor Navigate Search Project Metadata Run Window Help
[mild & | Qv | G £ |100% | v ‘ P A & BB B |5 Teiid Desi...‘ (i3 Database ... &'Java
= Model Explorer 3 2= outline = O | testModel.xmi 52 = 0 '{ Guides 52 W Status =a
) B % 7| ]

< & MyProject | Model JDBC Source S
IO — 2 & Define Teiid Model Project

=) < Create JDBC connection

EE] [1, Create source model for JDBC data source

& Preview Data
N Define VDB
(3% Execute VDB

Description

<no action selected>
2§ Teiid 2 A B ¥ =0

= A localhost
P = Data Sources
P = VDBs

~ Cheat Sheets
Cheat sheets for Teiid Designer use cases

reate Model from JDBC Source
reate Model from Flat File Source =

) Consume a SOAP Web Service
2) Create Model from XML Local File Source

! i )

" : (31 rronte Mndal fram YMI Ramata Crurre
%5 Package Diagram | [ Table Editor @ m |
- - — |2 Problems 32 " @] Error Lo v =a
= Properties 52 . [E] Description B| = ¥ =0 i Al
— 0items
Property value Description Resource Path Location Type

Figure C.1. Teiid Designer Perspective Layout

252


http://www.eclipse.org

APPENDIX C. TEIID DESIGNER Ul REFERENCE

C.3. OPENING A PERSPECTIVE

There are two ways to open a perspective:

iz

e Using the Open Perspective button on the shortcut bar.

e Selecting a perspective from the Window > Open Perspective menu.

To open a perspective by using the shortcut bar button:

ﬁ .

1. Click the Open Perspective button

2. A menu appears showing the same choices as shown on the Window > Open Perspective
menu. Click 0ther from the menu.

[ | &’
ﬂ %5 Debug

E‘J |ava Browsing

it

Figure C.2. Perspectives Menu

3. Inthe Select Perspective dialog, select Teiid Designer and click OK.
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T
o

& Java
E{Jjaua Browsing
E';‘Java EE

&Jjaua Type Hierarchy
%”Javaﬁcript

i |Boss AS

§® jBPM jPDL 3

& JMx

+H |PA

“J= Plug-in Development

Open Perspective

[>)

Ei Remote System Explorer
Ef‘_-, Resource

' Seam (default)

ED Team Synchronizing

&% Teiid Designer

@ Web

@WEI:: Development
3L XML

Cancel (8]4

Figure C.3. Select Perspective Dialog
The Teiid Designer perspective is now displayed.
There are few additional features of perspectives to take note of.

e The title of the window will indicate which perspective is in use.

Teilid Designer - PartsProject/PartsSource A.xmi - |[Boss Developer Studio

Fle Edit Refactor MNawvigate Search Project Metadata PRun Window Help

Figure C.4. Workbench Window Title Bar

e The shortcut bar may contain multiple perspectives. The perspective button which is pressed in,
indicates that it is the current perspective.

e To display the full name of the perspectives, right-click the perspective bar and click Show Text
and conversely click Hide Text to only show icons.

e To quickly switch between open perspectives, select the desired perspective button. Notice that
the set of views is different for each of the perspectives.

254



APPENDIX C. TEIID DESIGNER Ul REFERENCE

Ey ||ﬂ:jTeiid Desig...| [[3Database D...

Figure C.5. Workbench Window Title Bar

C.4. FURTHER INFORMATION

For more details on perspectives, views and other Eclipse workbench details, see formal Eclipse
Documentation.
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APPENDIX D. TEIID DESIGNER VIEWS

D.1. TEIID DESIGNER VIEWS

Views are dockable windows which present data from your models or your modeling session in various
forms. Some views support particular Model Editors and their content is dependent on workspace
selection. This section summarizes most of the views used and available in Teiid Designer. The full list
is presented in the main menu's Window > Show View > Other. .. dialog under the Teiid
Designer category.
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Show View

type filter text 4

+ = Server
+| = Team

el Datatypes
Description

W Guides

'ﬁ Metadata Favorites
& Model Explorer

& Model Extension Registry
O SGL Reserved Words
W Status

o System Catalog

= Tags

o Teiid

&7 Teiid Execution Plan

i Teiid Model Classes

Cancel | | OK

Figure D.1. Show View Dialog

D.2. MODEL EXPLORER VIEW
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Teiid Designer allows you manage multiple projects containing multiple models and any corresponding
or dependent resources. The Model Explorer provides a simple file-structured view of these
resources.

The Model Explorer (shown below) is comprised of a toolbar and a tree view.
T Model Explorer 3 0= Outline = O

1% &9 Sl =
1.7 AllCustomerAccounts
[» =% BooksProject
o 'E PartzsProject
[» (= data
[ = readme
] Parts.vdb
[* g PartsSourceA xmi
[* £ PartsSourceB.xmi
= [ PartsVirtual xmi
[ ‘= import declarations (4)
2 Package Diagram
[* E supplierinfo
& partsByColor
[* Cg SampleViews. xmi

Figure D.2. Model Explorer View

The toolbar consists of nine common actions:
° H’ Preview Data - Executes a simple preview query (SELECT * FROM ).

a
! & Sort Model Contents - Sorts the contents of the models based on object type and
alphabetizing.

° ‘5{}% Refresh Markers - Refreshes error and warning markers for objects in tree.

& Back - Displays the last Go Into location. (See Eclipse Help)

= Forward - Displays the next Go Into location. (See Eclipse Help)

° @ Up - Navigates up one folder/container location. (See Eclipse Help)

= Collapse All - Collapses all projects.
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° {};b Link with Editor - When object is selected in an open editor, this option auto-selects and
reveals object in Model Explorer.

e =~ Additional Actions

The additional actions are shown in the following figure:

S

Show all file types
Show Imports

Select Working Set. ..
Deselect Working Set

ink with Editor

[

Figure D.3. Additional Actions

If Show Model Imports is selected, the imports will be displayed directly under a model resource as
shown below.

= [ PartsVirtual xmi

w ‘= import declarations (4)
4_ JPartsProject/PartsSourcel xmi
4a_ JPartsProject/PartsSourceB. xmi
4_ http:ffwww.w3.org/2001/XMLSchema
4_ fPartsProject/SampleViews. xmi

2 Package Diagram
[* E supplierinfo

Figure D.4. Show Model Imports Action

D.3. SELECTION-BASED ACTION MENUS

Selecting specific objects in the Model Explorer provides a context from which the Teiid Designer
presents a customized menu of available actions.

Selecting a view model, for instance, results in a number of high level options to manage edit model

content, perform various operations and provides quick access to other important actions available in
Teiid Designer. These may include specialized actions based on model type.
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[* C§ PartsSourceB.xmi
Mew
MNew Child > Base Table
[} Mndeling > o Cﬂtﬂlﬂg
b Open I Index
P g S Open With 3 “l. Logical Relationship
Procedure
Copy 3 Schema
) Paste Ctrl+V View
Paste Special... Crl+ %2 Custom Diagram =
g =
Delet
off Teiid 330 — il ¥ =0
Refactor >
E¥y Import...
L7 Export...

Figure D.5. Sample Context Menu

D.4. OUTLINE VIEW

The outline View is a utility view which provides both at tree view dedicated to a specific model (open
in an editor) and a scaled thumbnail diagram representative of the diagram open in the corresponding
Diagram Editor.

You can show the Outline View by clicking its tab. If there is no open editors, the view indicates that
Outline is not available. If aModel Editor is open, then the root of the displayed tree will be the model
for the editor that is currently in focus in Teiid Designer(tab on top).

D.5. OUTLINE TREE VIEW

This tree view provides the same basic editing and navigation behavior as the Model Explorer. One
additional capability is the drag and drop feature which provides re-ordering and re-parenting of objects
in a model.
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rﬂ Model Explurerm = Ijﬁ
* @lﬁ] 1% &9

= [ PartsVirtual xmi
b

‘= import declarations (4)

2 Package Diagram
[» Supplierinfo
[» partsByColor

Figure D.6. Outline View

D.6. OUTLINE THUMBNAIL VIEW

The outline View also offers you a way to view a thumbnail sketch of your diagram regardless of its

size. To view this diagram thumbnail from the Outline panel, click the Diagram Overview button @
at the top of the view. The diagram overview displays in the Outline View.

-

1zY Model Explorer (DE Outline &3 =

® &= &
--

-

1

%
(1]

Figure D.7. Outline View

The view contains a thumbnail of your entire diagram. The shaded portion represents the portion visible

in the Diagram Editor view.
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To move to a specific portion of your diagram, click the shaded area and drag to the position you want
displayed in the Diagram Editor view.

[=H Model Explorer o= Outline 23 = O | g Northwind xmi 2

THHHH

41 HomePage : string(1073741823)

1 Country : string(15)

| HomePhone : string(24) X Produ

e = =
<] I

(\;’#Teiid 52 ﬁ} = Eq %4 Package Diagram]ﬁ Table Editor

t
i
A

Figure D.8.

D.7. SERVER VIEW

The Server View provides a means to display and manage server instances and their contents within the
JBoss Developer Studio environment. Since Teiid Designer is installed as part of a JBoss Data
Virtualization server, its contents is displayed as part of its JBoss parent.

To show the Server View click Window > Show View > Other. .. to display the Show View dialog.
Click Server > Servers view and click OK.

5l Problems €] Error Log # Servers 8% & Console @ Teiid Execution Plan B & ¥ O & ®m O |

@ 5, JBoss EAP 6.1+ Runtime Server [Started, Synchronized]

+ (%] XML Configuration
+ 5 Filesets
+ = Server Details
~I = Teiid Instance Configuration
= ‘A mm:/flocalhost: 9999
+l (= Data Sources
+l (& Translators

+ & VDBs

Figure D.9. Server View
To create your Teiid instance:

e Select the New. . . action in the Server view and this will launch the JBoss Data Virtualization
Server wizard. Configuring the JBoss Data Virtualization Server instance (with Teiid installed) will
enable connection to the Teiid Server.

e Inthe New Server wizard, select the JBoss Enterprise Application Platform server type under
the JBoss Enterprise Middleware category and click Next >.
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New Server
Define a New Server
Choose the type of server to create

Download additional server adapters

Select the server type:

type filter text f

® JBoss Enterprise Application Platform 6.1+

JBoss Enterprise Application Platform (EAP) 6.1+

¥

Server's host name: localhost
Server name: jposs-eap-6.1 Runtime Server (1)
Server runtime environment: | jboss-eap-6.1 Runtime ¥ Add..
Configure runtime environments...
® = Back Mext = Cancel Finish

Figure D.10. New Server Dialog

e On the JBoss Runtime page, click the top Browse. . . button to select the installation folder of
your JBoss Enterprise Application Platform server.
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MNew Server Runtime Environment

. .. . _
|Boss Runtime ® B o
L]

JBoss Enterprise Application Platform 6.1+ ® @ by Red Hat

A JBoss Server runtime references a JBoss installation directory.

It can be used to set up classpaths for projects which depend on this runtime,
as well as by a "server” which will be able to start and stop instances of JBoss.

Mame

JBoss EAP 6.1+ Runtime 1

Home Directory Download and install runtime...

ts/test/JBoss_Data_Virtualization_Testing/dv6/Teiid_Testing/jboss-eap-6.1

Browse...
JRE
Default JRE for JavaSE-1.6 v || IRE
Configuration file: | standalone.xml Browse...
® Cancel Finish

Figure D.11. JBoss Runtime Definition

e Then click the bottom Browse. . . button to select the standalone . xml configuration file

located under the EAP_HOME/standalone/configuration/ folder on your file system. Then click
Finish.
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£ standalone_xml_history

B teiid-security-users.properties-~
B teiid-security-users.properties

E teiid-security-roles.properties-
El teiid-security-roles.properties

9| standalone-osgi.xml

@I standalone-ha.xml

|@| standalone-full-ha.xml

\@| standalone-full.xml

E standalone. xml
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Size

97 bytes
96 bytes
195 bytes
189 bytes
28.7 kB
31.6 kB
38.0kB

323 kB

Modified

Yesterday at 12: 20

12f18f2013
12/27/2013
12/27/2013
12/27/2013
12f24f2013
12/24/2013
12f24f2013

12/24/2013

El modeshape-users.properties
E modeshape-roles.properties
__| mgmt-users.properties

E logging.properties

El application-users.properties

E application-roles.properties

Figure D.12. Teiid Configuration File Selection

e Your new JBoss Data Virtualization server configuration will be opened in the JBoss / Teiid
Editor for viewing. In this editor you can test both Teiid admin and JDBC connections.

85 bytes
207 bytes
876 bytes
1.9kB
812 bytes

634 bytes

12/19/2013
12/19/2013
12/24/2013
14:58

0&/21/2013

0&8/21/2013
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#] JBoss EAP 6.1+ Runtime Server &2 = B

Teiid Instance

* Overview

Display Name

Host localhost
Teiid Runtime Version &.4.0

JBoss Server JBoss EAF 6.1+ Runtime Server

* Administration Connection

Administration is performed via the jboss management configuration

Port 9999

Test Administration Connection

~ JDBC Connection

User name user
Password
Port 31000

JDBC connection uses 551 a

Test JDBC Connection

Overview | Deployment | Teiid Instance

Problems “JError Log # Servers & Conso

e Teiid Execution Plan

- 43 JBoss EAP 6.1+ Runtime Server [Started, Synchronized]
+ |¥] XML Configuration

+ 5 Filesets

Figure D.13. Teiid Editor
Actions available in this view include:

° ﬁ Teiid Server Properties - View and edit properties of an existing Teiid instance.

E{}% Reconnect - Reconnect and refresh contents of the selected Teiid instance.

° Qﬁ Execute VDB - Creates a JDBC Teiid connection profile and opens the Data Tools Database
Development perspective.

H Undeploy VDB - Removes the selected VDB from the Teiid instance.

° ﬂ’ Create Data Source - Launches the New Data Source wizard.

° * Delete Data Source - Removes the selected Data Source from the Teiid instance.
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-

NOTE

Once the server is started, the Server view will now display the data source, translator and
VDB content for your running Teiid server.

Bl Problems @]Error Log # Servers 8% & Console @ Teiid Execution Plan & 3% 0 P = O |

8 7, JBoss EAP 6.1+ Runtime Server [Started, Synchronized]

+ [¥] XML Configuration
+ 5 Filesets
+ = Server Details
- (& Teiid Instance Configuration
= ‘A mm:/{localhost: 9999
+l (= Data Sources
+l (& Translators

+ & VDBs

Figure D.14. Teiid Contents in Server View

D.8. PROPERTIES VIEW

The Properties View provides editing capabilities for the currently selected object in Teiid Designer.
The selection provided by whichever view or editor is currently in focus will determine the its contents.

To edit a property, click a cell in the Value column. As in the Table Editor, each cell provides a Ul
editor specific to the property type.

W

Property Value
Object UR
Searchability = SEARCHABLE
Selectable v true
Updateable i true
= Misc
Distinct Value Count il -1
Mame 4 SUPPLIER_NAME
Mame In Source A SUPPLIER_NAME
Mull Value Count 43 -1
= Twpe
Datatype B string (Path=http:/www. w3.0org/2001/XMLSC
Mative Type Ca varchar
Mullable I= NULLABLE ||
57 Tma Natail ]

Figure D.15. Properties View
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If the model for the object being edited is not open in an editor, a dialog may appear confirming the
attempt to modify the model and asking the user to confirm or cancel. This dialog can be prevented by
selecting the preference Always open editor without prompting. You can also select/clear this
property via the Teiid Designer's main preference page.

Open Model Editor

You must open this model in an editor tab before wvou can modify the property
<?> wvalue. Do wou want to open the editor?

[ ] Always open editor without prompting

Mo ] [ Cancel

Figure D.16. Open Model Editor Dialog

Properties can also be edited via a right-click menu presented below.

Value
nt il -1
| W[SUPPLIER NANS ;
LA SUPPLIER_NA ow Cut ka
1 -1 % Copy =
E% Paste lel
B string (Path= @ Delete [
LA varchar B |
i= NULLABLE | lz| Select Al 3
Input Methods > oL
DI Insert Unicode Control Character »
v true i = Jnk

Figure D.17. Open Model Editor Dialog

The Properties toolbar contains the following actions:

o« E Show Categories - toggles between categorized properties and flat alphabetical properties
list.

-+
e - Show Advanced Properties - shows/hide advanced properties (if available).

° B Restore Default Value - for a selected property, this action will reset the current to a default
value (if available).

D.9. DESCRIPTION VIEW

The Description View provides a means to display and edit (add, change or remove) a description
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for any model or model object. To show the Description View, click Window > Show View >
Other. .. todisplay the Eclipse Show View dialog. Click Teiid Designer > Description view
and then click OK.

| Properties  [=] Descriptic

PRODUCTDATA table contains various stock attribute values
including basic name, primary business type, etc...

Primary key ks PK_PD_INSTR_ID|

Figure D.18. Description View

You can click the edit description action in the toolbar or right-click select Edit in the context menu to
bring up the Edit Description dialog.

| Properties  [=] Descriptic

PRODUCTDATA table contains various stock attribute values
including basic name, primary business type, etc...

Primary key ks PK_PD_INSTR_ID

—

Copy

Select All

< FAnd

& Edit...
El Clear

Input Methods >
BaseTable: Products/PRODUC TosETs

Figure D.19. Description View Context Menu
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Edit Description for PRODUCTDATA

- Description

PRODUCTDATA table contains various stock attribute values including
basic name, primary business type, etc...

Primary key ks PK_PD _INSTR_ID

Cancel | | oK

Figure D.20. Edit Description Dialog

D.10. PROBLEMS VIEW

The Problems View displays validation errors, warnings, or information associated with a resource
contained in open projects within your workspace.
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|2 Problems &2 ¥ =g
1 error, 1 warning, 0 others
Description Resource Path Location Tvpe
= @ Errors (1 item)
@ 50L staterment is empty Books.xmi | /BooksProject | bookCollection | Problem

= (% Warnings (1 item)
& The type referenced by column book_edition must be marked as an enterprise datatype Books.xmi | /BooksProject | bookCollection/t Problem

| B

Figure D.21. Problems View

By default, the Problems View is included in the Teiid Designer perspective. If the Problems View is
not showing in the current perspective, click Window > Show View > Other > General >
Problems.

There are 5 columns in the view's table which include:

1. Description - A description of the problem preceded by a severity icon (i.e., error (X , warning
& , or info i )-

2. Resource - The name of the resource.
3. Path - The project name.

4. Location - The object within the resource that has a validation error.

o

. type - Type of validation item.

D.11. TOOLBAR MENU

v
Click the upside-down triangle icon to open the View Menu icon to see various options including
sorting, filtering, displayed columns and much more.

D.12. CONTEXT MENU

Additional actions are available by selecting a problem and right-click to open a context menu.
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1 error, 1 warning, 0 others

Description

= 3 Errors (1 item)

I."EI S0L statement is gooobe

< & Warnings (1 item)

i The type reference Copy P b
K Delete Delete
Select All Ctri+A

Show In  Shift+Alk+W >

I ovick Fx ctri+1 fi

Properties Alt+Enter

Figure D.22. Problems View Context Menu
e Go To - will open the appropriate editor and select the affected/referenced object.

e Show In Navigator - Opens the Basic > Navigator view (if not open) and expands file
system tree and reveals applicable resource.

e Copy - Copies the problem information to the system clipboard.

e Paste - Pastes the problem information located in the system clipboard (if applicable ) into the
cursor location for a specified text editor.

e Delete - Deletes the selected problem rows ( if applicable ).
e Select All - selects all problems in the table.
e Quick Fix - (Not yet implemented in Teiid Designer).

e Properties - displays a dialog containing additional information.

D.13. SEARCH RESULTS VIEW

Below is an example set of search results. The view contains rows representing matches for your search
parameters. You can double-click a entry and the object will be opened and selected in an editor and/or
the Model Explorer if applicable.
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Eprnblems ﬁm%\.\ I 4qp % & o ¢ ¥ =08
feature=MName, pattern=*Part¥ - 26 matches
[* £g Found & matches - /PartsProject/Parts Sourced xmi
[» ﬁ Found 1 match - /PartsProject/SampleViews.xmi
= [2 Found 7 matches - [PartsProject/PartsVirtual xmi
PART MAME : PART _NAME - http:/fwww.metamatrix. com/metamodels/Relational#//Column
A PART_COLOR : PART_COLOR - http:/fwww.metamatrix. com/metameodels/Relational #{/Column
PART_ID : PART_ID - http:/fwww.metamatrix. com/metamodels/Relational #/Calumn
El PART ID : PART ID - http: ffwww. metamatrix. com/metamodels/Relational#//Column
El PART_WEIGHT : PART_WEIGHT - http:/fwww.metamatrix. com/metamodels/Relational #{/Column
“= Partsvirtual : Partsvirtual - http:(fwww. metamatrix. com/metamodels/Core#//ModelAnnotation
partsByColor : partsByColor - http:/fwww. metamatrix. com/metamodels/Relational#//Procedure
[* E§ Found 10 matches - /PartsProject/PartsSourceB. xmi

<] HE

Figure D.23. Search Results View

The toolbar actions for the Search Results view are:
° "Jx} Show Next Match - Navigates down one row in the view.

{F Show Previous Match - Navigates up one row in the view.

° x Remove Selected Matches - Removes selected results from the view.

° % Remove All Matches - Clears the view.

4 Search - Launches the Teiid Designer Dialog.

Fl= . : .
° ;.P Previous Search Results - Select previous search results from history.

You can also perform some of these actions via the right-click menu:

Eprnblems ﬁm%\.\ I 4qp % & o ¢ ¥ =08
feature=MName, pattern=*Part¥ - 26 matches
[* £g Found & matches - /PartsProject/Parts Sourced xmi
[» ﬁ Found 1 match - /PartsProject/SampleViews.xmi
= [2 Found 7 matches - [PartsProject/PartsVirtual xmi
PART MAME : PART _NAME - http:/fwww.metamatrix. com/metamodels/Relational#//Column
A PART_COLOR : PART_COLOR - http:/fwww.metamatrix. com/metameodels/Relational #{/Column
PART_ID : PART_ID - http:/fwww.metamatrix. com/metamodels/Relational #/Calumn
El PART ID : PART ID - http: ffwww. metamatrix. com/metamodels/Relational#//Column
Il PART_WEIGHT : PART_WEIGHT - http: /fwww.metamatrix. com/metamodels/Relational #//Column
“= Partsvirtual : Partsvirtual - http:(fwww. metamatrix. com/metamodels/Core#//ModelAnnotation
partsByColor : partsByColor - http:/fwww. metamatrix. com/metamodels/Relational#//Procedure
[* E§ Found 10 matches - /PartsProject/PartsSourceB. xmi

<] BE
Figure D.24. Search Results Context Menu

D.14. DATATYPE HIERARCHY VIEW
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To open Teiid Designer's Datatype Hierarchy view, click the main menu's Window > Show View
> Other... andthen click theTeiid Designer > Datatypes view in the dialog.

i 5

e Model Expl (EE Outline (Eg Datatype &3 = H

= @ anySimpleType : xs:anyType .
O anylRI

[* B base&4Binary
% BookEdition : xs:nonNegativelnteger
O boolean
o date

O dateTime

O decimal

B bigdecimal : xs:decimal

O biginteger : xs:decimal

=~ 0 integer : xs:decimal

¥ [ long : xs:integer

[* B nonMegativelnteger : xs:integer
Datatype details

(<]

Property Value Defined by
whiteSpace collapse decimal
fractionDigits 0 integer

maxinclusive 9223372036854775807
mininclusive -9223372036854775808
pattern [\-+]7[0-9]+ integer

Figure D.25. Datatype Hierarchy View

The following table shows the mapping between Teiid Designer Types and JBoss Data Virtualization
Runtime Types.

Table D.1. Corresponding Runtime Types

Teiid Designer Type Java Runtime Type

anyURI java.lang.String
base64Binary java.lang.String
bigdecimal java.math.BigDecimal
biginteger java.math.Biglnteger
blob java.sql.Blob [a]
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Teiid Designer Type Java Runtime Type

boolean

byte

char

clob

date

dateTime

decimal

double

duration

ENTITIES

ENTITY

float

gDay

gMonth

gMonthDay

gYear

gYearMonth

hexBinary

ID

IDREF

IDREFS

int

java.lang.Boolean

java.lang.Byte

java.lang.Character

java.sql.Clob [b]

java.sgl.Date

java.sgl.Timestamp

java.math.BigDecimal

java.lang.Double

java.lang.String

java.lang.String

java.lang.String

java.lang.Float

java.math.BigInteger

java.math.BigInteger

java.sgl.Timestamp

java.math.BiglInteger

java.sql.Timestamp

java.lang.String

java.lang.String

java.lang.String

java.lang.String

java.lang.Integer
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Teiid Designer Type Java Runtime Type

integer

language

long

Name

NCName

negativelnteger

NMTOKENS

NMTOKENS

nonNegativelnteger

nonPositivelnteger

normalizedString

NOTATION

object

positivelnteger

QName

short

string

time

timestamp

token

unsignedByte

unsignedint

unsignedLong
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java.math.BigInteger

java.lang.String

java.lang.Long

java.lang.String

java.lang.String

java.math.BigInteger

java.lang.String

java.lang.String

java.math.BiglInteger

java.math.BigInteger

java.lang.String

java.lang.String

java.lang.Object

java.math.BiglInteger

java.lang.String

java.lang.Short

java.lang.String

java.sqgl.Time

java.sgl.Timestamp

java.lang.String

java.lang.Short

java.lang.Long

java.lang.Biginteger
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Teiid Designer Type Java Runtime Type

unsignedShort java.lang.Integer

XMLLiteral java.sql.SQLXML [c]

[a] The concrete type is expected to be org.teiid.core.types.BlobType.
[b] The concrete type is expected to be org.teiid.core.types.ClobType.

[c] The concrete type is expected to be org.teiid.core.types. XMLType.

D.15. TEIID MODEL CLASSES VIEW

The Model Classes View provides a hierarchical EMF-centric view of the various metamodel classes
available within Teiid Designer. This view is primarily for informational purposes, but can be used as a
reference if creating relationships or searching your workspace for specific metamodel constructs.
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1zY Model Explorer | o= Outline | [, Teiid Model Classes &3 = O

ik http:/f'www.eclipse.org/emf/2002/Ecare

i http:/fwww.eclipse.orgfemff2002/Mapping

ik http:/fwww.eclipse.orgf/uml2/3.0.0/UML

i http:/fwww.eclipse.orgfxsd/2002/XSD

i http:/fwww.metamatrix. com/metamodels/Compare
ik http:/f'www.metamatrix. com/metamodels/Core

ik http:/f'www.metamatrix. com/metamodels/Dependency
ik http:/f'www.metamatrix. com/metamodels/Diagram

ik http:/f'www.metamatrix. com/metamodels/Extension
ik http:/f'www.metamatrix. com/metamodelsf|DBC

ik http:/f'www.metamatrix. com/metamodels/MetaMatrixFunction

| v v T T T T T T T T

ik http://'www.metamatrix. com/metamodels/Relational
[ AccessPattern -= RelationalEntity [com.metamatrix. metamodels.r
BaseTable -= Table [com.metamatrix. metamodels.relational Base
Catalog -= RelationalEntity [com.metamatrix. metamodels. relatior
Column -= RelationalEntity [com.metamatrix. metamodels. relatior
ColumnSet -=> RelationalEntity [com. metamatrix. metamodels.rela
DirectionKind

Foreignkey -= Relationship [com.metamatrix. metamodels. relatior
Index -= RelationalEntity [com.metamatrix. metamodels.relational
LogicalRelationship -= Relationship [com.metamatrix. metamodels
LogicalRelationshipEnd -=> RelationalEntity [com. metamatrix. meta
MultiplicityKind

MullableType m

| |_| B

Figure D.26. Datatype Hierarchy View
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D.16. SYSTEM CATALOG VIEW

To open Teiid Designer's System Catalog View, click the main menu's Window > Show View >
Other. .. andthenclick theTeiid Designer > System Catalog view in the dialog.
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l= Model Explorer ﬂ' System Catalog &3 = O

- [§ 5Y5

[» B virtualDatabases

[* B Schemas
Tables
DataTypes
Columns
Eeys
KeyColumns
Procedures
ProcedureParams
Properties
getCharacterVDBResource
getBinanDEResource
getvDBResourcePaths
ReferencekKeyColumns
get¥MLSchemas
) document : string
[* B schemas

| v v T T T T T VT T T T
O o S S O T 2 1

Figure D.27. System Catalog View

D.17. SQL RESERVED WORDS VIEW

To open Teiid Designer's SQL Reserved Words View, click the main menu's Window > Show View

> Other. .. andthen click theTeiid Designer > SQL Reserved Words view in the dialog.
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Flter Text (? = any character, * = any String):

[se ]

Matching Reserved Words:
SEARCH
SECOND
SELECT
SENSITIVE
SESSION_USER
SET

Figure D.28. System Catalog View

You can also display the view by selecting the main menu's Metadata > Show SQL Reserved
Words action as shown below.

Teiid Designer -
roject | u--oci- | Run Window Help

, Update Model from Source

| j‘ Show Systemn Catalog
h Show Datatype Hierarchy
Show SQL Reserved Words

AR
5 >

Convert to Enterprise Datatypes
Show Model Statistics

Build Model Impaorts
= |

Figure D.29. SQL Reserved Words Action

D.18. MODEL EXTENSION DEFINITION REGISTRY VIEW (MED
REGISTRY VIEW)

To open Teiid Designer's MED Registry View, click the main menu'sWindow > Show View >
Other... andthenclick theTeiid Designer > Model Extension Registry view in the dialog.

The Model Extension Registry view shows the currently registered MEDs. Registered MEDs can be
applied to models in the workspace (see Managing Model Object Extensions). The Model Extension
Registry view looks like this:
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&8 Model Extension Registry 52 ™._[Z{ Problems | €] Error Log B ¥ =0
Built-In Namespace Prefix Mamespace URI Model Class Version|Description
] ext-custom org.teiid.designer.extension.deprecated Relational 1 Designer 7.4 extension proper
mymodelextension mymodelextension Relational 1 This is my model extension
v rest org.teiid.designer.extension.rest Relational 1 REST extended virtual procedu
v salesforce org.teiid.designer.extension.salesforce Relational 1 Salesforce extended relational
] sourcefunction org.teiid.designer.extension.sourcefunction Relational 1 Source Function properties

Figure D.30. System Catalog View

You can also open the view by clicking the MED Editor toolbar action in the right corner of shared sub-
editor header section.

For each registered MED, the namespace prefix, namespace URI, extended model class, version, and
description is shown. In addition, a flag indicating if the MED is built-in is shown. The Model Extension
Registry view has toolbar actions that register a workspace MED file, unregister a user defined MED,
and copy a registered MED to the workspace. All these actions are also available via a context menu.

A MED registry keeps track of all the MEDs that are registered in a workspace. Only registered MEDs
can be used to extend a model. There are 2 different types of MEDs stored in the registry:

e Built-In MED - these are registered during Teiid Designer installation. These MEDs cannot be
updated or unregistered by the user.

e User-Defined MED - these are created by the user. These MEDs can be updated, registered,
and unregistered by the user.

NOTE

When a workspace MED is registered it can be deleted from the workspace if desired.
The registry keeps its own copy. And a registered MED can always be copied back to the
workspace by using the appropriate toolbar or context menu action.

D.19. GUIDES VIEW

To open Teiid Designer's Guides View, click the main menu's Window > Show View > Other...
and then click the Teiid Designer > Guides view in the dialog.

The Guides view provides assistance for many common modeling tasks. The view includes categorized
Modeling Actions and also links to Cheat Sheets for common processes. Cheat Sheets are an eclipse
concept for which Teiid Designer has provided contributions (see Cheat Sheets view). The Guides view
is shown below:
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;
A Guides 2 - % Statusw = O

Modeling Actions...

~ Action Sets

Model |DBEC Source

L

& Create Teiid Model Project

=@ Create |DBC connection

[, Create source model for |DBC data source
% Preview Data

i Create VDB

% Execute VDB

Description
<no action selected=

~ Cheat Sheets
Cheat sheets for Teiid Designer use cases

Create Model from JDBC Source

Create Model from Flat File Source
Consume a SOAP Web Service

Create Model from XML Local File Source
Create Model from XML Remote Source
Create multi-source VDB

Create and test a VDB

SRSASEORTNSNS

Figure D.31. Guides View

The upper Action Sets section provides categorized sets of actions. Select the desired category in
the drop-down, then the related actions for the selected category are displayed in the list below it.
Execute an action by clicking the Execute selected action link or double-clicking the action.

The lower Cheat Sheets section provides a list of available Cheat Sheet links, which will launch the
appropriate Cheat Sheet to guide you step-by-step through the selected process.
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STATUS VIEW

To open Teiid Designer's Status View, click the main menu's Window > Show View > Other...
and then click the Teiid Designer > Status view in the dialog.

The Status View provides a quick overview status of the selected project. A sample Status view for a
project is shown below:

™ Guides 4 Status &3

Project Status

¥ Enable| Lnange rroject |

Project: TestProj

Source Connections
sources

XML S5chema

Views

VDEBs

E¥|EEOEA

Model validation (OFF)
Test

Figure D.32. Status View

The status view is broken down into common project areas:

Source Connections - all Source Connections are fully defined.

Sources - Source Models exist.

XML Schema - XML Schemas exist.

Views - View Models exist.

VDBs - VDBs exist and are deployable.

Model Validation (Status) - all Models pass validation.

Test - all defined VDBs pass validation.

The status of each area is denoted by an icon: A green check indicates OK, a red x indicates errors and

a warning icon indicates potential problems. The project can be changed by selecting the Change

Project button.
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D.21. CHEAT SHEETS VIEW

To open Cheat Sheets View, click the main menu'sWindow > Show View > Other... and then
click the Help > Cheat Sheets view in the dialog.

The Cheat Sheets view is a standard Eclipse Help concept. Cheat Sheets provide step by step
assistance for common process workflows. Teiid Designer has contributed to the Eclipse help
framework to provide assistance for many common modeling tasks. The Guides View (see Guides View)
provides links to these Cheat Sheets, as previously described. A sample Cheat Sheet is shown below:

& Cheat Sheets &3 B v =g

Create Model from JDBC Source

+ = |Introduction

This cheat sheet shows you how to create a model from
a JDBC source.

% Click to Restart

~ Create New Teiid Model Project

Follow the steps below to create a Teiid Model

Project
Launch New Teiid Model Project Wizard B 4
1) Specify unique project name [V %

2) Click Next > twice to get to Model
Project Options page

3) Check folders you wish the wizard to create
in your project

4) Click Finish

» Create New JDBC Source Connection

» Create Source Model From JDBEC Connection
» Test |DBC Source Data

» Create VDB

» Test VDB

Figure D.33. Cheat Sheet Sample
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APPENDIX E. EDITORS

E.1. EDITORS

Editors are the Ul components designed to assist editing your models and to maintain the state for a
given model or resource in your workspace. When editing a model, the model will be opened in a Model
Editor. Editing a property value, for instance, will require an open editor prior to actually changing the

property.

Any number of editors can be open at once, but only one can be active at a time. The main menu bar
and toolbar for Teiid Designer may contain operations that are applicable to the active editor (and
removed when editor becomes inactive).

Tabs in the editor area indicate the names of models that are currently open for editing. An asterisk (*)
indicates that an editor has unsaved changes.

[ PartsVirtual xmi &3 [g PartsSourceA xmi (] Parts.vdb
&
==Base Table== =<=Procedure=:=
= Supplierinfo partsByColor

L TR T o o T T S L ] P _ I

Figure E.1. Editor Tabs

By default, editors are stacked in the editors area, but you can choose to tile them vertically, and or
horizontally in order to view multiple models simultaneously.
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ﬂ PartsSourceA xmi 53 % PartsVirtual xmi g2 =&

%
%

C ccmmembles> | iprocedun
& [t Supplierinfo partsBy(

L]

& £ SUPPLIER_ID : string(10) ¥ colorin : string

£4 PART_ID : string(50)
| LI QUANTITY : short T—E
- - £ SHIPPER_ID : short NewProcedn
] £ SUPPLIER_NAME : string(30) L=

¥ SUPPLIER_STATUS : short £y PART_ID : string(4)
& SUPPLIER_CITY : string(30] £y PART_MAME : string

A SUPPLIER_STATE : stringi2) £y PART_COLOR : strir

I PART_WEIGHT : stri

%4 Package Diagram] ] Table Editor| I| 34 Package Diagraml ] Table Editor| I|
Parts.vdb
-Description
Models
Maodel Path Synchronized? Wisible?  Source Name Translator JNDI Name Description
ﬁ PartsSourceA xmi | /PartsProject m m PartsSourceA db2 PartsSourceA Add..
(g PartsSourceB.xmi ; /fPartsProject #A #A PartsSourceB sqlserver PartsSourceB S—
£ Partsvirtual xmi JPartsProject A A | BEGIEEE |
~Other Fles VDB Data Roles
Fle Path Synchronized? Description Data Role Description New. ..
-m | Edit... |
| Remowve |
- | Remowve |
| Synchronize All |

Figure E.2. Viewing Multiple Editors
The Teiid Designer provides main editor views for XMI models and VDBs.

The Model Editor contains sub-editors which provide different views of the data or parts of data within
an XMI model. These sub-editors, specific to model types are listed below.

e Diagram Editor - All models except XML Schema models.
e Table Editor - All models.

e Simple Datatypes Editor - XML Schema models only.

e Semantics Editor - XML Schema models only.

e Source Editor - XML Schema models only.

The VDB Editor is a single page editor containing panels for editing description, model contents and
data roles.

In addition to general Editors for models, there are detailed editors designed for editing specific model
object types. These object editors include:

e Transformation Editor - Manages Transformation SQL for Relational View Base Tables,
Procedures and XML Web Service Operations.
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e Choice Editor - Manages properties and criteria for XML choice elements in XML Document
View models.

e Input Editor - Manages Input Set parameters used between Mapping Classes in XML Document
View models.

e Recursion Editor - Manages recursion properties for recursive XML Elements in XML Document
View models.

e Operation Editor - Manages SQL and Input Variables for Web Service Operations.

E.2. MODEL EDITOR

E.2.1. Model Editor

The Model Editor is comprised of sub-editors which provide multiple views of your data. The
Diagram Editor provides a graphical while the Table Editor provides spreadsheet like editing
capabilities. This section describes these various sub-editors.

E.2.2. Diagram Editor

The Diagram Editor provides a graphical view of the a set of model components and their
relationships.

Several types of diagrams are available depending on model type. They include:
° i) Package Diagram
° g Custom Diagram
° E'@ Transformation Diagram
° Mapping Diagram

° B Mapping Transformation Diagram
You can customize various diagram visual properties via Diagram Preferences.

Each diagram provides actions via the Main toolbar, diagram toolbar and selection based context
menus. These actions will be discussed below in detail for each diagram type.

When a Diagram Editor is in focus, a set of common diagram actions is added to the application's main
toolbar.

£lhom [v| P A a B

Figure E.3. Main Toolbar Diagram Actions

The actions include:

° ?Zoom In
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1 Zoom to Level
° P Zoom Out

A. Increase Font Size

e A" Decrease Font Size

EE Perform Diagram Layout

E.2.3. Package Diagram

The Package Diagram provides a graphical view of the contents of a model container, be it the model
itself, a relational catalog or schema.

E®ae “ ¢ &

& Package Diagram | [5] Table Editor

Figure E.4. Package Diagram Example

Package Diagram toolbar actions include:
° Eﬁ Refresh Diagram - Redraws diagram.
o Show Parent Diagram - Navigates to diagram for parent object (if available).
° i Preview Data - Executes a simple preview query (SELECT * FROM ).

° % Save Diagram as Image - Save the diagram image to file in JPG or BMP format.
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° Modify Diagram Printing Preferences - Modify page layout information for printing diagrams.

Includes margins, orientation, etc...

° Show/Hide Page Grid - Show current page boundaries as grid in diagram.

Context menus provide a flexible means to edit model data, especially from Package Diagrams. Each
Package Diagram represents the contents of some container (i.e. Model, Category, Schema, etc...), so
New Child, New Sibling and New Association actions are almost always available in addition to standard

Edit actions (Delete, Cut, Copy, Paste, Rename, Clone).

A sample context menu for a relational base table is shown below.

Mew Child
Mew Sibling

Mew Association

b L

Modeling

{'r'f Undo Delete multiple objects

of Cut Ctrl+X |
Ii=| Copy Ctrl+C

Clone

Copy Name >

¥ Delete

Rename

Link Types >
-E{}{:i“i' Refresh Diagram
[#3 Show Parent Diagram
% Sawve Diagram To FAle
Page Setup

Show Page Grid |

Input Methods >
Figure E.5. Package Diagram Context Menu

E.2.4. Custom Diagram

The Custom Diagram represents a view of user defined model objects. Unlike Package Diagrams,
Custom Diagrams can contain objects that are not only unrelated, but can be from different containers

and even models.
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-

e

Figure E.6. Custom Diagram Example

Custom Diagram toolbar actions include:
° "E‘I}% Refresh Diagram - Redraws diagram.
o [ Show Parent Diagram - Navigates to diagram for parent object (if available).
° H’ Preview Data - Executes a simple preview query (SELECT * FROM ).

+_I

° |;'| Add To Diagram - Add objects selected in Model Explorer to diagram.
° |i—'| Remove From Diagram - Removed objects selected in diagram from diagram.
° Clear Diagram - Remove all objects from diagram.
° % Save Diagram as Image - Save the diagram image to file in JPG or BMP format.

° Modify Diagram Printing Preferences - Modify page layout information for printing diagrams.
Includes margins, orientation, etc...

° Show/Hide Page Grid - Show current page boundaries as grid in diagram.
Since Custom Diagrams do not represent represents the contents of container objects(i.e. Model,

Category, Schema, etc...) its context menus are limited to adding/removing objects from diagram and
basic diagram related display options.

E.2.5. Transformation Diagram

The Transformation Diagram represents a view of the relationships defined by the source inputs
described in a view table's SQL transformation.

B

Figure E.7. Transformation Diagram Example

Transformation Diagram toolbar actions include:

° "E‘I}% Refresh Diagram - Redraws diagram.

3 Show Parent Diagram - Navigates to diagram for parent object (if available).
° H’ Preview Data - Executes a simple preview query (SELECT * FROM ).

+_I
|;'| Add Transformation Sources - Add selected sources to transformation.

+|E| Add Union Transformation Sources - Add selected sources as union sources.
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° |i—'| Remove Transformation Sources - Removed sources selected in diagram from
transformation.

£
° 1@ Clear Transformation - Remove all sources from transformation.
Bn . . .
e  # Open Transformation Reconciler dialog
° % Save Diagram as Image - Save the diagram image to file in JPG or BMP format.

° Modify Diagram Printing Preferences - Modify page layout information for printing diagrams.
Includes margins, orientation, etc...

° Show/Hide Page Grid - Show current page boundaries as grid in diagram.

E.2.6. Mapping Diagram

The Mapping Diagram represents a view of the mapping between virtual mapping class columns and
XML document elements. This mapping defines how source data is transformed from row based results
into XML formatted text.

Figure E.8. Mapping Diagram Example

Mapping Diagram toolbar actions include:
° "E‘I}% Refresh Diagram - Redraws diagram.
e [ Show Parent Diagram - Navigates to diagram for parent object (if available).

° ff’li Show Mapping Transformation Diagram - Show detailed mapping transformation diagram
for selected mapping class.

° H’ Preview Data - Executes a simple preview query (SELECT * FROM ).

.*.
° § Generate Mapping Classes - Generate mapping classes for the selected XML document
root element.

° *E New Mapping Class - Insert new mapping class referenced to the selected XML document
element or attribute..

° *E New Staging Table - Insert new staging table referenced to the selected XML document
element or attribute.

5 )
° IE Merge Mapping Classes - Merge selected mapping classes.
° Split Mapping Class - Split selected mapping class.
° FE Display All Mapping Classes

° % Show Mapping Class Columns
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|
e i Filter Displayed Mapping Classes with Selection

Context menus for Mapping Diagrams provide Edit capability to the mapping class in addition to mapping
class manipulation actions (i.e. Merge Mapping Classes, Split Mapping Class, etc..)

E.2.7. Mapping Transformation Diagram

The Mapping Transformation Diagram is identical to a Transformation Diagram except for
displaying an Input Set and possibly Staging Tables as sources for the Mapping Class's transformation.

7 BooksXMLami 55 =R
e 7 {8 sookCollection VIEWY -
= [} sequence [MC: bockl _ .
k= = 9 book
i# 1sbn = T | | =eieuctens
w4t sequence | ook \ISJ o input Set
) tite
0 it £ ishn ; string
<:e) subitly A title : string 51 ISBN - string| 2551 A PUBLISHER IO : it
A8 edition =ubatls - string B TITLE : stringl285] NAKE : stringl255]
= {8 authors A edition : siring 5J SUBTITLE : string(255) LY LOCATION : string|255)
= [ | sequence [MC: suther| & pubksher - string O PUBLISHER : Int _—
i authar publshbate - slring 51 PUSUSH_YEAR . ink I e _PUZUSHIRS
! — ECATICH © it
= _{'Q publishinginfarmatdon ET\'PE: :u-lmmz.sa
g _5_!' SEAUBACE
b ) publishar
s i publishDats
-
L
=3 Dvagram [ Table Editor

Figure E.9. Mapping Transformation Diagram Example

Mapping Transformation Diagram toolbar actions include:
° E{}{h Refresh Diagram - Redraws diagram.
o E Show Parent Diagram - Navigates to diagram for parent object (if available).
° H’ Preview Data - Executes a simple preview query (SELECT * FROM ).

° NE New Mapping Link - Create a mapping link between selected mapping extent (i.e. XML
element or attribute) and mapping class column.

° D’ﬁﬁ Remove Mapping Link - Delete mapping link between selected mapping extent (i.e. XML
element or attribute) and mapping class column.

+_I
° |;'| Add Transformation Sources - Add selected sources to transformation.
° +|E| Add Union Transformation Sources - Add selected sources as union sources.

__I . . .
° |;'| Remove Transformation Sources - Removed sources selected in diagram from
transformation.

£

° 1@ Clear Transformation - Remove all sources from transformation.
Bx . . .

e  # Open Transformation Reconciler dialog

° % Save Diagram as Image - Save the diagram image to file in JPG or BMP format.
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° Modify Diagram Printing Preferences - Modify page layout information for printing diagrams.
Includes margins, orientation, etc...

Context menus for Mapping Transformation Diagrams identical capabilities to the Transformation
Diagram with the addition of managing and editing Input Sets.

E.3. TABLE EDITOR

E.3.1. Table Editor

The Table Editor provides a table-based object type structured view of the contents of a model. The
figure below shows a relational model viewed in the Table Editor. Common object types are displayed in
individual folders/tables. All base tables, for instance, are shown in one table independent of their
parentage.

(g PartsSourceA.xmi 53 =8
& Base Tables | Y Columns
Location Name Name In Source  System Cardinality Supports Up Materialized Logical Relat Materialized Object URI
| PARTS | PARTS  false f16 true | false :
[SHIP_VIA | SHIP_VIA { false i3 true ! false
| STATUS | STATUS { false i3 ! true { false
i SUPPLIER | SUPPLIER i false i 16 [ true i false
| SUPPLIER_PA; SUPPLIER_PARTS | false {227 | true  false

g e
# Package Diagram |[5] Table Editor

Figure E.10. Table Editor Example
You can customize Table Editor properties via Table Editor Preferences.
These are the primary features of the Table Editor:

e Edit existing properties.

e Add, remove or edit objects, via the main Edit menu and context menu ( Cut, Copy, Paste,
Clone, Delete, Rename, Insert Rows ).

e Paste information from your clipboard into the table.

e Print your tables.

When a Table Editor is in focus, the Insert Table Rows action in is added to the application's main
toolbar.

A few Table Editor actions are contributed to the right-click menu for selected table rows. These actions,
described and shown below include:

° @ Table Paste - Paste common spreadsheet data (like Microsoft Excel) to set object properties.

e Table Editor Preferences - Change table editor preferences, including customizing visible
properties.

293



User Guide Volume 1: Teiid Designer

294

e Insert Rows - Create multiple new sibling objects.

° E{}{h Refresh Table - Refreshes the contents of the current Table Editor to insure it is in sync with
the model.

Marme Mame In Source | Sysis
New Child >
e
Mew Sibling >
=T o e
Mew Association >
=11 ] e
Modeling >
sl e
ndc
:;'|
of Cut Ctrl+X
: Ii=| Copy Ctrl+C E
: Diagr @ Table Paste [—
e Clone -
: @ M Copy Name ? ol
¥ Delete
‘e part Rename F? s
ndled e Open Ctrl+0 N
ndled & S .u
dler cc ‘ﬁ Add to Metadata Favorites -
dodel | . _ _ _ _ 35
i+ Open in Relationship Navigator
dodel F 7 Aun A > 15
un As
dodel F B bua A N 15
ebug As
dodel F ; ﬁlg A N 15
rofile As
dodel F ; ot 25
alidate
ndled & - .u
“dled '*;] Mark as Deplovable u
Team b
E Compare With » E
Replace With >
Guwvnor > T
Table Editor Preferences
el 'E Insert Rows =
1.8 KB | 49 Refresh Table 11
L.1 KEE JPEG image Tue 07 Sep 201

Figure E.11. Table Editor Example
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E.3.2. Editing Properties

You can edit properties for an object by double-clicking a table cell.

For String properties, the table cell will become an in-place text editor field.

Base Tables l A Cu:ulumnsl Fl Foreign

ation | Marme | M:
CATEGORIES i
CUSTOMERCUSTOMERDEMO (L
CLISTOMERDEMOGRAPHICS il
CIISTOMERS il
EMPLOYEES EP

Figure E.12. Editing String Property

If a property is of a boolean (true or false) type or has multiple, selectable values, a combo box will be
displayed to change the value.

| Supparts L., ]
Erue

=
brue
brue
brue
brue
brue
brue

| TR

Figure E.13. Editing Boolean Value

. | Searchability | Currenc

ALL_EXCEP... False
ALL_EXCEP... False
ALL_EXCEP... False
ARCHABLE false
T
ALL_EXCEPT_LIKE
LIKE_CMLY

UNSEARCHAELE

SEARCHABLE  False
SEARCHAELE  False

b

Figure E.14. Editing Multi-Value Property

For multi-valued properties where the available values are dynamic (i.e. can change based on available
models or data), a picker button . . . . will be displayed.
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| Datakype | J
ink ¢ x5:long
chort § xsiink
long ¢ xsiinkeger
string (Path=http: /v, w3, orgfzoo_]
long @ xs:inkeger
skring
skring
long ¢ xsiinkeger

=krimm

Figure E.15. Editing Multi-Value With Picker

An example of this type is the relational column datatype property. Editing via the table cell and clicking
the . .. button for datatype will display the following dialog.

| Datakype | J
ink ¢ x5:long
chort § xsiink
long ¢ xsiinkeger
string (Path=http: /v, w3, orgfzoo_]
long @ xs:inkeger
skring
skring
long ¢ xsiinkeger

=krimm

Figure E.16. Editing Datatype Values

E.3.3. Inserting Table Rows

The Insert Rows action provides an additional way to create objects in a model. Insert Rows action
performs the same function as Insert Sibling action, but allows you to create multiple children at
the same time. All new rows will correspond to an object of the same type as the selected object and be
located under the same parent as the selected object.

To Insert Rows in a table:
1. Select a table row to insert rows after.

2. Right-click select Insert Rows action or click the Insert Rows action on the main toolbar.
The following dialog will be displayed.
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Insert Table Rows

Insert Rows (Maximum of 1000)

20 rows will be inserted

Mumber of Rows: [EU |%

@ Cancel || ok |

Figure E.17. Editing String Property

3. Edit the Number of Rows value in the dialog, or use the up/down buttons to change the value.

4. Click OK in dialog.

The desired number of rows (new model objects) will be added after the original selected table row.

E.4. SIMPLE DATATYPES EDITOR

The Simple Datatypes Editor provides a form based properties view of XML Schema data.
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Simple Datatype Editor

] [Clear] Target Namespace: http:/fwww metamatrix. com/XMLSchema/DataSets/Books/BookDatatypes

[change
Datatypes in
BookDatatypes.xsd: + ldentification
BookType Marme: ISBN (change]
CommaSeparatedList Description ISBN, using very simple farmatting rules.
PublicationDate
PublicationYear - Inheritance
Base datatype: string (http:/fwww.w3.org/2001/XMLSchema) [chanage)
Create subtyvpe of this datatvpe... Prevent Restrictions: [ Atomic
Open in Datatype Hierarchy wiew [ List
[C] Union
+ Enterprise
Infarmation in this section is required in order to use this type in other models.
[7] Enterprise Datatype
Runtime type: string [] Fixed l=e Defgyls Inherited from string
Hide Built-in Dat
ide Built-in Datatvpes + Length
Built-in Datatypes:
Length B " Add Description
anySimpleType [T] Fxed Use Default
anylURl Minimum Length [ Fixed Use Default Add Description
basefdBinary . .
Maximum Length B W Add Description
bigdecimal [ Fixed Use Default
biginteger =
blob ]
boolean Whitespace Collapse |2 [[] Fixed Use Default
byte Enumerations | ya) e Description Add Use Default
char _
clob | Edit |
date | Remove |
dateTime
_ Patterns |y |ue Description add Use Default
decimal :
double [0-9.\-XH10.13}; | Edit |
duration | ErE |
EMTITY
float E

] simple Datatypes | [5] Table Editor| (5] Semantics | [ Source

Figure E.18. Editing String Property

E.5. SEMANTIC EDITOR

The Semantic Editor is a tree based editor for XML Schema elements and attributes.

E.6. SOURCE EDITOR

The Source Editor is a simple text editor which is aware of XML Schema formatting rules.

E.7. MODEL OBJECT EDITORS
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The Model Object Editors represent specialized sub-editors which are available for specific model
object types.

E.8. VDB EDITOR

E.8.1. VDB Editor

A VDB, or virtual database is a container for components used to integrate data from multiple data
sources, so that they can be accessed in a federated manner through a single, uniform API. A VDB
contains models, which define the structural characteristics of data sources, views, and Web services.
The VDB Editor, provides the means to manage the contents of the VDB as well as its deployable
(validation) state.

The VDB Editor, shown below, contains a upper and lower panels. The upper panel contains the
Models tab and anOther Files tab. The lower panel contains tabs for managing Data Roles, the
VDB Description and Translator Overrides.

iUpdateVis VDB wdb: 2 =0
m Other Hles|

Model Path Dg p Source Name Translator JMDI Name Description

[ Products.xmi fUpdateVGTest A A Products aracle Products :

[} Updates.xmi é!UpdateVGT&st A A

sl =G S WDB Description | Translator Overrides

Data Role Description

CustomerService

iy

Figure E.19. VDB Editor
You can manage your VDB contents by using the Add or Remove models via the buttons at the right.

Set individual model visibility via the Visibility checkbox for each model. This provides low level data
access security by removing specific models and their metadata contents from schema exposed in GUI
tools.

In order for a VDB to be fully queryable the Source Name, Translator, and JNDI Names must have valid
values and represent deployed artifacts on your JBoss Data Virtualization server.
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If you have Teiid Designer runtime plugins installed, and have a JBoss Data Virtualization server
running, you can select a source model in the VDB Editor and right-click select Change Translator
or Change JNDI Data Source which will allow you to select any applicable artifacts on your server.

m Other F|Ies|
Maodel Path Ug ©,  Source Name Translator JNDI Name D
[ DataDictionaryxsd | /fAnancialsDemo/EnterpriseDatalayer | & | & ] ]

W EU_Customers.xmi JAnancialsDemo/DataSources . . EU_Customers my=ql5

[} EU_Customers_DDC.xmi | /RnancialsDemo/EnterpriseDatalaver | & | & |

i) EU_Custome-rs_VE!L.xml g.FF|nar1cTaIsDemontualE!aseLayer A A rmetamatric .

[ Products. xmi /FnancialsDemo/DataSources A A Products | modeshape Products
E3 Products_DDC.xmi { fAnancialsDemo/EnterpriseDataLayer | § | §# ¢ .

3 Products_VBL.xmi ! fAnancialsDemo/VirtualBaseLayer I, [ R, :

[ T TR S R — D i mm il P I s Py el i = =

Figure E.20. Change Translator or Data Source Actions

If you have a default JBoss Data Virtualization server instance defined and connected the translator and
JNDI table cells will contain drop-down lists of available translator and JNDI names available on that
server.

E.8.2. Editing Data Roles

Teiid Designer provides a means to create, edit and manage data roles specific to a VDB. Once
deployed within a JBoss Data Virtualization server with the security option turned on (by default) any
query run against this VDB via a Teiid JDBC connection will adhere to the data access permissions
defined by the VDB's data roles.

The VDB Editor contains a VDB Data Roles section consisting of a List of current data
roles and New. .., Edit... and Remove action buttons.

Data Roles Ryl Description|

Data Role Description

' NoAccountHoldingsAccess  Client cannot access customer account holdings (financial productiinfe

wirtualOnby Client users can only access virtual layver. Access requests to physical sources will be denied.

Figure E.21. VDB Data Roles Panel
Clicking New. .. or Edit. .. will launch the New VDB Data Role editor dialog. Specify a unique data

role name, add a optional description and modify the individual model element CRUD values by selecting
or clearing entries in the models section.
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(e T S VD B Data Role
Mew VDB Data Role cﬂﬂn
Select Anish to save data role = ﬁﬂ

Mame ||nwentory ]

-Description

[] Allow usage of temporary tables
Apply this role to All Users

-Mapped Role Names

-Models

Madel Create Read Update Delete Execute Alter
= W ProductsSQL.xmi

[ B ProductData 0 m ,m' 0
- B ProductSymbaols 0 m m ] |:| |:|

-System Tables Access

Allow this role to access SYSADMIN model

® Cancel ] [ FBnish ]

Figure E.22. VDB Data Roles Tab

E.8.3. Editing Translator Overrides

Teiid Designer provides a means to create, edit and manage translator override properties specific to a
VDB via the Translator Overrides tab. A translator override is a set of non default properties
targeted for a specific source model's data source. So each translator override requires a target
translator name like oracle, db2, mysq|, etc. and a set of non-default key-value property sets.

The VDB Editor contains a Translator Overrides section consisting of a List of current
translator overrides on the left, a properties editor panel on the right andAdd (+) and Remove
(-) action buttons on the lower part of the panel.
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it

Other F|Ie5|

Model Path 03 p Source Name Translator JNDI Name Description
5 Products.xmi /UpdateVGTest Products oracle Products
[ Updates.xmi | /UpdatevGTest | & | # | : :

Synchronize All

Data Roles |VDE! Description QLENEEGTMe Ny T L1

Overridden Translators -
Description:
Property Value

Base Tanslator Type Name oracle

Database time zone

Database Version
Execution Factory Class name org.teiid.translator. jdbc. oracle. OracleExecutionFacton
Is Immutable *true
Max number of dependent values across all IN 50
Max number of IN predicate entries 1000
Max Prepared Insert Batch Size 2048
name translator-aracle
property
Requries Criteria false
Supported Join Criteria ANY
Supports Full Quter Joins * false
+ - -

Figure E.23. VDB Translator Overrides Tab

To override a specific translator type, click the add translator action (+). If a default JBoss Data
Virtualization server instance is connected and available the Add Translator Override dialog
(below) is displayed, select an existing translator type and click OK. Note that the override is only

applicable to sources within the VDB, so be sure and select a translator type that corresponds to one of
the VDB's source models. The properties panel on the right side of the panel will contain editable cells for

each property type based on the datatype of the property. (i.e. boolean, integer, string, etc.).
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[l Add Translator Override X

Choose the translator type whose properties you want to override:

—_

b

loopback hal

metamatrix
modeshape
mysql
mysqgls

olap

aracle

postgresqgl
salesforce

sqlserver

syvbase

® Cancel oK

Figure E.24. Add Translator Override Dialog

If no default Teiid server instance is available, the Add New Translator Override dialog is
displayed. Enter a unique name for the translator override (i.e. oracle_override), a valid translator type
name (i.e. oracle) and click OK. The properties panel on the right side of the panel will allow adding,
editing and removing key-value string-based property sets. When editing these properties all values will
be treated as type string.

[ Add New Translator Override o

translator name and translator type are both required when creating a

@ A Teiid server is not available so translator types are not available. A
translator override.

Press "OK" when finished.

Cancel ] | (8] 4 |

Figure E.25. Add New Translator Override Dialog

E.9. MODEL EXTENSION DEFINITION EDITOR

The MED Editor is a editor with multiple tabs and is used to create and edit user defined MEDs (* . mxd
files) in the workspace. The MED Editor has 3 sub-editors (Overview, Properties, and Source) which
share a common header section. Here are the MED sub-editor tabs:
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e Overview Sub-Editor - this editor is where the general MED information is managed. This
information includes the namespace prefix, namespace URI, extended model class, and the
description. The Overview sub-editor looks like this:

,r:% miyrmixd.mxd 53 = O
S

¥ Overview - 2 &

MNamespace Prefix; mymodelextension

MNamespace URI #mymndele:n:tensinn

Model Class: Relational v
Model Types: ' Source Model |

View Model |
\ersion: 1 ]
Description: This is my model extension|

< > () >

Ovewiew| Prnperties| Snurce|

Figure E.26. Overview Tab

e Properties Sub-Editor - this editor is where the MED extension properties are managed. Each
extension property must be associated with a model object type. The Properties sub-editor is
divided into 2 sections (Extended Model Objects and Extension Properties) and looks like this:
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T mymxd.mxd 2 =8

& Properties ~

~ Extended Model Objects

Manage the extended model objects that have extension properties

BaseTable

B &

* Extension Properties -{'
Manage extension properties for each extended model object

ID Runtime Type Required Modifiable Advanced Masked Indexed Default Value Fixed Value Allowed Values Display Name Descrip{
copyable boolean | | true,false Copyable |Indicat

Owverview |Properties | Source |

Figure E.27. Properties Tab

e Source - this tab is a read-only XML source viewer to view the details of your MED. This source
viewer is NOT editable.

The GUI components on the Overview and Properties sub-editors will be decorated with an error icon
when the data in that GUI component has a validation error. Hovering over an error decoration displays a

tooltip with the specific error message. Those error message relate to the error messages shown in the
common header section. Here is an example of the error decoration:

Mamespace URI: El

Figure E.28. Text Field With Error
The MED sub-editors share a header section. The header is composed of the following:

e Status Image - an image indicating the most severe validation message (error, warning, or info).
If there are no validation messages the model extension image is shown.

e Title - the title of the sub-editor being shown.

e Menu - a drop-down menu containing actions for (1) adding to and updating the MED in the
registry, and (2) for showing the Model Extension Registry View.

e Validation Message - this area will display an OK message or an error summary message.

When a summary message is shown, the tooltip for that message will enumerate all the
messages.

e Toolbar - contains the same actions as the drop-down menu.

Below is an example of the shared header section which includes an error message tooltip.
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@ Overview ™ 1 error detected ﬁg_ ﬁ“’

|Mamespace URI: The "namespace URI" cannot be empty. g -

Figure E.29. Shared Header Example
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APPENDIX F. TEIID DESIGNER MAIN MENU

F.1. TEIID DESIGNER MAIN MENU
There are 8 categories of actions on Teiid Designer's main menu bar.
These categories include:

e Resource management actions

e Standard edit actions including undo/redo

e Resource actions (i.e. Rename, Move, etc...)

e Find data within your workspace.

e Model level actions

e Custom metadata-related actions

e Change perspectives or add/remove views to your perspective.

e Access available Teiid Designer help documents, Teiid Designer SQL Support Guide and
Eclipse Overview information.

Teiid Designer - PartsProject/PartsSourceA.xmi - |Boss Developer Studio

Fle Edit Refactor Mavigate Search Project Metadata Run Window Help

Figure F.1. Application Main Menu

F.2. FILE MENU

The File menu provides actions to manage your workspace resources.
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il Teiid Designer - PartsProject/Parts
Edi‘t Refactor Mavigate Search Project Me
N

ewW Shift+Alt+N » |
Open Ale_.. .
Close ctrl+w |
Close All Shift+Ctrl+w |
Save Ctri+s [,

Sawve All Shift+Ctrl+5 I
Rewvert
Mowe. ..
Rename... F2
#'] Refresh F5
Convert Line Delimiters To >
Print. .. Ctrl+P
Switch Workspace >
Restart
E¥y Import...
L7 Export...
Properties Alt+Enter

1l PartsSourcel.xmi [PartsProject]
2 Parts.vdb [PartsProject]
3 PartsSourceB.xmi [PartsProject]

L

Exit

Figure F.2. File Menu

The New > submenu provides specific actions to create various generic workspace resources as well as
Teiid Designer models and VDBs.
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Egdit Refactor Mavigate Search Project Metadata BRun Window Help

S 6 Teiid Model Project

Open File... ™ Project...
Close Ctri+w % Folder
Close All Shift+Ctri+W

fﬁ* Teiid Metadata Model
[N Teiid VDB

“ Example. ..
|
™ Other... Ctri+N

Figure F.3. File Menu

The File menu contains the following actions:
° ﬁ New > Model Project - Create user a new model project.
° ﬁ New > Folder - Create new folder within an existing project or folder.

° fi\ New > Model - Create a new model of a specified model type and class using the New Model
Wizards.

ik

New > Virtual Database Definition - Create a new VDB, or Virtual Database Definition.

e Open File - Enables you to open a file for editing - including files that do not reside in the
Workspace.

e Close (Ctrl+W) - Closes the active editor. You are prompted to save changes before the file
closes.

e Close All (shift+Ctrl+W) - Closes all open editors. You are prompted to save changes
before the files close.

° [ﬂ Save (Ctrl+S) - Saves the contents of the active editor.

° IH Save As - Enables you to save the contents of the active editor under another file name or
location.

° @ Save All (Shift+Ctrl1+S) - Saves the contents of all open editors.
e Move - Launches a Refactor > Move resource dialog..

e Rename (F2) - Launches a Refactor > Rename resource dialog if resource selected, else inline
rename is preformed.

e Refresh - Refreshes the resource with the contents in the file system.

e Convert Line Delimiters To - Alters the line delimiters for the selected files. Changes are
immediate and persist until you change the delimiter again - you do not need to save the file.
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o = Print (Ctrl+P) - Prints the contents of the active editor. In the Teiid Designer, this action
prints the diagram in the selected editor. Allows control over orientation (portrait or landscape),
scaling, margins and page order. User can also specify a subset of the pages to print (i.e., 2
through 8).

e Switch Workspace - Opens the Workspace Launcher, from which you can switch to a different
workspace. This restarts the Workbench.

e Restart - Exits and restarts the Workbench.

° £ --> Import - Launches the Import Wizard which provides several ways to construct or import
models..

° 2| Export - Launches the Export Wizard which provides options for exporting model data.

e Properties (Alt+Enter) - Opens the Properties dialog for the currently selected resource.
These will include path to the resource on the file system, date of last modification and its
writable or executable state.

e Most Recent Files List - Contains a list of the most recently accessed files in the Workbench.
You can open any of these files from the File menu by selecting the file name.

e Exit - Closes and exits the Workbench.

F.3. EDIT MENU

The Edit menu provides actions to manage the content, structure and properties of your model and
project resources. The figure below represents the Edit menu presented when a metadata model is
selected.
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ew Child >
ew Sibling >
ew Association >
odeling >
opy Ctri+C
elete Delete
elect All Ctri+aA

Add Bookmark. ..
Add Task. ..

Figure

F.4. Edit Menu

The Edit menu contains the following actions:

New > Child - This menu is created dynamically to support the creation of whatever types of
child objects can be created under the selected object.

New > Sibling - This menu is created dynamically to support the creation of whatever types of
sibling objects can be created under the same parent as the selected object

New > Association - This menu is created dynamically to support the creation of whatever types
of associations can be created with the selected object.

Modeling > - This menu is created dynamically. Various modeling operations are presented
based on selected model object type.

A

& Undo - Reverses the effect of the most recent command.

[

o Redo - Reapplies the most recently undone command.

fo Cut - Deletes the selected object(s) and copies it to the clipboard.

EE] Copy - Copies the selected object(s) to the clipboard.
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L

_=l Paste - Pastes the contents of the clipboard to the selected context.
Paste Special... - Provides additional paste capabilities for complex clipboard objects.

Clone - Duplicates the selected object in the same location with the same name. User is able to
rename the new object right in the tree.

H Delete - Deletes the selected object(s).
Select All - Select All objects in current view.
Rename - Allows a user to rename an object in the tree.

Find/Replace - Launches dialog that can be used to search in the current text view, such as a
Transformation Editor.

Open - Opens the selected object in the appropriate editor.

Edit - Opens the selected object in the appropriate specialized editor, such as the Choice Editor
or Recursion Editor..

Add Bookmark... - This command adds a bookmark in the active file on the line where the cursor
is currently displayed.

Add Task... - This command adds a task in the active file on the line where the cursor is
currently displayed.

F.4. REFACTOR MENU

The Refactor menu provides Teiid Designer specific actions for file level changes to the models.

Figure F.5. Refactor Menu

The Refactor menu contains the following actions:

e Undo - Undo the last refactor command.
e Redo - Redo the last undone refactor command.
e Move - Move a model from one container (folder or project) to another.

e Rename - Rename a model.

F.5. NAVIGATE MENU

Teiid Designer currently does not contribute actions to the Navigate menu. See Eclipse
documentation for details.
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[*® Open Spring Bean...
[ﬁ' Open Seam Component

Show In

<o Back

Figure F.6. Navigate Menu

F.6. SEARCH MENU

The Search menu presents several specific search options.

4" search. ..

=i Fle...

B Remote...

%4 Pointcut Matches. .

% Beans. ..

Text

Teiid Designer

Figure F.7. Search Menu

>

Shift+Alt+B
Shift+Ctrl+Z

Shift+Alt+W >

Alt+Left >

APPENDIX F. TEIID DESIGNER MAIN MENU

Teiid Designer contributes a submenu (i.e. Teiid Designer > ) to the main search menu, as shown above.
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Text >

< Metadata. ..
(® Fnd Model Object

Figure F.8. Search Menu

The individual actions in the Teiid Designer submenu are described below:

° e Transformations... - Launches the Transformation Search dialog. User can search models in
the workspace for matching SQL text. Search results appear in the dialog and user can select
and view SQL as well as open desired transformations for editing.

° 4 Metadata... - Launches the Search dialog. User can search for models in the workspace by
specifying an Object Type, and/or a Data Type, and/or a property value. Search results appear
in the Search Results view, and double-clicking a result will open that model in the appropriate
editor.

° b Find Model Object - Launches the Find Model Object dialog, which can be used to find an

object in the workspace by specifying all or part of its name. Selecting the object will open it in
the appropriate editor.

F.7. PROJECT MENU

Close Project

Build Working Set >
Clean...
Build Automatically

7y Clone Project

]

Build Project Imports

]

Build All Imports

Properties

Figure F.9. Project Menu

The individual actions in the Project menu are described below:
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e Open Project - Launches the Open Project dialog.

e Close Project - Closes the currently selected project(s).

e 1 Build All - Validates the contents of the entire workspace. Any errors or warnings will appear
in the Problems View.

e Build Project - Validates the contents of the selected project(s). Any errors or warnings will
appear in the Problems View.

e Build Working Set - Validates the contents of the selected working set. Any errors or warnings
will appear in the Problems View.

e Clean.. - Launches the Clean dialog.

e Build Automatically - Sets the Build Automatically flag on or off. When on, a checkmark appears
to the left of this menu item. When this is turned on, validation of changes is done automatically
each time a Save is done.

e Clone Project - Launches the Clone Project dialog.

e Build Project Imports - Reconciles all model import dependencies for models contained within
the selected project.

e Build All Imports - Reconciles all model import dependencies for models contained within the
workspace.

e Build Packages - TBD
e Validate Model Transformations - Revalidates all transformations for the selected view model.

e Properties - Displays the operating system's file properties dialog for the selected file.

F.8. METADATA MENU

The Metadata menu provides Teiid Designer specific actions.

Eun Window Help

ﬂ' Show Systemn Catalog
‘Eg Show Datatype Hierarchy

Figure F.10. Metadata Menu

The Metadata menu contains the following actions:
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e Update Model from Source - If the selected model is a relational source model that was originally
created via JDBC Import, then the model will be updated based on changes in the database
schema.

e Show System Catalog - Opens the System Catalog view.

e Show Datatype Hierarchy - Opens the System Catalog view.

o Re-resolve References - Analyzes references within models to other model components.

e Convert to Enterprise Datatypes - Adds an additional property to simple datatypes within your
selected schema model to label them as enterprise datatypes.

e Show Model Statistics - Opens the Model Statistics dialog for the selected model.

e Build Model Imports - Reconciles all model import dependencies for the selected model.

F.9. RUN MENU

Teiid Designer currently does not contribute actions to the Run menu. See Eclipse documentation for
details.

@, External Tools >

Figure F.11. Window Menu

F.10. WINDOW MENU

The Window menu shown below contains no Teiid Designer specific actions. See Eclipse Workbench
documentation for details.

New Window

Mew Editor
QOpen Perspective >
Show View >

Customize Perspective. ..
Save Perspective As. ..
Beset Perspective. ..
Close Perspective

Close All Perspectives
Mavigation >
Preferences

Figure F.12. Window Menu

The Preferences. .. action launches the Preferences dialog, which can be used to set preferences
and default values for many features of Teiid Designer.
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NOTE

These menu items may vary depending on your set of installed Eclipse features and
plugins.

To customize a perspective to include one or more Teiid Designer views, click the Show View >
Other. .. action and expand the Teiid Designer category to show the available views.

[ Show View x
[1:_ pe filter text g]
[* = Team kil
¥ [~ Teiid Designer
h Datatypes

Description

'ﬁ Metadata Favorites
& Model Explorer

*E* Relationship Mavigator
j‘ System Catalog

== Tags

el Teiid

i, Teiid Model Classes

<[]

Cancel | | oK

Figure F.13. Show View Dialog

F.11. HELP MENU

The Help Menu shown below contains no Teiid Designer specific actions. See Eclipse Workbench
documentation for details.
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Welcome

Help Contents

8 @

' Search
Dynamic Help
Key Assist. .. Shift+Ctri+L

Tips and Tricks. ..
Cheat Sheets. ..

Project Examples...
Report Problem

Red Hat Web Site
Check for Updates

Install New Software. ..

About |Boss Developer Studio

Figure F.14. Help Menu
The individual actions are described below:

e Welcome - Shifts to the Welcome perspective, which contains links to documentation, examples
and 'how-to' starting points.

e Help Contents @ - Launches the Help Window. All of Designer's online documentation is
accessible from there as well.

e Search % - Launches the Help Search view, which can be used to search for phrases in the
documentation.

e Dynamic Help - Opens the docked dynamic help view.
e Key Assist (Ctrl-shift-L) ... - Launches a dialog describing existing key assist bindings.

e Tips and Tricks... - Launches a dialog to select one of any contributed Tips and Tricks help
pages.

e Cheat Sheets... - Launches a dialog to select one of any contributed Eclipse cheat sheets.

e Project Examples... - A JBoss contributed action which provides quick access to import various
project examples into your workspace.

e Report Problem - A JBoss contributed action which provides simple problem reporting.
e Check for Updates... - provides access to retrieve updates to installed Eclipse software.
e |Install New Software... - provides access to install new software into your workbench.

e About JBoss Developer Studio - Launches the About dialog.
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